Sound Designer II™
Version 2.8
User’s Guide
Sound Designer II Project Team:
Evan Brooks, Dave Clementson, Robert Currie, Gary Isobe, Jim Jasmin and Peter Richert

Sound Designer II Software:
Evan Brooks, Mark Jeffery, Robert Currie, Peter Richert

Sound Designer II Manual:
Mike Freitas. Additional text by Mark Wilcox

Package and Sound Designer II Graphic Design:
Kristine Ekstrand, Stacey Fisher

Product Management:
Wendy Butler

Special Thanks to:
Michael Abowd, Wendy Butler, Tina Chavez, Midori Duarte, Peter Gotcher, Jeffro™, Rob Lodes, Chris Now, Seth Worden, Shane Ross, Tim Walters, Wes Weaver, Wheres Gordon, and the rest of the “never a dull moment” Digi gang.

Copyright
This manual is copyrighted ©1994 by Digidesign, Inc. with all rights reserved. Under copyright laws, this manual may not be duplicated in whole or in part without the written consent of Digidesign.

One Year Limited Warranty
Digidesign, Inc. warrants Sound Designer II to conform substantially to the specifications of this manual for a period of one year from the date of original purchase when used in accordance with the specifications detailed in this manual. In the case of a valid warranty claim, your sole and exclusive remedy and Digidesign's entire liability under any theory of liability will be to, at its option, repair or replace the product without charge or, if not possible, to refund the purchase price to you. This warranty is not transferable, it applies only to the original purchaser of the product. For warranty service, please call Digidesign, Inc. at (415) 688-0744 (European users should call +40 841-082) to obtain a Return Authorization (RA) number. Next, ship the defective product, transportation and insurance charges prepaid, to Digidesign Inc., 1360 Willow Road, Suite 101, Menlo Park, CA 94025. Write the RA number in large letters on the outside of the shipping box. Enclose your name, address, telephone number, copy of original sales invoice and a detailed description of the problem. Digidesign will not accept responsibility for loss or damage in transit.

This warranty is void if the product serial numbers have been removed from the product or if the product has been damaged by misuse, modification or unauthorized repair.

THIS WARRANTY IS IN LIEU OF ALL WARRANTIES, WHETHER ORAL OR WRITTEN, EXPRESS, IMPLIED OR STATUTORY. DIGIDESIGN, INC. MAKES NO OTHER WARRANTY, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. PURCHASER'S SOLE AND EXCLUSIVE REMEDY UNDER THIS WARRANTY SHALL BE REPAIR OR REPLACEMENT AS SPECIFIED HEREIN.

IN NO EVENT WILL DIGIDESIGN, INC. BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE PRODUCT, INCLUDING LOST PROFITS, DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGE FOR PERSONAL INJURY, EVEN IF DIGIDESIGN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Some states do not allow the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above limitations may not apply to you. This warranty gives you specific legal rights. You may have other rights which vary from state to state.

Registered User Customer Support
Digidesign will provide telephone support to registered users for a period of one (1) year from the date of original purchase. For customer support in the US, please call (415) 688-0744. European users in the UK please call +81-875-9977. In Germany/Beneleux call +40-841-082. In South America, call +525 687 4559.

All trademarks are property of their respective holders.

All features and specifications subject to change without notice.

©1994 Digidesign Inc.
All rights reserved

PN 932002962 Rev A 9/94
DIGIDESIGN END USER LICENSE AGREEMENT

NOTICE TO END USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT PRIOR TO USING THE SOFTWARE PROVIDED WITH THE AGREEMENT (Sound Designer II®). USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THE AGREEMENT, PROMPTLY RETURN THE SOFTWARE AND THE ACCOMPANYING ITEMS (INCLUDING WRITTEN MATERIALS AND CONTAINERS) TO THE LOCATION WHERE YOU OBTAINED THEM FOR A FULL REFUND.

1. License Grant. Digidesign grants to you (either as an individual or entity) a personal, non-transferable, and non-exclusive right to use the copy of the object code version of the SOFTWARE provided with this license. You agree you will not copy the materials accompanying the SOFTWARE.

2. Copyright. You acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive property of Digidesign or its suppliers, and you will not acquire any rights to the SOFTWARE except as expressly set forth above. You agree that any copies of the SOFTWARE will contain the same proprietary notices which appear on and in the SOFTWARE.

3. Reverse Engineering. You agree that you will not attempt, and if you are a corporation, you will use your best efforts to prevent your employees and contractors from attempting to reverse compile, modify, translate, or disassemble the SOFTWARE in whole or in part.

4. Limited Warranty. Digidesign warrants that the SOFTWARE will perform substantially in accordance with the accompanying documentation and that the documentation and diskettes are free from any physical defects for a period of ninety (90) days from the date of purchase (“Limited Warranty”).

5. Customer Remedies. Digidesign’s entire liability and your sole and exclusive remedy shall be, at Digidesign’s option, either to (a) correct the error, (b) help you work around or avoid the error or (c) authorize a refund, so long as the SOFTWARE, documentation and diskettes are returned to Digidesign with a copy of your receipts. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period.

6. No Other Warranties. DIGIDESIGN DOES NOT WARRANT THAT THE DIGIDESIGN SOFTWARE IS ERROR FREE. DIGIDESIGN DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING DOCUMENTATION OR DISKETTES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

7. Term. This Agreement is effective until terminated. You may terminate this Agreement at any time by destroying the SOFTWARE together with any copies in any form. Digidesign may terminate this Agreement if you fail to comply with any term or condition herein.

8. Severability: In the event of invalidity of any provision of this Agreement, the parties agree that such invalidity shall not affect the validity of the remaining portions of this Agreement.

9. No Liability for Consequential Damages. IN NO EVENT SHALL DIGIDESIGN BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE USE OF THE DIGIDESIGN SOFTWARE, EVEN IF DIGIDESIGN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL DIGIDESIGN’S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU.

10. Export. You agree that you will not export or re-export the SOFTWARE without the appropriate United States or foreign government licenses.

11. Governing Law. This Agreement will be governed by the laws of the State of California as they are applied to agreements between California residents entered into and to be performed entirely within California. The United Nations Convention on Contracts for the International Sale of Goods is specifically disclaimed.

12. Entire Agreement. This is the entire agreement between you and Digidesign which supersedes any prior agreement, whether written or oral, relating to the subject matter of this Agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS

If this product is acquired under the terms of a: DOD contract: Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of 252.227-19(a) through (d) and restrictions set forth in the accompanying end user agreement. Unpublished-rights reserved under the copyright laws of the United States.

Should you have any questions concerning this Agreement, or if you desire to contact Digidesign for any reason, please write: Digidesign, Inc., 1360 Willow Road, Suite 101, Menlo Park, CA 94025.
Digidesign's Update and Support Policy

Digidesign will provide telephone support to registered users for a period of one year from the date of original purchase. As a new Sound Designer II owner, the first action you should take is to send in your registration card. You must be a registered owner if you want to receive telephone support, program updates, or new product information. Once you are a registered owner, program updates will be made available to you for a minimal charge.

Digidesign is serious about customer support, and is strongly committed to a continuing relationship with you after your purchase. As a registered Sound Designer II owner, you can contact Digidesign directly with any questions or problems. A Sound Designer II Technical Support person will be standing by to help you during business hours.

For the best service, please have the following information ready before calling: 1. Apple System software version 2. Relevant Digidesign software version 3. Digidesign hardware configuration 4. Hard disk mechanism model number and firmware revision

Telephone Technical Support is available from the following locations (please, DO NOT call any other Digidesign numbers (sales, Pro School, etc.) with technical problems):

**Digidesign US (English speaking)**
Phone: 415 688 0744
Fax: 415 327 3131
Hours Monday through Friday — 9:00am - 5:30pm PST

**Digidesign Germany/Beneleux (English, Dutch, and German speaking)**
Phone: +31 40 841 082
Fax: +31 40 840 363
Hours: Monday through Friday — 9:30am - 5:30pm GMT

**Digidesign South America (Spanish and English speaking)**
Phone: +525 687 4559
Fax: +525-687 4732
Hours: Monday through Friday — 9:30am - 5:30pm

**Digidesign UK**
Phone: +81 875 9977
Fax: +81 875 9987
Hours: Monday through Friday — 9:30am - 5:30pm GMT

Digidesign is made up of people who are very interested in audio and the recording process as a whole. Become one of our registered owners and participate in the creative process.
Contents

Chapter A: Introduction
Preface .............................................................................................................................. 3
Hardware Requirements .................................................................................................... 3
About your Sound Designer II User's Guide ....................................................................... 4
Installing the Sound Designer II Software ........................................................................ 5
Starting the Sound Designer II Application ........................................................................ 7
"De-authorizing" Your Hard Disk ...................................................................................... 8
Summary ........................................................................................................................ 15

Chapter B: Getting Started with Sound Designer II
Introduction .................................................................................................................... 19
Essential Concepts: Destructive and Non-Destructive Editing .......................................... 19
   About Soundfiles ....................................................................................................... 20
Sound Designer II Basics: Opening, Saving and Closing Files ........................................... 22
The Soundfile Window .................................................................................................... 32
   Title Bar .................................................................................................................... 33
   Close Box .................................................................................................................. 33
   Overview Display ...................................................................................................... 33
   View Indicator ........................................................................................................... 34
   Waveform Display .................................................................................................... 34
   Amplitude and Time Axes ......................................................................................... 35
   Mac-to-SampleCell ................................................................................................. 35
   The Speaker .............................................................................................................. 36
   The Zoomer .............................................................................................................. 36
   The Pencil ................................................................................................................. 37
   The Selector .............................................................................................................. 37
   The Display Scale Arrows .......................................................................................... 38
   Marker/Loop Tools .................................................................................................... 38
   The Numbered Marker Tool ..................................................................................... 39
   The Text Marker Tool ............................................................................................... 39
   The Loop Start Marker Tool ..................................................................................... 40
   The Loop End Marker Tool ...................................................................................... 40
   The Tape Deck Button .............................................................................................. 40
   The Playlist Button .................................................................................................. 41
Chapter C: Hard Disk Recording and Non-Destructive Editing

Introduction ............................................................................................................ 47
Recording to Your Hard Disk ........................................................................................... 52
Playing Back Audio .......................................................................................................... 53
Understanding Waveforms On Screen ............................................................................. 54
Creating and Editing Playlists .......................................................................................... 56
  Selecting a Region .................................................................................................... 59
  Selection Shortcuts ................................................................................................... 60
Creating and Assembling a New Playlist ........................................................................... 63
Setting Playlist Crossfades and Transitions ....................................................................... 65
Further Editing of Playlists ............................................................................................... 70
  Fine Tuning Regions with the Edit Regions Dialog .................................................... 71
Summary ........................................................................................................................ 76

Chapter D: Destructive Editing and Digital Signal Processing

Introduction .................................................................................................................... 79
Digital Cut and Paste Editing ........................................................................................... 79
Trimming Excess Data ..................................................................................................... 81
Reversing a Passage ......................................................................................................... 82
Permanently Silencing A Passage ..................................................................................... 82
Fading a Passage In and Out ........................................................................................... 82
Optimizing Playback Levels ............................................................................................. 83
Compare Files ................................................................................................................. 86
Inverting Amplitudes ....................................................................................................... 87
About Digital Signal Processing ......................................................................................... 88
Mixing Up to Four Soundfiles .......................................................................................... 89
Merging Two Soundfiles .................................................................................................. 91
Sample Rate Conversion .................................................................................................. 93
Common DSP Functions ................................................................................................. 95
  Applying the DSP Settings Permanently ................................................................ 95
  Applying DSP Settings Non-destructively ............................................................... 95
Chapter G: Reference

Introduction .................................................................................................................. 153
The File Menu ............................................................................................................... 153
The Edit Menu .............................................................................................................. 156
The DSP Menu .............................................................................................................. 160
The Playlist Menu .......................................................................................................... 163
The Display Menu ......................................................................................................... 165
The Setup Menu ........................................................................................................... 168
Summary ...................................................................................................................... 177

Appendix

Basic Sampling Concepts .............................................................................................. 181
Keeping Your Hard Disk Tuned-Up ................................................................................ 183
About Plug-Ins .............................................................................................................. 185
How To Use Dither In Sound Designer II ....................................................................... 186
  What Is Dither? ........................................................................................................... 186
  How Is Dithering Done? .......................................................................................... 187
  How Do I Use Dither In Sound Designer II? ............................................................. 188
  When NOT to use Dithering ................................................................................... 188
  When is Simple Dithering used? ............................................................................. 188
  When is Complex Dithering Used? ......................................................................... 189
  How Do I Select Which Type Of Dither Is Used? ..................................................... 189
  Limitations .............................................................................................................. 190
Backup and Archiving Suggestions ................................................................................ 191
Using the JL Cooper CS-1 or CS-10 with Sound Designer II ........................................... 193
Key Command Shortcuts in the Soundfile Window ....................................................... 197
Recommended Reading ................................................................................................ 198

Index

Index ............................................................................................................................ 201
Chapter A

Introduction
An Introduction to Sound Designer II

Preface

Welcome to Sound Designer II. Sound Designer II is the software “interface” for Digidesign’s Sound Tools II™, Audiomedia II™, Audiomedia LC™ and ProMaster 20™ digital audio recording and editing systems. By installing one of these systems and the Sound Designer II software in your Macintosh, your computer becomes a sophisticated digital audio production studio in which CD-quality digital audio can be recorded, edited, and arranged with great flexibility and precision.

Sound Designer II is ideal for a variety of users and applications. Musicians can use it to record and arrange CD-quality master recordings. Video and film professionals can use it to edit and assemble dialog, sound effects, and music. Sound designers can use it to sample and edit sounds for music or film. Multimedia producers can use it to record and produce soundtracks for presentations. Virtually anyone with an interest in audio and a compatible Macintosh can benefit from Sound Designer II.

Hardware Requirements

In order to install and use Sound Designer II, you will need:

- A standard NuBus-equipped, 25MHz, 68030 or faster CPU Macintosh, with at least 8 megabytes of RAM (you cannot use the Macintosh’s “Virtual Memory” capability with Sound Designer II).

- A Digidesign digital recording system such as Session 8™, Sound Tools II, ProMaster 20, ProTools™, Audiomedia II, or Audiomedia LC

  Note: Sound Designer II no longer supports Sound Tools I or SE/30 cards

- Apple’s System software version 7.1 or higher, running in 32-bit mode

- A hard disk with an average access speed of 18 milliseconds or faster

- Apple’s Sound Manager 3.0 (only required to play back thru the Mac speaker)
To record and play back audio you will also need:

- A stereo amplifier and speakers and/or headphones.

---

**About your Sound Designer II User’s Guide**

Your Sound Designer II User’s Guide is designed to teach you how to install and use Sound Designer II. Even if you simply hate to read manuals (as most of us do), make an exception this time. Your User’s Guide is the key to unlocking the power of Sound Designer II. Here’s a brief overview of what you should expect to find in your Sound Designer II User’s Guide:

**Chapter A** explains the hardware/software requirements of Sound Designer II and provides instructions for installing the Sound Designer II software. At the end of Chapter A you will be shown how to open and listen to one of the example files from your Sound Designer II disk to verify that your installation was successful. Be sure to read this entire chapter.

**Chapter B** provides an introduction to Sound Designer II by taking you on a “guided tour” of the program’s main window. You’ll also learn some Sound Designer II basic terminology, concepts and general techniques such as how to save, close, and open documents. Be sure to read this chapter as it contains definitions and explanations of terms that are used throughout the remainder of your User’s Guide.

**Chapter C** explains Sounds Designer II’s hard disk recording and non-destructive editing capabilities.

**Chapter D** explains destructive editing and digital signal processing in Sound Designer II.

**Chapter E** tells you how to loop samples in the Loop Window, and how to take advantage of Sound Designer II’s built-in support for SampleCell.

**Chapter F** describes how to synchronize Sound Designer II with SMPTE timecode.

**Chapter G** is a reference chapter, and provides definitions and functions of every menu command and dialog box in the Sound Designer II program.

The **Appendix** contains general information including basic sampling concepts, hard drive maintenance suggestions and an explanation of Dither.
Important
Whenever your manual has something particularly important to tell you, such as an important warning or a word of caution, you'll be alerted by an important header, like the one above. Please pay special attention to these portions of the manual.

Whenever the manual has a shortcut or tip, you'll be alerted by an exclamation mark icon like the one shown above. By reading all these tips you'll become aware of all the options that Sound Designer II provides.

Before using Sound Designer II, you should have a working knowledge of the Macintosh computer and its operating conventions. These include how to use a mouse; how to open, close, and save files; and how to use standard Macintosh menus and commands. If you are unfamiliar with how to perform any of these tasks, please spend some time learning your Macintosh before going any further.

Installing the Sound Designer II Software

This section shows you how to install Sound Designer II on your hard disk. Please carefully follow the steps outlined below to ensure a successful installation. First, you will install Sound Designer II from floppy disk onto your hard disk. Later, when you start Sound Designer II for the first time, you will authorize your hard disk and complete the installation process.

Before you install the Sound Designer II software, make sure that you have installed and connected the hardware (Audio Card and/or Audio Interface) that came with your Digidesign digital recording system. Although you will be able to install the software, Sound Designer II will not open unless your Digidesign DSP (Digital Signal Processing) card is installed in one of your computer's NuBus slots.

As described earlier, Sound Designer II requires that System 7.1 or later be running on your Macintosh, and that 32-bit Addressing be turned on. If 32-bit Addressing is not already on, turn it on now. To do so, simply open the Control Panels folder within your System folder, double-click the item called Memory, and click the On button under 32-bit Addressing. At the same time, make sure that Virtual Memory is set to Off. After you do this, restart your computer.
Important

Sound Designer II uses the U.S. version of the Apple Installer. Do not rename the System Folder, or the install process will create a “System Folder” folder containing the extensions and control panels. You must then manually move these files into the correct System Folder. If you are running a non-U.S. System, run the Installer and then move the files from the “System Folder” to their corresponding folders. The document “About these files...” on the Install 1 disk describes the purpose and destination folder for each System Folder file.

To install Sound Designer II on your hard disk:

- Insert the “Install 1” disk into any floppy drive connected to your system.

- Double-click the file called Install. The Welcome screen will appear - click OK after you read it. Next, the Apple Installer dialog will appear.

- Select the hard disk on which you want to install Sound Designer II using the Switch Disk button. It is recommended that you install to the internal drive, or the drive that contains the active System. (Do not install Sound Designer II on your System Accelerator drives as you will lose the ability to de-install it.)

- Click Install. The installation program will place all the necessary files (Sound Designer II, DigiSystem INIT) in the appropriate folders. If you already have a folder named Digidesign on your drive, the installer will first create a new folder called Sound Designer II inside your Digidesign folder. The installer will then install the Sound Designer II software inside the newly created folder. The installer will prompt you to insert the other disks - follow the on-screen instructions.

If you see any error messages, check your hard drive to make sure you have enough available space to install Sound Designer II (approximately 2 Mb minimum). Repeat the installation procedure and make sure to double-check that you have met all the system requirements. If you still experience difficulty, contact Digidesign Customer Support at any of the numbers listed on page iv (before the Table of Contents).

When you have completed the installation, proceed to the next section to find out what to expect the first time you launch Sound Designer II.
Starting the Sound Designer II Application

This section tells you how to start Sound Designer II. You should already have installed and connected your Sound Designer II software, Digidesign hardware and external hard drives. If you haven’t yet connected any of these components, do so now before trying to launch Sound Designer II.

Sound Designer II is copy-protected with a very simple-to-use, first-time-only “key disk” protection system. The first time you launch Sound Designer II after installing it from floppy disk, you’ll be asked to insert your key disk (the Sound Designer II “Install 1 disk). This disk permits two installations (referred to as hard disk “authorizations”), which allows for one initial installation, and one backup installation. It also allows for removing the key from your hard disk to replace one of the two authorizations. Registered users receive a backup installation disk, providing additional installs.

*Note: Optimizing your hard disk will not erase authorization, but you must remove the key (referred to as “de-authorization”) before formatting or initializing your hard disk. Refer to the Appendix for more information on hard disk maintenance.*

To Authorize Sound Designer II:

- Double-click on the installed Sound Designer II application. The following dialog appears:

  ![Unauthorized Copy Dialog](image)

  This is an unauthorized copy. Please insert the Sound Designer II “Install 1” disk into any available drive.

- Next, insert the “Install 1” disk. The following dialog appears:

  ![Authorization Dialog](image)

  This copy of Sound Designer II™ is not authorized to run on your hard disk. Select Authorize to enable this copy to run on your hard disk without requiring the master diskette.
  
  Select Continue to run this copy or Quit to quit Sound Designer II™.

  ![Authorize Button](image)

- Click Authorize. You’ll now see a couple of status dialogs as the installer authorizes your hard disk.
When authorization is finished, this dialog appears:

![Dialog box](image)

This dialog box confirms that your hard disk is now authorized to run Sound Designer II, and tells you how many more authorizations your disk has left. (In the example above, the disk has a remaining authorization count of 1.)

- Click OK. Sound Designer II will now open, and its menu bar will appear across the top of your screen. The exact sequence of events at start-up will depend on whether or not you use OMS™ — refer to the section Starting and Configuring Sound Designer II later in this chapter for more information.

This completes the installation and authorization of Sound Designer II. You can now start Sound Designer II at any time by double-clicking on its icon (and without the Install 1 disk being inserted).

The next section explains how to de-install Sound Designer II. Unless you need to remove Sound Designer II from your hard disk right now, skip this section and proceed to the section Starting and Configuring Sound Designer II, later in this chapter. (You'll want to de-install Sound Designer II before you reformat or initialize your hard drive.)

**“De-authorizing” Your Hard Disk**

On an authorized hard disk, you can start up, use, and even move Sound Designer II around without ever being prompted for your master disk. After you have used your Install 1 disk to authorize your hard disk twice, no additional authorizations can occur until an authorization is replaced onto the Install 1 disk by using the De-authorization feature of the Sound Designer II installer.

**To De-authorize your hard disk:**

- Insert the Sound Designer II Install 1 disk into any floppy drive. Make sure that the hard disk that you want to de-authorize is connected to the Macintosh and is mounted.

- Double-click on the Sound Designer II icon on the master disk to launch the installer.
The following dialog appears:

- Click on *Setup*. Next, this dialog box appears:

- Click *Deauthorize*. The following dialog will appear:

- Make sure the appropriate hard disk is selected (use the pop-up menu to select a different disk, if necessary) and click *OK*.

A status dialog will appear briefly while de-authorization takes place, after which the following dialog appears confirming that you have replaced one authorization onto the Install 1 disk.
Authorization to run Sound Designer II™ has been removed from "Mac HD". You have a remaining authorization count of 2.

OK

• Click OK. When the next dialog box appears (the “Authorize/Deauthorize” dialog), click Quit to return to the Finder.

De-authorization is now complete. If you now try to launch Sound Designer II (assuming you left a copy on your hard disk) you will see the “This is an unauthorized copy” dialog every time you start the application. This dialog only appears when launching Sound Designer II on a hard disk that is not authorized.

Note: Do not lose or alter your Sound Designer II disks in any way! You will not be able to complete an installation without them. Keep the disks locked to avoid any accidents, and store them in a safe place.

If you have any problems installing, authorizing or deauthorizing Sound Designer II, try repeating the steps listed above. If you have tried and still have problems, call Digidesign Technical Support using one of the phone numbers listed on page iv.

Important
As part of the auto-installation, a folder called SD II Sample Rates was placed inside the same folder as Sound Designer II. It is very important that the SD II Sample Rates folder resides in the same folder as the Sound Designer II application. Without these files, Sound Designer II will not open.

Register your software!
• Fill out and send in your Registration card right away. Doing so will make sure you’re eligible for technical support plus ensure you will receive any updates and news regarding Sound Designer II. Registered owners of Sound Designer II also receive a backup disk with additional authorizations.
Starting and Configuring Sound Designer II

This section tells you how to start-up and configure Sound Designer II for your Digidesign system. You should already have installed and connected all your hardware. If you haven’t yet connected any of these elements, do so now before trying to launch Sound Designer II.

The Sound Designer II Installer placed a copy of the Sound Designer II Read this First file in the Sound Designer II folder. The Read this First file contains any late-breaking updates that didn’t make it into the manual. Please read it before going any further.

To examine the Read this First file:

- Open the Sound Designer II folder.
- Double-click on the SDII Read this First icon to open it. Please read the entire document.
- When you have read the entire document, select Quit from the File menu to return to the Finder.

Starting Sound Designer II

If you have just authorized your hard disk as explained earlier in this chapter, Sound Designer II is probably already running. The following are simple instructions for starting Sound Designer II from the Finder.

To start Sound Designer II:

- Double-click on the Sound Designer II icon to start the program. Sound Designer II was installed inside the folder Sound Designer II inside your Digidesign folder.

If you use OMS™ (Opcode’s Open MIDI System) and have not yet turned off AppleTalk, OMS will display a dialog giving you several options for dealing with AppleTalk. Refer to your OMS documentation if you need additional information about OMS and AppleTalk.
In a moment, Sound Designer II’s menu bar will appear at the top of your computer screen.

The first thing you’ll do is configure playback for your particular hardware.

- From the Setup menu, choose *Sound Playback*. The following dialog appears:

```
Sound Playback Options

- Digidesign Card
- Direct from disk
- Continuous SMPTE Sync

OK
```

The Sound Playback dialog

The Sound Playback dialog has two radio buttons and two checkboxes for controlling playback of Sound Designer II.

**Digidesign Card** instructs Sound Designer II to output its audio through your Digidesign DSP card. (If you have more than one Digidesign DSP card installed in your computer, specify which DSP card to use from within the *Hardware Setup* dialog. This dialog is accessed by choosing *Hardware Setup* from the Setup menu.)

The two checkboxes **Direct from disk** and **Continuous SMPTE Sync** select additional options available when using a Digidesign DSP card for playback. Selecting **Direct from disk** (by clicking in the checkbox) configures Sound Designer II to play back directly from your hard disk. When **Direct from disk** is not checked, Sound Designer II will only play back the contents of RAM.

*Note: Loops cannot be played direct from disk. Also, direct from disk playback may cause a slight hesitation before playback begins, unless Pre-allocate HD buffers is selected in the Preferences dialog of the Setup menu. If you want immediate direct-from-disk playback choose Preferences from the Setup menu and select Pre-allocate HD buffers.*

If you plan to trigger playback of soundfiles with SMPTE, check **Continuous SMPTE Sync**. This ensures that Sound Designer II playback remains perfectly synchronized. However, because of the DSP processing power required to
implement this feature, you will not be able to implement other DSP functions such as Graphic EQ and Dynamics in real time.

- If it's not already selected, click the button next to Digidesign Card. This will enable you to play audio through your Digidesign DSP card (which should be connected to a mixer, power amp, and speakers).

We strongly recommend that you configure Sound Designer II to use your Digidesign Card for sound playback. However, if for some reason you don’t wish to use your Digidesign card for this purpose, you have another option.

Though it is not generally recommended because of its low fidelity, you can use your Macintosh’s built-in speaker for playback, too. To do this, do the following:

**To configure SDII to play sound through the Macintosh’s speaker:**

- In the Sound Playback dialog box, click the button next to Sound Manager. This will enable you to play audio through your Macintosh’s speaker.

- After you have configured the Sound Playback options, click OK to close the dialog box.

Now let’s open one of the example files that came with your Sound Designer II package and verify your playback settings and hardware connections. To do this, we’ll use the file Left/Right. It should have been installed in the same folder as Sound Designer II. Check and make sure this file is on your hard disk before trying to open it (do not open it from the floppy disk).

**To open the file Left/Right:**

- Choose Open from the File menu. The following dialog appears:

![The Open Soundfile dialog](image)
• Locate the file *Left/Right* and click on (highlight) it. This file was included on your Sound Designer II installer disks and should have been installed in your Sound Designer II folder. If *Left/Right* is not on your hard disk, click *Cancel* and then copy the file from your Sound Designer II disks onto your hard disk (do not open it from the floppy disk).

• With *Left/Right* highlighted, click *Select* to open the file. When the file opens in Sound Designer II, the Soundfile window will appear similar to the following:

![The Soundfile Window](image)

Now let's listen to the soundfile *Left/Right*.

**To listen to *Left/Right***:

• Press the Space bar of your computer keyboard to play the soundfile from the beginning. In the next chapter, you'll learn other methods to initiate playback).
Listen to the soundfile. If your hardware and audio system is connected properly, you should first hear the word “Left” in your left speaker, followed by the word “Right” in the right speaker. To listen to it again from the beginning, press the Return key and then press the Space bar again.

If you do not hear anything, check your audio connections and volume settings to make sure everything is plugged in and turned up to an audible level. If your audio connections appear to be correct, check to make sure your Sound Playback is configured correctly. If you are listening through Sound Manager, check to make sure the volume is up in the Sound Control Panel of your Macintosh. If you still experience difficulty, refer to the hardware installation instructions that came with your Digidesign system.

Summary

You should now have installed and configured the Sound Designer II software for playback, opened a soundfile and tested your setup using the soundfile Left/Right. You are now ready to move on to Chapter B, Getting Started with Sound Designer II.
Chapter B

Getting Started with Sound Designer II
Introduction

This chapter explains the tools, buttons, windows and basic file management features you'll be working with in your recording and editing sessions with Sound Designer II. Before diving into these features, however, it is necessary to define and explain some essential terms and concepts of Sound Designer II and hard disk recording in general.

Essential Concepts: Destructive and Non-Destructive Editing

Sound Designer II software is capable of both destructive and non-destructive random access editing of digital audio. Before you start using Sound Designer II it is helpful to understand these concepts and related terms.

Random access Random Access editing means that your Digidesign system allows you to go to any point in a recording without having to rewind or fast-forward to find it as you would with tape. Aided by Sound Designer II's graphical display of your audio data, you can navigate through sound with unprecedented ease and speed.

Soundfile The audio you record and edit in Sound Designer II takes the form of a soundfile. A soundfile can be stored on disk in a variety of formats (described later in this chapter).

Region A region is really just a “piece” of audio data of any length. An audio region could be a guitar riff, a verse of a song, a sound effect, a piece of dialog, or even an entire soundfile. In Sound Designer II, regions are “captured” from an audio file and strung together to create an audio “playlist” within Sound Designer II’s Playlist Window.

Playlist A Playlist is a list of regions strung together in a specific order. Because audio is recorded on hard disk, it can be freely manipulated, unlike when using tape. Therefore, the Playlist is merely a set of instructions which tell the hard disk which audio regions
to “read” in what order. In the same way that a word processor allows you to cut, paste, move and delete words, sentences, and paragraphs, Sound Designer II’s Playlist lets you cut, paste, move and delete sound. In fact, you can almost think of Sound Designer II as a “word processor for sound.”

**Destructive** editing refers to operations such as cutting, pasting, normalizing, and other functions which *permanently* alter a soundfile. Sound Designer II provides many of these types of destructive editing features.

**Nondestructive** editing refers to editing which will not permanently alter the original audio data on your hard disk. With this type of editing, no matter how many changes you make, your original recordings remain intact. This type of editing is one of Sound Designer II’s most important features.

Nondestructive editing works like this: When you edit an audio file within Sound Designer II’s *Playlist* window you are not really cutting and moving chunks of sound as you would if you were editing analog tape. Instead, Sound Designer II is merely creating a “map” of your audio file. This map, or “playlist”, simply describes the order in which you want portions of the recording to be played. If you’d like to hear the middle of a song first, the end next and the beginning last, then so be it. Sound Designer II will tell the hard disk (where the information is stored) to go to the middle of the recording and play that portion first, followed by the others.

With non-destructive editing, you are free to experiment with music and sound in ways never before possible. You can move and rearrange “pieces” of audio with total freedom. Edits can be heard as soon as you perform them. Sound Designer II offers a fast, flexible, and powerful approach to recording and editing digital audio.

---

**About Soundfiles**

Here are brief explanations of each of the file formats which Sound Designer II supports:

**Sound Designer** The Sound Designer file format is the standard 16-bit mono format used by the original Sound Designer program. It is useful for file exchange with programs that support only Sound Designer files.

**Sound Designer II** Sound Designer II is the standard 8-, 16- and 24-bit mono and stereo format. It is also the recommended file format for Digidesign systems.
Audio IFF (AIFF)  The AIFF file format is Apple's Audio Interchange File Format. It is a variable-resolution, multi-channel soundfile format. The AIFF format can be used to create and store mono or stereo files, of all supported bit resolutions and sample rates.

System 7 Sound  The System 7 Sound format (sfil) is a type of soundfile which contains a single snd Resource (described below). Prior to the arrival of System 7, Macintosh sounds were limited to resources which had to be stored within applications and/or fit into RAM — resource data itself could not be read directly from disk. When the Resource Manager was rewritten for System 7 this limitation was removed, and made it possible for a snd Resource to “exist” outside of an application.

Compressed  When saving a copy of a Sound Designer II sound file, you can choose to save it in Compressed format. This format is useful for conserving disk space, because it compresses files at the ratio of 2:1 or 4:1 using a technique called adaptive differential pulse code modulation, similar to that used in CD-I.

.WAV (PC)  PC.WAV is a standard soundfile format used on Windows® compatible PC computers. You can use Sound Designer II to edit any .WAV file, including Digidesign Session 8™ and SampleCell II PC audio data.

snd Resource  The snd Resource format is the standard Macintosh sound resource format. Format 1 and Format 2 snd Resources are supported. When saving a snd Resource, you have the option of entering the resource ID, sample size and the number of channels, along with the resource name and base note.

SD II Split Stereo  SD II Split Stereo is a pair of Sound Designer II format mono files (a.k.a. “Split Stereo”) which are treated as one stereo pair. This is the standard stereo file format used by Digidesign’s Pro Tools™ multi-channel hard disk recording system. In order for Sound Designer II to open a Split Stereo file, the two files must be in the same folder, and the names must be identical except for the appropriate suffixes “.L” and “.R.” (L and R can be upper or lower case).
Sound Designer II Basics: Opening, Saving and Closing Files

This section will cover all the basics of using Sound Designer II, including how to create new documents, and how to open, save and close new or existing documents.

Creating a New Document
The first step in beginning a Sound Designer II project is creating a new soundfile.

To create a new document:

- Choose New... from the File menu. The New... dialog appears:

![The New... dialog]

The New... dialog lets you name the new document and choose the location where it will be created. In addition, the three pop-up menus at the bottom let you choose the file format, bit resolution, and number of channels for the new document.

- To set the file format for the new document, click and hold down on the left-most pop-up menu at the bottom of the dialog. The file format pop-up appears:
The File Format pop-up menu from the New... dialog

- Select the type of file format you want to create. Refer to the previous section "About Soundfiles" earlier in this chapter for descriptions of each of the available file types. Sound Designer II 16-bit stereo is the default file format.

- Use the remaining two pop-up menus to select the bit resolution (8-, 16-, or 24-bit) and mono/stereo status for the new file. If you are not sure which resolution setting to use, choose 16. You can convert the file later if you need to deliver it in 8-bit (as you would for most multimedia projects).

- Enter an appropriate name for your new file. Choose a location for it and click New. An empty Soundfile Window appears.

Tip: Using the New... command in combination with Sound Designer II's cutting and pasting capabilities can be used to convert files from one format to another. For example, to convert a 16 bit soundfile to 8 bit, you would copy and paste the 16 bit audio data into a new 8-bit document.

Opening a Soundfile

If you want to work on a soundfile that you created previously, you can open it with the Open..., (and Open Resource...) command.

To open an existing file for editing:

- Select Open... from the File menu. A file dialog appears:
The Open... dialog

The Open dialog has two file windows. The window to the left allows you to locate and open files and/or aliases of soundfiles on your hard disk. A check in any of the file format boxes at the lower left of the dialog (Sound Designer, Sound Designer II, Audio IFF, System 7 and .WAV) will tell Sound Designer II to display any files of that type in the hard disk folder currently being displayed. In the example shown above, all supported file types are selected to be shown, and the demo file Drums is selected. (Drums was installed in the same folder as Sound Designer II, along with the other demo file Left/Right).

- Check the box next to the type of file that you want to open (Sound Designer, Sound Designer II, Audio IFF, System 7 or .WAV)

Note: To open a .WAV file, the file type must match your settings in the “.WAV File Type” field of Sound Designer II’s Preferences dialog. Use ResEdit to check or change the file type in the .WAV file after you transfer it to your Macintosh.

When you have selected an audio file (or its alias), regions or playlists associated with it will appear in the window to the right when you select one of these viewing options with one of the radio buttons near the bottom of the dialog. You can try this yourself using the Drums file: select Drums in the left window and then click the radio button Regions or Playlists. You can use these buttons to open individual Playlists and Regions, or entire soundfiles. You’ll learn more about Regions and Playlists later. You can also audition files, regions and playlists from within the Open dialog by selecting them and clicking on the Play button.
Sound Designer II can create and open 8-, 16- and 24-bit audio files. 16-bit resolution is the recommended format for professional recording, as it provides CD quality fidelity. 8-bit resolution, usually used for multimedia and system sounds, is lower in fidelity and is therefore unsuitable for professional audio recording. 24 bit audio is the maximum resolution supported by Digidesign’s current line of DSP devices, including the TDM Bus™ and the ProMaster 20™. Contact your nearest Digidesign dealer or Digidesign PreSales for more information on these systems.

NOTE: The Open Resource... command in the File menu is used to open Macintosh SND Resource files. Resources are embedded within documents and applications, so the Open Resource... dialog will show documents and applications, instead of showing only soundfiles.

Saving Your Work

Saving is not just something you should do at the end of a session. In fact, you should get in the habit of saving frequently throughout your sessions in order to avoid the possibility of losing valuable work due to some unforeseen accident. In addition to standard Save commands, Sound Designer II contains several commands which provide added security against data loss. These commands include Use Backup Files, Temp File Location, Undo, Allow Edit Undo and Revert to Saved.

Using Backup Files

Before you begin using Sound Designer II to edit audio files you may wish to turn on the Use Backup Files option in the Setup menu. This section will tell you how to use this option, as well as how to specify where you want the backup file stored.

When the Use Backup Files command is checked in the Setup menu, Sound Designer II will create a backup copy of any file that is opened. In this mode, all edits are made to a copy of the original soundfile, and are NOT saved to the original until the File menu’s Save command is chosen. This is the safest way to edit soundfiles, because it allows you to undo changes and close a file without saving any changes you have made.

Because the Use Backup Files option creates a backup copy of any file that is opened, your hard disk will be using twice the original file size. To help avoid running out of disk space, you can choose a different hard drive location for the backup files via the Temp File Location command. If you plan to work with large audio files, choose the drive that has the most amount of free disk space as your Temp File location.
Important

Without the Use Backup Files command enabled, the actual audio data is directly altered whenever you perform an edit (i.e., all editing is destructive). For this reason it is wise to enable Use Backup Files whenever possible. The Use Backup Files option will only function if there is enough disk space to create and edit a backup file. If the required space is not available, a warning dialog will appear. You will then be allowed to open the soundfile only as a No Backup soundfile.

To edit a backup copy of your soundfile:

- Choose Use Backup Files from the Setup menu.
- Open the desired soundfile.

To disable this option, choose it once again from the menu.

To choose a hard disk volume to store Clipboard and Undo (Backup) files:

- Choose Temp File Location from the Setup menu. The Temp File dialog appears:

Sound Designer II will create its Undo and Clipboard files in the following directory:
ProStore 660:Digi Apps B/U:Audio

Choose Directory  OK

The Temp File Location dialog

This dialog displays the current Temp File location. In the example shown above, Sound Designer II is configured to create its Clipboard and Undo files to the folder Audio, which is within the folder Digi Apps B/U on the hard disk volume ProStore 660. This information is displayed in the form of the pathname ProStore 660:DigiApps B/U:Audio. To change the selected location use the Choose Directory button.

- Click the Choose Directory button. A Select Volume dialog appears.
- Select the appropriate hard disk volume and/or folder to use as the Temp File Location. When you have navigated to the appropriate volume, click Select.

You will return to the Temp File Location dialog box, and the pathname to the new Temp File Location will now be displayed. Click OK.
Recovering from Mistakes
Sound Designer II provides an *Undo* command to let you “undo” the last operation in case you made a mistake. Since some operations are extremely memory and disk intensive, not all actions can be undone. Sound Designer II will always warn you before performing an operation that will be permanent.

You can choose to have this capability on or off via the *Allow Edit Undo* command of the Edit menu. With Allow Edit Undo on Sound Designer II will attempt to make an Undo file for each destructive waveform edit you perform. When Allow Edit Undo is off, no undo file will be created. Leaving it off saves the time it takes Sound Designer II to create the undo file. A check appears next to it in the Edit menu when it is enabled.

**To turn *Allow Edit Undo* on or off:**

- Choose *Allow Edit Undo* from the Edit menu. A check appears next to the command when it is on. To turn it off, remove the check mark by repeating the process.

The on/off status of Allow Edit Undo is saved within the Sound Designer II application.

**To Undo your most recent edit:**

- Select *Undo* from the Edit menu.

In addition to Undo, Sound Designer II provides a *Revert to Saved* command. If *Use Backup Files* is engaged, choosing Revert to Saved from the File menu ignores changes you have made since your last save and returns to the old version. This command is disabled if the Use Backup File option is turned off.

**To revert to the previously saved version:**

- Choose *Revert to Saved* from the File menu.

Remember, the Revert to Saved command is only available when *Use Backup Files* is engaged.

**Saving a Soundfile and its Playlists**
The *Save* ... command saves the changes you have made and writes them over the original soundfile, using the same file format: This command cannot be undone.
To save the file under the same name:

• Select Save from the File menu. The original file will be updated.

Saving a File Under a Different Name

The Save A Copy... command is useful for saving a copy of the current soundfile under a different name, in a different format, or in a different hard disk location. It is also the only way to save a soundfile in Compressed format or as a Resource. Because the Save a Copy... command closes the current session and lets you keep working on the renamed copy, it is particularly useful if you are experimenting and want to save successive stages of the editing session. By working this way, you’ll always have the option of going back to an earlier version.

Important

Warning: To avoid confusion and possible errors, always have current backups of your data when saving soundfiles in split stereo format. Do not rely solely on the Macintosh alerts and warnings. In essence, Sound Designer II’s automatic appending of split stereo file names with the suffixes “.L” and “.R” can not be anticipated by the Macintosh. This has two potentially confusing side effects.

Let’s say you want to save the demo file “Left/Right” as a split stereo file. If you do not rename the file when you select “SDII Split Stereo” in the Save a Copy dialog, the Macintosh will automatically put up an alert saying "replace existing file “Left/Right”? (This example assumes another file named “Left/Right” already exists in the folder you have selected.) The problem is that Sound Designer II is not really going to create a file named “Left/Right”, but rather a file named “Left/Right.L” and “Left/Right.R” — therefore, the alert message about replacing the file with the same name is meaningless.

There is also a situation in which you will not be warned about replacing a file, as described in the following example. Let’s say you already have saved a split stereo version of “Left/Right” in a new folder. In other words, you now have the following files in the same folder — “Left/Right.L” and “Left/Right.R.” If you repeat the steps of the first example (i.e., open the original version of “Left/Right” and use the Save a Copy dialog to save a split stereo version) and go to save in the new folder, you will NOT be warned about replacing your earlier “Left/Right.L” and “Left/Right.R.” To the Macintosh, you are simply saving “Left/Right” in the same folder as the files “Left/Right.L” and “Left/Right.R”.

Sound Designer II User’s Guide
To save the file under a different name:

• Select Save A Copy... from the File menu. A file dialog will appear:

The Save A Copy... dialog

• Select the desired format, enter a name for the file, then click on Save.

Files can be saved in Compressed format to conserve file size, or as Macintosh snd resource in either 8- or 16-bit resolution, mono or stereo format.

The Compressed file format utilizes a technique called adaptive differential pulse code modulation to compress Sound Designer II files at the ratio of 2:1 or 4:1. When compression is selected, a dialog appears in which the compression may be selected and previewed. This format is useful for saving files when hard disk space is limited. Please be aware that by compressing a soundfile you are actually reducing the amount of sample data contained in the file, thus compromising its audio fidelity to some degree.

The Resource button is used to create sounds that can be played back by the Macintosh System, (the alert sound, for example), and by certain applications, such as HyperCard™.

To save a sound as a resource:

• Click on the Resource button to save the file as a Macintosh snd Resource. The following dialog appears:

The Save a Copy... as Resource button
This dialog provides additional options for saving snds Resource files.

- Enter a Name and Resource ID in the Name and ID fields. The name you enter here will be the name for the Resource in ResEdit™, the name you’ll use to play the sound from Hypercard, etc.
- Select a Format (Format 1 or Format 2).
- Enter a value for the Base note to indicate the pitch of the sound.
- Specify the Sample Size (8-bit or 16-bit).
- Select Mono or Stereo to specify the number of Channels.
- After specifying your options, click OK.

Next, a dialog appears asking you to choose an application into which you want to save the new resource. If an application is currently open it will not appear as a choice in this dialog box — resources can not be saved into open applications.

- Choose an application and click Save.

**Saving a Playlist as a New Soundfile**

This discussion of Sound Designer II’s Save features would not be complete without mentioning the Save Playlist as Soundfile command, even though Playlists are explained later in Chapter C.

In some cases, after you have created a definitive Playlist “remix” of an audio file, you may wish to permanently transform the Playlist into a new audio file of its own. In other words, the new soundfile will be the equivalent of digitally recording the output of a Playlist into a new file. The Save Playlist as Soundfile command lets you do just this.

Be aware that by doing this, the new file will be just as long as the Playlist’s play time, so you may require quite a lot of additional hard disk space.

**To save a Playlist as a soundfile:**

- Open the desired Playlist as explained in Chapter C in the section Creating and Editing Playlists.
- Choose Save Playlist as Soundfile from the Playlist Menu. A dialog box will appear allowing you to name the new file.
• Enter the desired file name and click OK. This creates a new soundfile with all of the attributes of the current Playlist—region playback order, fade ins/out, crossfades, and so on.

---

**Closing and Quitting**

The *Close* command closes your current Sound Designer II document but leaves the Sound Designer II application open. Although Sound Designer II will warn you before allowing you to close without saving changes, you will probably want to save your work using the *Save...* or *Save a Copy...* command before closing.

**To close a document:**

• Choose *Close* from the File menu (or click the close box at the upper left corner of the Soundfile window).

When you are ready to end your Sound Designer II session, the *Quit* command will quit Sound Designer II and return you to the Finder. Although Sound Designer II will warn you before allowing you to quit without saving changes, you will probably want to save your work using the *Save...* or *Save a Copy...* command before quitting.

**To Quit Sound Designer II:**

• Choose *Quit* from the File menu.

If you have made any changes since the last time you saved, Sound Designer II will ask you if you want to save them.

Now that you know the basics of file management in Sound Designer II, let's take a look at the Soundfile window.
The Soundfile Window

Sound Designer II's Soundfile Window is where you'll look at the audio that you record. It is the only place where you can view the actual sample data that makes up a sound. This is where you will perform all destructive editing as well as create non-destructive audio "regions" for use in Sound Designer II’s Playlist. Below is an example of what the Soundfile Window looks like with the stereo soundfile Drums open (Drums is one of the audio files installed by the Sound Designer II installer):

In this section you will learn about the different parts of the Soundfile Window. In the section immediately following ("Configuration Options"), you will learn how about configuration options and other Preferences Sound Designer II provides for customizing the application to suit your individual work habits.
Title Bar

**Drums - No Backup**

The Title Bar always contains the name of the soundfile you’re viewing in the Soundfile Window. Like all windows, you can move the active window by dragging its Title Bar.

In the Setup menu, Sound Designer has a command called *Use Backup Files* (explained in the section “Configuration Options” later in this chapter). If this command is turned off, the words “No Backup” appear after the file name in the Title Bar. This means you are making all edits permanently to the disk file and will not be able to “undo” them, so proceed with caution. For safety’s sake you may wish to turn the *Use Backup Files* option on. “Read-only” files, such as locked soundfiles or those opened from a CD-ROM, show a read-only indicator in the Title Bar.

**Close Box**

Click on the Close Box in the upper-left corner of the active window to close it. If you have made changes that have not been saved, you will be warned and given another chance to save them. The File menu’s *Close* command performs the same function.

**Overview Display**

The Overview Display shows the entire soundfile, either as a waveform or a time line.

**To choose between the Waveform Display and the Time Line Display:**

- Hold down the Option key while the mouse cursor is over the Overview area. The cursor will change into a pop-up menu symbol. Press the mouse button, and a pop-up menu will appear.
• Drag the mouse to select the display type you want.

Notice that stereo files also let you view a sum of the left and right channels at once. The Option key pop-up is the only way to select what is displayed in the overview.

NOTE: If you are performing destructive edits on long files, you may wish to view the time line instead of the actual wave data. This will make it possible for you to avoid the wait period required to recompute and redraw the Overview Display after each edit. Switching from Time Line to Waveform display may also require a wait period on long files.

To start playback from any point in the file:

• Click and hold the mouse down at any point in the Overview Display. Playback will continue until either the end of the file is reached, or you release the mouse.

View Indicator

The View Indicator is a dotted rectangular box that is always present in the Overview Display. It shows you exactly what area of the soundfile is presented in the Waveform Display, and where that waveform range is located in the overall soundfile. It is particularly useful for keeping track of your specific location in large soundfiles.

Waveform Display

The Waveform Display shows the editable waveform of the soundfile. In stereo files, both the left and right channels are displayed. In a mono soundfile, only the single channel is displayed. When you are fully zoomed, the window displays as much audio as is currently stored in your computer’s RAM memory. In other words, the Waveform Display will show you only as much audio as will fit into RAM. However, this does not mean that you can only edit the audio data currently in memory. You can view and edit other portions of the audio file by scrolling across Sound Designer II’s Waveform Display. Sound Designer II automatically scrolls to the left or right when you reach the edge of the window during the selection process.
Amplitude and Time Axes

In Sound Designer II, both the time (X) and amplitude (Y) axes are displayed at all times. By using the Scale Marks... command in the Setup menu, you can select different units for both axes. Amplitude may be viewed as percent of maximum or as sample value; Time may be viewed as seconds, hours:minutes:seconds:milliseconds, various SMPTE formats, as decimal or hex sample number, as feet and frames, or as bars and beats.

⚠️ SHORTCUT: Time and amplitude axis units can also be set using the pop-up menus which are displayed by holding down the Option key while the mouse is over either axis.

<table>
<thead>
<tr>
<th>Scale Marks Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hr:Min:Sec:Msec</td>
</tr>
<tr>
<td>Sample Numbers</td>
</tr>
<tr>
<td>Hex Sample Numbers</td>
</tr>
<tr>
<td>SMPTE Time Code</td>
</tr>
<tr>
<td>Feet+Frames</td>
</tr>
<tr>
<td>Bars:Beats</td>
</tr>
</tbody>
</table>

The pop-up time axis Scale Marks menu

NOTE: The Preferences... command in the Setup menu lets you set defaults for scale units.

Mac-to-SampleCell

If you have Digidesign’s SampleCell sample playback card installed in your Macintosh and the SampleCell Editor software running, the Mac-to-SampleCell button loads the current soundfile into SampleCell, transferring all loop information along with the audio data. If you have the SampleCell Editor software but it is not currently running, Sound Designer II will prompt you to locate and open it. Sound Designer II’s built-in SampleCell support is explained in detail in Chapter E: Looping Samples.
**The Speaker**

The Speaker button plays back the selected (highlighted) waveform range. If no selection has been made, it plays the section of the soundfile shown in the Waveform display.

In order for the Speaker icon to play directly from disk, the Direct from disk box must be checked in the Setup menu's Sound Playback dialog box. If this box is not checked, the Speaker icon will only be able to play back the contents of memory. When playing back directly from disk, you may experience a slight hesitation before playback begins while the playback buffer is filling. One way to avoid this slight hesitation is to select Pre-allocate HD buffers with the Preferences command in the Setup menu. Loop playback capabilities are disabled when Direct from disk is checked in the Sound Playback dialog.

⚠️ **SHORTCUT:** Pressing the Spacebar on the Macintosh keyboard will start and stop playback of a soundfile from the current cursor position (i.e., the place where you have clicked the mouse) in the Overview Display. This technique also works in the Playlist window and Tape Deck dialog. The Spacebar always plays direct from disk through the DSP card or through Sound Manager (see Sound Playback for more information). Additionally, pressing the Return key will place the Overview cursor at the beginning of the file and scroll the Waveform Display so that the left edge is positioned at the beginning of the file.

**The Zoomer**

The Zoomer puts Sound Designer II in Zoom mode. When you click the Zoomer button and then drag the mouse to select a waveform range in the Overview or Waveform Display, Sound Designer II zooms in to fill the Waveform Display with the selected area. You can use the Zoomer to navigate quickly to any spot in your soundfile and view it at greater resolution.

*NOTE: To zoom the current Waveform Display area to the default (medium) magnification, double-click on the Zoomer.*
The Pencil

The Pencil tool switches the Waveform Display into *Draw Mode*, where single-sample waveform adjustments can be drawn into an existing soundfile. The Pencil tool is particularly useful for correcting transient clicks and pops anywhere in a sampled waveform. Draw mode is only active when you are zoomed in at least close enough for one screen pixel to represent one sample. You will know you have zoomed in far enough when the pencil icon becomes selectable, which is when the Waveform Display is made up of discrete curves instead of blackened waves.

The Selector

The Selector switches Sound Designer II into Selection mode. Many of the editing functions you’ll perform in Sound Designer II, such as cut, copy and paste, involve selecting specific areas of the soundfile. The Selector is the tool for this process.

When Selection mode is active, the cursor changes to an I-beam when it is positioned in the Waveform Display. Clicking and dragging the cursor across any waveform range in the Waveform Display will select that range for editing. Selected ranges are displayed in inverted color: a white waveform on a black background. The I-beam’s position relative to a selected range’s start (or insertion point) is always shown in a Data Indicator box (described later in this section).

Clicking the cursor once anywhere in the Waveform Display positions a flashing *Insertion* cursor. The current position of the Insertion cursor is displayed in both the Overview and Waveform Displays. (If a range is selected, the start point will flash in the Overview Display.) Extended ranges can be selected quickly by clicking once to define the range start point, scrolling to the intended range end point, and Shift-clicking (holding down the Shift key while clicking).

Selection of a stereo range is accomplished in much the same manner — begin your selection in the left (top) channel and drag downward into the right channel as you drag across.
SHORTCUT: If a selection is made in one channel of a stereo soundfile, you can automatically select the same range in the other channel by holding down the shift key and clicking on the other channel's amplitude axis. The same holds true for deselecting a whole channel. Also, when you are making a selection you will often want to switch to the Scrubber (described later) to help you pinpoint the proper edit point. Holding down the Option key while in Selection mode will temporarily change the cursor to the Scrubber. This way you don’t have to click on the Scrubber to access that tool.

The Display Scale Arrows

The Display Scale arrows make it possible to adjust the Waveform Display’s view. Only your view of the waveform is changed, not the sample data itself. The Display Scale arrows adjust the view so that the waveform stays centered as the scale changes.

The up arrow vertically expands the Waveform Display. This adjustment is useful for viewing amplitude differences at higher resolutions.

The down arrow vertically compresses the Waveform Display. This is helpful for squeezing the height of the waveform view so you can see its entire amplitude range.

The right arrow acts as a zoom-in tool. It magnifies the waveform view horizontally, making it possible to view single wave cycles or sample values, and edit them with the Pencil tool.

The left arrow acts as a zoom-out tool. It compresses the waveform view so that you can see more of a soundfile. The left arrow will only zoom out to show the amount of a soundfile that fits into Sound Designer II’s RAM buffer.

Marker/Loop Tools
The following sections explain each of the tools found in the Marker/Loop icon of the tool bar:
The Numbered Marker Tool

The Numbered Marker icon is one of Sound Designer II's four marker tools. It allows you to place an unlimited number of markers in any soundfile so that you can easily identify sections of songs, narration, etc., by number and quickly navigate to those sections later. Each marker appears with its own discrete number, which makes it easy to keep track of the different soundfile positions. Numbered Markers also make it easy to define start and end points for a selection range.

The cursor changes to a Numbered Marker cursor when this icon is selected. A Marker is placed in the soundfile by clicking this cursor at the desired position. (Markers appear at the bottom of the Soundfile Window.) The cursor always switches back to Selection mode after a marker is placed.

SHORTCUT: Numbered markers can be “dropped on the fly” by pressing the Enter key during hard disk playback. This is a very fast and convenient way to “flag” start and end points for regions of a file as you record or playback that file, which can greatly accelerate later editing.

You can quickly jump to numbered markers by typing the numbers of a marker on the Macintosh keyboard, or via the Find Marker... command of the Display menu. Markers can be moved at any time by dragging them with the mouse when not in Markers mode. Markers can be deleted by dragging them to the Trash Can in the lower left corner of the Soundfile window.

Numbered markers are saved with the soundfile, and will always appear until they are dragged to the Sound Designer II Trash Can.

NOTE: Sound Designer mono (not Sound Designer II) format soundfiles are limited to a maximum of 10 numbered markers. Additional markers (and text markers) will not be saved with the file!

The Text Marker Tool

The Text Marker lets you place bulleted text notes anywhere within a soundfile. Text notes can be very useful for marking specific regions or naming soundfile landmarks.
The cursor changes to a Text cursor (I-beam with a baseline mark) when the Text Marker icon is selected. Click anywhere to position a Text marker and enter the description. Text markers can be repositioned by dragging in Selection mode. Double-clicking on a Text marker with the Selector brings up its text dialog for editing.

Text markers are saved with Sound Designer II and AIFF soundfiles (not original Sound Designer mono files). They can be removed by dragging them into Sound Designer II’s Trash Can.

To locate a text marker, simply select Find Marker... in the Display menu and indicate the name of the marker you wish to locate.

The Loop Start Marker Tool

Loops are used when editing soundfiles for use in digital samplers. The Loop Start Marker tool is used to mark the point in a soundfile where you would like a loop to begin.

The cursor changes to a Loop Start cursor when this tool is selected. Loop Start Markers are placed and manipulated like Numbered Markers and Text Markers. For more details on looping, please refer to Chapter E.

The Loop End Marker Tool

The Loop End Marker tool lets you mark the point in your soundfile where you would like a loop to end, then jump back to the corresponding loop start.

The cursor changes to a Loop End cursor when this tool is selected. Loop End Markers are placed and manipulated like numbered markers and text markers. For more details on looping, please refer to Chapter E.

The Tape Deck Button

The Tape Deck button opens Sound Designer II’s hard disk recording control panel. This panel provides transport controls, lets you set recording parameters and initiate hard disk recording. For specific information about using Sound Designer II’s Tape Deck module, see Chapter C.
The Playlist Button

The Playlist button opens Sound Designer II's Playlist window, which is used to create and edit non-destructive playlists for hard disk recordings. Within the Playlist you will be able to rearrange audio regions, create crossfades between them, adjust their relative volumes, and even trigger playback of them via SMPTE. For more information about Playlists, see Chapter C.

The Scrubber

The Scrubber allows you to “scrub” playback of audio to find an appropriate edit location. (“Scrubbing” gets its name from the technique of manually rocking the reels of an analog tape deck to hear an exact audio location.) Selecting the Scrubber and holding down the mouse button anywhere in the Waveform Display will bring up the Scrub Bar. Using the mouse, drag the arrow cursor to the right to scrub forward, or left to scrub backward. As you do this, the cursor moves across the soundfile and plays back the corresponding audio. Release the button when you have located the desired point in the soundfile.

The Scrub cursor (the double vertical dotted lines) remains in the Waveform Display and Overview at all times to indicate the last scrub point. This can be helpful in selecting range end points, as described in Chapter C.

NOTE: There are two types of scrubbing. In the normal “shuttle” mode, your mouse movement dictates a direction and speed for playback. A second type of scrubbing called “jog” scrubbing is available by holding down the Command key before scrubbing. With jog scrubbing, playback corresponds directly to your mouse movements.

The Data Indicator Boxes

The Data Indicator boxes display information about the current insertion point, selected range start, and mouse position. They also contain position and amplitude information when you are moving cursors and markers.
The upper left-hand box displays the distance from the insertion point or Selection start to the mouse’s current position.

The upper right-hand box gives you the absolute position of your mouse relative to the beginning of the file.

The lower left-hand box displays SMPTE time when your system is slaved to SMPTE.

The lower right-hand box gives you the waveform’s amplitude value at the current position of the mouse.

With the exception of the SMPTE time box, all values are displayed in the units (seconds, SMPTE frames, etc.) selected with the Setup menu’s Scale Marks command. The SMPTE time box changes to Feet and Frames if Feet + Frames is selected for the time scale.

The Trash Can

Sound Designer II has its own miniature Trash Can icon that you can use to throw away markers. Once you throw a marker away, it can not be recovered. For this reason you should use Sound Designer II’s Trash Can icon with care.

Configuration Options

Sound Designer II provides several options for customizing the display of various elements of the Soundfile window. Although some of these settings may seem foreign until you become more familiar with Sound Designer II, it helps to at least be aware of them while you learn the program. You can always return here to refresh you memory about an option.

Display Options

Sound Designer II gives you control over the type of information displayed on the Amplitude and Time axes, the arrangement of your windows, and the color of certain elements of the the Soundfile window.
Amplitude and Time Scales
In the Soundfile window, you can change the type of data which is displayed in the Amplitude and Time Scales (the vertical and horizontal axes, respectively). Refer to the discussions of the Amplitude and Time Scales there for instructions on changing their display format.

Window Arrangement
As you work with Sound Designer II you might often find yourself keeping several different windows open simultaneously, such as the Soundfile and/or Playlist windows of several different soundfiles. You can use the Tile Windows and Stack Windows commands (located in the Display menu) to quickly re-arrange the location of all open windows. Tile Windows resizes and arranges all open Sound Designer II windows, (excluding Mix, Merge, SR Convert, Time Comp/Expand and EQ) so that they are all visible at the same time. Stack Windows stacks all open Sound Designer II windows (excluding Mix, Merge, SR Convert, Time Comp/Expand and EQ), one on top of another, but staggers them from top to bottom so that all their Title Bars are visible and selectable simultaneously.

Set Colors...
You can use the Set Colors... command to assign different colors or gray levels to the major components of the Soundfile window. Choosing Set Colors... from the Setup menu displays the Set Colors dialog:

Click on a display element (overview, waveform, sound cursor, or scale marks) in the Set Colors dialog. This opens the standard Macintosh “Color Picker” which you can use to select a color or gray level for the selected Sound Designer II component.
About Other Configuration Options
In addition to the *Use Backup Files, Allow Edit Undo, Temp File Location*, and other options already described, Sound Designer II provides the ability to set defaults for several other parameters. You can set default Crossfade type and length, pre/post roll, Dither on/off, and more. Rather than list all of these before you have a chance to become familiar with Sound Designer II, these options will be noted where relevant. For example, since you can choose to have Sound Designer II automatically name regions (and playlists) as you create them, this feature is described in the discussion of Regions and Playlists in Chapter C: *Hard Disk Recording and Nondestructive Editing*. Watch for the exclamation mark icons in the manual — they will alert you to all instances of shortcuts and default options.

In addition, there are several global parameters which you will want to learn about after you’ve worked with Sound Designer II and are familiar with its basic operation. All of these parameters are explained in detail in Chapter G: *Reference* and in the *Appendix*, and they include the options provided by following commands:

- Smoothing
- Screen Cursor
- OMS/MIDI
- Hardware Setup
- Use Dither
- Scroll After Play
- HDPlay Buffer and RAM Buffer Size
- Ignore Bad Timecode

Summary
You should now be familiar with Sound Designer II’s basic tools and working environment. The next chapter explores hard disk recording and the non-destructive editing capabilities of your system.
Chapter C

Hard Disk Recording and Non-Destructive Editing
Introduction

This chapter is devoted to hard disk recording and playback with Sound Designer II. Here you will learn to record digital audio direct to disk and edit that audio with Sound Designer II's non-destructive editing tools. Sound Designer II has two special windows for direct to disk recording and non-destructive editing.

The Tape Deck window is your digital recording deck. You will use it to record directly to hard disk, and play back what you've recorded.

The Playlist window offers non-destructive editing tools that let you assemble and arrange portions of your digital audio for playback in any order without actually changing the original data. Regions can be crossfaded with other regions on the fly, and even locked to and triggered by SMPTE time code or MIDI Time Code (MTC) for synchronization to video or audio tape.

You can open these windows with the Tape Deck and Playlist buttons, both of which are located in the Soundfile Window.

The rest of this chapter explains how to use these two modules.

Overview of Recording and Nondestructive Editing

Unlike a tape-based recorder like a DAT deck or an audio multitrack tape deck whose only function is recording, your Digidesign system allows you to edit and manipulate sound after you have recorded it. In fact, that's when the fun begins, and where Sound Designer II really excels.
Non-destructively editing audio with Sound Designer II consists of the following steps:

- Create a new Sound Designer II document with the appropriate file format, bit resolution and mono/stereo settings;
- Open the Tape Deck window and set the Sample Rate, input level, and other recording parameters;
- Record audio to your hard disk;
- View a graphic (waveform) representation of the audio in the Soundfile window;
- Use Sound Designer II’s Selector tool to define “regions” of the audio that you wish to edit;
- Name the regions;
- Place the regions that you created into a Sound Designer II Playlist;
- Arrange the regions in the Playlist in the order that you want.

Now, let’s get started recording some audio so you can learn how to put the Playlist and non-destructive editing to work for you.

---

**Getting Ready to Record**

Sound Designer II’s Tape Deck module has been designed to function much like a stereo tape deck. Anyone who has operated a tape recorder should find the module controls familiar.

Before you can record a mono or stereo signal directly to your hard disk, you must create a new file and set up your recording parameters.

To prepare for hard disk recording:

- Choose the New... command on the File menu to create a new empty soundfile for your recording.
• In the New... dialog, enter an appropriate name for your file. The default name is “Untitled.”

• Click on the pop-up menus, and select the type of file format you wish to create. Refer to the section “About Soundfiles” in Chapter B for descriptions of each of the file types available.

Note: Sound Designer II 16 bit stereo format is the default file type and is recommended for CD-quality stereo hard disk recording with Sound Designer II.

• Select a location for the new file. The location you choose here will be where Sound Designer II will record the audio data, so make sure to select the correct hard disk (i.e., one with enough available space to store your recording).

• Click on Save... An empty Soundfile Window appears.

• Click on the Tape Deck icon.

The Tape Deck dialog appears on your screen.

The Tape Deck icon

Chapter C: Hard Disk Recording and Non-Destructive Editing
The first thing to do in the Tape Deck window is set the sample rate.

- Click on the Sample Rate pop-up menu to set the sample rate at which you wish to record.

Sound Designer II defaults to 44.1 kHz for recording—this is the standard for compact discs. 48 kHz is a sample rate found on many DAT recorders.

Higher sample rates yield better “high end” (better reproduction of high frequencies) in your recordings. Higher sample rates also use more disk space to record the same amount of audio, so you’ll need to make a judgement here based on the audio fidelity that you require.

Lower sample rates can also be set in this pop-up menu (there is one exception — if Sound Designer II’s sample rate is set to 48000 in the Hardware Setup dialog, lower sample rates cannot be selected in the Tape Deck window).

- Click on the Pre-Allocate box if you want to create a “contiguous” file. A contiguous file is one in which all of the sample data is recorded in a giant block, and is not broken up and placed at different spots on your hard disk. A contiguous file is less susceptible to disk access and general playback problems that can occur if your hard disk data becomes fragmented. Remember, however, that even a hard disk with 30 free megabytes may not have any contiguous disk areas that are larger than three or four megabytes. When Pre-Allocate is checked, Sound Designer II will allocate all the space available on the hard disk (contiguous or not) for recording. The important point is, you should select Pre-Allocate before you begin recording. When recording on erasable optical drives, the Pre-Allocate box must be checked prior to recording.

- Set the Disk Buffer size, to choose how much memory is allocated as a record buffer. Generally a setting of 8 will produce the best results, but you may need to decrease this number if you are running with limited memory, or increase it if you have a fragmented or slow disk.

NOTE: When using erasable optical drives, the Disk Buffer value should be higher — perhaps 16 or even 32 — since these devices are quite a bit slower than conventional hard disks.

The next thing to do in preparation for recording is to adjust your input level.

To set the input level:
• Select input type (analog or digital) in the *Hardware Setup* command in the Setup Menu.

• Feed a signal into the Audio Interface's or DSP card's input(s). (When feeding a signal to a Digidesign Audio Interface, Sound Designer II can only “look at” inputs #1 and #2.) The level meters in the Tape Deck dialog will display the input levels.

The Tape Deck module’s level meters provide clip indicators. These clip indicators are really “clip-hold” indicators, meaning that they remain highlighted even after clipping has ceased. This allows you to leave your Mac while recording, and detect any clipping after you return. If the clip indicators are highlighted, you know that at least some signal has been clipped. To reset the clip-hold indicators, click the mouse anywhere on the level meter display.

The clip indicators still work even when in “hold.” The border of the clip LED will be steadily lit to indicate clip hold, but the center of the LED will flash on each clipped sample.

• To hear the input signal, click on the *Monitor* box. The input signal will be fed to the outputs of the Audio Interface (or audio card), allowing you to audition the input material.

**IMPORTANT**

Warning: Avoid nasty feedback surprises when utilizing the *Monitor* option. Sound Designer II mutes its inputs during playback but unmutes them when the transport is stopped. Because of this, you will experience feedback if you route Sound Designer II’s output via your mixer back to Sound Designer II and the Record Window is open with the Monitor box enabled.

• Adjust the input level of your signal until the level meters in the Tape Deck dialog register input levels that peak around 0 dB without clipping.

Input levels must be adjusted with the output controls of your signal source. Make sure that the input levels do not clip! Unlike analog distortion, digital distortion does not merely “color” the source signal but instead scrambles it to an indistinguishable stream of modem-like noise. Unless you specifically desire the sound, avoid digital distortion.
Recording to Your Hard Disk

It is assumed that you have followed the setup instructions in the previous sections in this chapter. You should have the Tape Deck window open, with the sample rate and other parameters configured. If all these settings look correct for your project, you're ready to record!

To record to your hard disk:

- Click on the Record button to begin recording (the On-line box should not be checked).

You are now recording directly to your hard disk. The input signal will be routed out through your Audio Interface or DSP card's output jacks so you can monitor the recording. The Tape Deck dialog shows you a real-time display of the length of the file being recorded, the current time into the file, and the available recording time that disk space will allow.

NOTE: If the disk is not fast enough, your Macintosh will issue a beep warning during recording. If this happens, increase the Buffer Size setting in the Tape Deck window (from 8 to 12, for example).

To stop recording and listen to the take:

- Click on the Stop button.

- Click on the RTZ (Return To Zero) button to move to the beginning of the file, then click the Play button. (Make sure that the On Line indicator is not checked, or playback will not begin. See Chapter F for more information about putting Sound Designer II on-line with SMPTE.)

- When you are satisfied with the recording, click on the Done button. The Tape Deck dialog will disappear, and your newly recorded track(s) will appear in the Soundfile Window.

Remember that the window will require some extra time to appear if your Overview Display is set to show you wave data rather than a time line. To access the pop-up for choosing the Overview Display format, simply hold down the Option key while clicking on the Overview Display.
Playing Back Audio

Once you have recorded a soundfile, you can play it back by returning to the Tape Deck dialog and using the transport controls.

You can also use your Mac's keyboard to control playback in the Tape Deck dialog: the left arrow key on the Mac's keyboard functions as a Rewind button, the right arrow as a Fast Forward button, and the Spacebar as a Play/Stop button. Pressing Return is the same as clicking on Done.

There are also several ways to play the file from the main Soundfile Window.

To play a soundfile from the beginning:

- Press the Return key to move to the beginning of the file, then press the Spacebar.

To play a file from the position displayed at the left edge of the Soundfile Window:

- Click and hold on the Speaker icon.

  NOTE: You will not be able to use the Speaker icon to control playback unless the Setup menu's Sound Playback... command has the Digidesign Card and Direct from disk options selected.

To play the soundfile from the current cursor position:

- Press the Spacebar. Press the Spacebar again to pause playback.

To play the soundfile from any point:

- Click and hold the cursor at the desired position in the Overview Display. (This will not work if the Zoomer is selected.)

  NOTE: The Preferences... command of the Setup menu allows you to pre-allocate memory buffers for hard disk playback in case you experience a delay before playback begins. See Chapter G for more information on the Preferences command.
You are now ready to begin editing the soundfile with Sound Designer II’s digital editing tools. But before we jump into digital editing, let’s take a look at a typical waveform in order to understand what you see on screen when you return to the soundfile window.

Understanding Waveforms On Screen

When you record audio to your hard disk, Sound Designer II displays a visual representation of the sound in its Soundfile Window. Using this graphic representation of your audio, you can edit sound very precisely in destructive or non-destructive ways.

If you’ve never seen an audio waveform, this graphic display of the data may seem strange to you. The following section is designed to help you understand what you’re looking at so you can create and edit your own audio regions.

When you look at a waveform, you are basically seeing a diagram of your recorded sound. This diagram tells you many things about the sound. For example, take a look at the following illustration. It is an example of a typical waveform.

![A typical waveform](image)

As you can see, there are some very noticeable landmarks in this audio landscape. The distinctive “peaks” are places in the recording where the volume goes up momentarily. These are followed by “valleys” where the volume goes down.

Different types of sounds produce different types of waveforms. Drums, for example, generally produce the kinds of waveform you see in the illustration: sharp peaks of short duration which are clearly defined. If you think about a drum’s sound, you’ll understand why: A drum hit has a loud, sharp attack, and a rapid decay. Other sounds, such as a vocal or a keyboard “pad”, produce a very different waveform, one that has less pronounced peaks and valleys. That’s because these sounds generally have softer attacks and longer decays.
Using Sound Designer II’s Selector tool, you’ll select portions of these waveforms and create regions out of them so that you can rearrange them in the Playlist.

Getting back to our illustration, let’s look at this typical waveform selection. Each of the peaks probably represents a beat in the music. Second, since most popular music has four beats to a measure, you might also guess that four of these “peaks” equals one measure of the recorded music. To test this, you could select this waveform range:

![Waveform selection diagram]

A one bar selection

For our example, we’ll name this waveform range “One Bar.” Notice that the selected range begins immediately before a peak and ends immediately before a peak. Looking at it you can see one of the fundamental rules for defining music regions:

- When defining a region, make sure it starts and ends on exactly the same part of a beat.

Probably the most important step in constructing a music track from regions is making sure that the beat is maintained. If the beat or rhythm is not maintained, the playlist will seem to “skip” like a broken record. If you always define regions so that they contain a whole number of beats (2 beats rather than 2.3 beats, for example), you will be able to string all of those regions together and still maintain the rhythm. Here’s a tip for making sure your region contains a whole number of beats:

- Whenever possible, start a region precisely before a volume peak (downbeat) and end it precisely before a volume peak (downbeat).

Think of downbeats as rhythm markers. Most musical phrases begin with a downbeat and end just before another downbeat. By making your playlist regions begin just before a downbeat and end just before the next downbeat, you are creating the most flexible type of region. These regions basically start on a “one,” and end before another “one” (or other whole number). They fit together with no interruption in the rhythm, and they can also be used to begin and end arrangements. Here is an example of a single selected beat. We will call this region “One Beat.”
Notice that this waveform range also begins just before a volume peak and ends just before a volume peak. Its length is equal to 1/4 of our “One Bar” region, so you know that it constitutes a quarter note.

These hints should provide you with some insight into selecting waveform regions with Sound Designer II. Sound Designer II’s Playlist allows you to arrange the regions of a soundfile in any order, but it is up to you to make the final product “musical.”

Creating and Editing Playlists

Once you have recorded a soundfile, an unlimited number of rearrangements can be created for it with the Playlist. As you learned earlier, the Playlist is really a map of the soundfile that defines the way it will be played back. You can think of each Playlist as a non-destructive “remix” of the original soundfile. It allows you to create a new song structure without changing the original recorded material.

Creating a Playlist consists of the following steps:

- Defining (capturing) regions of a soundfile;
- Creating a blank Playlist;
- Arranging the order of the regions in the Playlist;
- Setting up transitions (crossfades) between the different regions.

Since a region can be played back any number of times in a Playlist, it is possible to create Playlists that are much longer than the original recording.
Lets look at an example of this in action. For this example we’ll use the file *Drums* from your Sound Designer II Misc Files disks.

**To listen to the Playlist example in the Drums file:**

- Use the *Open* command of the File menu to open the file *Drums*. This file was included on the Sound Designer II Misc Files disk, and should have been installed in the same folder as Sound Designer II. If you cannot locate the file, cancel the Open command and return to the Finder. Then copy the file Drums from the Sound Designer II Misc Files disk into your Sound Designer II folder. Do not open the file directly off the floppy disk. After copying the file to your Sound Designer II folder, start up Sound Designer II and open the file Drums.

⚠️ **SHORTCUT:** You can drag-drop to launch Sound Designer II. To do this from the Finder, drag the file Drums on top of the Sound Designer II application icon and release (the Sound Designer II icon will highlight when the document is on top of it). Sound Designer II will launch and automatically open the file Drums.

- When the file opens, press the Spacebar to playback the file from the beginning. The file is a short, one measure drum beat that is a little over 2 seconds.
- After listening to the file in the Soundfile window, click the Playlist icon in the toolbar.

![The Playlist icon](image)

The Playlist window will open containing the Demo Playlist:
The Playlist Window

- Play the Demo Playlist by clicking on the **Play** button in the upper right corner of the Playlist window, or by pressing the Spacebar.

Every element of the drum groove you hear in the Demo Playlist was captured from within the 2 second soundfile Drums. You can see (and hear) how you can create a nearly infinite number of variations of a soundfile simply by defining regions and arranging them in the Playlist window. This is the essence of Sound Designer II’s non-destructive editing, and its effectiveness is the same when used on a short drum break, a stereo soundfile of a whole song, a dialog track or a sound effects hit list.

Before a Playlist can be created for a soundfile, you need to define at least one region. By selecting a waveform range and choosing the Playlist menu’s **Capture Region** command, you will be able to define a Playlist region. The next section will show you how.
Selecting a Region

Playlist regions can be selected in a variety of ways. The Selector provides the simplest method, but there are also several alternative methods. These alternatives are described in the next section, “Selection Shortcuts.”

While capturing a region, it doesn’t matter if only one channel of a stereo file is selected — the resultant region will include both channels of audio data.

To select a short region:

• Click on the Selector icon to activate the Selector.

• Drag through one or both channels of the Waveform Display to select the desired range. The selected area will be displayed in inverted video (white on black).

A selection range can be extended using the standard Macintosh “Shift-click” technique.

To select an extended region:

• Click on the point within the Waveform Display to place the flashing cursor at one end of the desired range.

• Scroll or locate to the other end point for the range. Hold down the Shift key and click/drag until you have found the exact position in the Waveform Display to define the extended range.

To audition a selected region:

• Click and hold the Speaker button.

To define the selected region for use with a Playlist:

• Choose Capture Region... from the Playlist menu (or type Command+R).
• Enter a name for your new region.

• Click OK

Your region has been captured and will be appear in the Regions List when you open the Playlist window.

NOTE: The Preferences... command in the Setup menu provides an option for automatically naming captured regions in sequential fashion, such as “Region 1”, “Region 2”, and so forth. Regions can later be renamed with the Rename Region command in the Playlist menu.

---

Selection Shortcuts

The arrow keys on the Mac keyboard, Scrubber, and Number Markers provide various shortcuts that can significantly speed up the task of locating and defining regions.

Selecting a Region with the Arrow keys
The arrow keys on the Macintosh keyboard provide a great shortcut when selecting soundfile regions. Pressing the Down arrow during playback in the Soundfile Window sets the start point of the selection and pressing the Up arrow sets the end point of the selection.

To select a region as the soundfile plays back:

• Press the Spacebar to start playback of the active soundfile from the current cursor position.

• As the soundfile plays, press the Down arrow at the appropriate time to define the start point of the selection.

• As playback continues, press the Up arrow at the appropriate time to define the stop point of the selection.

• Press the Spacebar to stop hard disk playback.

When playback stops, you will see that you have selected a section of the soundfile. If the highlighted section is not immediately visible, press the Left arrow key and the Waveform Display will jump to the selection’s start point. Likewise, pressing the Right arrow will cause the display to jump to the selection’s end point.
• Click and hold on the Speaker button to audition the selected range.

• Use the Capture Region command in the Playlist menu (or press Command+R) to capture this region for use with the Playlist.

Selecting Regions Using the Scrubber
The Scrubber provides a way of selecting end points for a range with pinpoint accuracy.

To select a region with the Scrubber:

• Make sure that Scroll After Play is checked on the Setup menu.

• Click on the Scrubber icon to switch to Scrub mode.

• Click and hold the mouse in the Overview Display to play back the file until you reach a potential region start position, then let go of the mouse button. The Waveform Display will automatically scroll to show your current soundfile position.

• Click and hold the mouse in the Waveform Display to show the Scrub bar, then drag the mouse to the left or right to scrub across the waveform.

• When you have pinpointed a good region start, switch to Selection mode (with the Selection icon), and click the cursor once at the point you’ve just located. A flashing insertion point will appear.

• Return to Scrub mode and repeat the same procedure to pinpoint the exact region end point.

• When you have found a good region end point, switch back to Selection mode.

• Hold down the Shift key and click on the region end point you’ve located. The entire region will now be selected.

• Click and hold on the Speaker button to audition the selected range.

• Use the Capture Region command in the Playlist menu to capture this region for use with the Playlist.

Note: Holding down the Command key before you start scrubbing activates “jog” type scrubbing. Also recall that you can toggle back and forth between Selection and Scrub modes by holding down the Option key.
This procedure is an easy way to find and capture regions in a long soundfile. Once a region has been captured, it appears in the Regions list of the Playlist window until it is cleared.

Selecting a Region Using Markers
Another convenient way to locate regions for later capture in a long soundfile is to place Numbered Markers “on the fly” during playback. You can then go directly to each marker location and begin defining the beginning and/or end of regions.

To place Numbered Markers during playback:

- Start playback before the points you wish to mark.
- Press Enter on the Mac keyboard at each point you wish to mark. Playback will continue, and you will notice the Last Marker Count icon in the title bar increment as you place each marker.
- Stop playback.

To “go to” a numbered marker location:

- Press the number key on you computer keyboard (keypad numbers work too) which corresponds to the numbered marker you want to go to. The display will center on that marker.
- Fine-tune the marker’s position with the Selector if desired, then click the Selector at the marker position. You must click the Selector to define a region start point.
- Press the number key corresponding to end of the range. The display will scroll to that position.
- Fine-tune the marker’s position with the Selector if desired, then click the Selector at the marker position. The waveform range between the two marker locations will be highlighted.

You can drop markers during playback from the tape deck and the Waveform Display.
Creating and Assembling a New Playlist

Once you have captured your regions, you are ready to create a new Playlist.

To create a Playlist:

- Choose New Playlist... from the Playlist menu, or click on the Playlist icon. A dialog box will appear prompting you to name the new Playlist.

**NOTE:** The Preferences... command in the Setup menu allows Playlists to be automatically named “Playlist 1”, “Playlist 2”, etc., with sequential numbers. If you want, Playlists can later be renamed with the Rename Playlist... command in the Playlist menu.

- Type in a name and click on the OK button. The Playlist window appears on your screen. Any currently defined regions are displayed under Regions.

The Playlist window

**Note:** Time is always displayed in the Playlist Window as Hours:Minute:Seconds and Frames.
• Click on the name of the region that you wish to place first in the Playlist then
drag it down to the Playlist area.

The name of the region will appear in the Playlist area. Notice that the start
time, length, stop time, and volume are entered automatically. (You may
change the defaults for crossfade type and crossfade duration in the Preferences
command.)

• Drag the next region from the Regions area down to below the first region in
the Playlist area. The new region will be placed after the first region. You can
place any region before or after any other region by dragging it to a different
position.

• If you make a mistake and want to remove a region from the playlist, click on
it in the Playlist area (not the Regions area) to select it. Then press the Delete
key, or choose Clear from the Edit menu. The region(s) will be removed from
the Playlist but will remain in the Regions list.

• Continue dragging regions from the Regions area and placing them at the
appropriate relative positions in the Playlist area. Notice that all start and stop
information is automatically updated.

You have now created a working Playlist. Playlists are saved with the soundfiles from
which they were created. Options for saving your work are covered at the end of this
chapter.

Auditioning Playlists

Now that you have created a playlist, you’ll want to audition it to decide whether or
not to make further changes.

To audition a Playlist:

• Select the first region in the Playlist (or press Return) and click on the Play
button (or press the Spacebar) to play back the Playlist. Press the spacebar or
click the stop button to stop playback.

To audition a single Playlist region or start playback from a specific region:

• Select the region in the Playlist area.
• Click on the Play button (or pressing the Spacebar). Click on the Stop button (or press the Spacebar again) to terminate playback.

Setting Playlist Crossfades and Transitions

Often, in the process of creating a Playlist, you will be able to organize a remix so that it works rhythmically, but the transitions between regions may seem abrupt or unnatural. To remedy these problems, Sound Designer II’s Playlist module lets you set different crossfades to be executed automatically when playback moves from one Playlist region to another.

Each region in the Playlist area has a user-selectable XFade (crossfade) as one of its parameters. The symbols in the XFade column are icons that show you what type of crossfade will be executed between the end of that region and the beginning of the next region. The transition time of these crossfades can be set with the XFade Duration box to the right of the XFade indicator. These crossfades are done in real time, and no sample data is changed.

NOTE: The Preferences... command in the Setup menu provides a way to set a default crossfade time. See the Preferences... command in Chapter G for details.

There are seven different transition/crossfade types you can choose from. Here are brief explanations of each:

- **Butt splice.** Butt splice is the default transition type. It indicates that playback will jump from this region to the next with no crossfade. This will generally cause abrupt transitions, but will be acceptable most of the time.

- **Linear crossfade.** The linear crossfade transition fades out the first region with a linear fade curve, as it fades in the next region with a linear fade curve. Linear crossfade curves generally produce good results, so try them as your first crossfade choice.
Equal power crossfade. The equal power crossfade transition type fades out this region with a 3dB fade curve, as it fades in the next region with a 3 dB fade curve. If a linear crossfade produces a drop in overall volume across the transition, try an equal power crossfade.

Slow in, fast out crossfade. The slow in, fast out crossfade transition type quickly fades out the first region as it slowly fades in the next region.

Fast in, slow out crossfade. The fast in, slow out crossfade transition type slowly fades out the first region as it quickly fades in the next region.

Overlap transition. The overlap transition type performs no crossfading. Based on the crossfade duration setting, it simply overlaps data after the end of the first region into the next region, while overlapping data before the beginning of the next region into the first region. If an overlap transition causes signal overload, try the overlap with limit, explained below.

Overlap transition with limit. Like the overlap transition the overlap transition with limit performs no crossfading. Based on the crossfade duration setting, it overlaps data after the end of the first region into the next region, while overlapping data before the beginning of the next region into the first region. However, in doing so, it automatically limits the amplitude of the resulting overlap area, making sure that no clipping (and therefore no distortion) results.

Pre/Post Crossfades and Crossfade Length
All of the transition types may be set as normal transitions, pre-crossfades, or post-crossfades. A pre-crossfade generates the entire crossfade before the transition instead of through the transition. This type of crossfade is very useful if you want to maintain the amplitude at the very beginning of the next region, instead of fading across it (when you don’t want to fade across a percussive downbeat, for example).
A post-crossfade generates the entire crossfade after the transition instead of through the transition. This type of crossfade is very useful if you want to maintain the amplitude at the end of this region instead of fading across it (when the region ends with an important audio feature, for example).

To set and adjust the crossfade type that will be executed at the end of a region:

- Click and hold on the icon in the region’s XFade box until the crossfade pop-up menu appears. The multifunction pop-up menu showing the crossfade type and “pre” or “post” characteristics of the crossfade (the vertical lines on either side of the crossfade icon).

- Drag down the center of the pop-up menu to highlight the crossfade type. Drag to the right (pre-crossfade) or left (post-crossfade) to select the transition characteristic of that crossfade.

- Release the mouse button. Your selected crossfade appears in the region’s Xfade box.

To adjust the length of a crossfade:

- Double-click on the Duration box to set the duration of the crossfade. This dialog also tells you the maximum duration available, based on the region’s boundary. (You may see a maximum available time for the crossfade, but not have enough RAM in your computer to execute it — if so, refer to the section Utilizing more RAM for Crossfades on the next page.)

- Type in the desired crossfade duration and click on the OK button.

NOTE: XFade Duration performs no function if the transition is a butt splice transition. The default butt splice duration is zero milliseconds. It is possible to create your own default settings with the Preferences command in the Setup menu. Sound Designer II will remember these new defaults and use them each time you open the application.

IMPORTANT

All crossfades in an active Playlist are stored in RAM for playback. This means that a Playlist with many long crossfades may actually use up all remaining RAM in your CPU, and prevent playback. To avoid this, remember that short crossfades (10 ms to 100 ms) generally produce the best results.
Utilizing More RAM for Crossfades

To gain the maximum amount of RAM possible for long playlists and crossfades, you can try the following:

- Install more RAM in your Macintosh.
- Allocate more RAM to the Sound Designer II application. To do this, first quit out of Sound Designer II and then select the application in the Finder. Choose Get Info... in the File Menu to open the Get Info dialog for Sound Designer II. At the bottom of the Get Info dialog are the fields Minimum Size and Preferred Size. Increase the amount shown in the Preferred Size field to the maximum your system allows (if you do not know how to determine this, refer to your Macintosh User's guides).
- Reduce the RAM Buffer size in the Setup Menu size to its minimum (4).

Adjusting the Volume of Playlist Regions

In addition to being able to specify a crossfade between two regions in a Playlist, it is also possible to individually adjust the volume of each region in the Playlist. Volume is adjustable between 0 and -96 dB in 0.0 db increments (volume adjustments are gain reductions only). This feature is useful in minimizing the effects of transitions between regions of widely different volumes. A setting of 0.0 is normal volume (i.e., no reduction).

To adjust the volume of a Playlist region:

- Click and hold the mouse over the Gain dB box. A slider will appear along with numeric readout ranging from 0 to -96. Hold down the Option key while clicking on the Gain dB box to fine-tune the gain to a tenth of a decibel (i.e., the slider readout will display 0.0 to -6.0, or the appropriate 6 dB range
- Move the slider to the desired volume setting and release the mouse button.

Previewing Transitions Between Regions

You probably don’t want to listen to your entire Playlist each time you change it. Therefore, Sound Designer II provides you with a handy command for previewing just the currently selected region in the playlist and a portion of the regions before and after it.
The pre/post-roll settings in the Preferences dialog (in the Setup menu) determine how much of the neighboring regions you will hear.

**To preview the transitions between the currently selected region and the regions before and after it in the Playlist:**

- Choose **Preview Edit...** from the Playlist menu. As the audio plays back you will be able to hear the transitions.

**To increase or decrease the amount of Pre/Post roll for the Preview Edit function:**

- Choose **Preferences** from the Setup menu. This dialog appears:

![Preferences dialog]

*The Preferences dialog*

- Enter the amount of pre and post roll that you wish to hear.
- Click **OK**.

These settings will remain active until you change them again. For explanations of the other elements of the Preferences dialog, refer to Chapter G; *Reference.*
Further Editing of Playlists

Once a Playlist has been created and saved, it can always be reopened and edited. Remember, each soundfile can have multiple playlists.

To edit an existing Playlist:

- Open the soundfile that contains the Playlist.
- Click on the Playlist icon to open the Playlist window.
- If the desired Playlist is not already open, choose the Open Playlist... command in the Playlist menu. An open dialog will appear with a list of existing Playlists.
- Select the Playlist you wish to edit, then click on the Open button. The selected Playlist will appear in the Playlist window’s Playlist area.
- Move any Playlist region by dragging it to a new position. All start and stop information is automatically adjusted.

NOTE: Frame-locked regions for SMPTE synchronization will not slide in position to compensate for a moved region. If there is no room for a region between frame-locked regions, it will not be moved. See the chapter Working with SMPTE, for more information on synchronization.

To view or change the waveform range that makes up a region:

- Double-click on the region’s name in the Regions list. The Soundfile window will be brought to the front with the region selected. You can then examine it, or change it, and then recapture it under a new name.

To delete an entry from the Playlist:

- Click the entry to select it and press the Delete key on the Mac’s keyboard, or select Clear from the Edit Menu.
To copy a region or group of regions from one Playlist to another:

- Select the region(s) in the source Playlist and select *Copy* from the Edit menu (use the Shift key to select more than one region).

- Use the *Open Playlist...* or *New Playlist...* command in the Playlist menu to switch to the destination Playlist.

- Select the region that you would like the copied entries to be placed above in the destination Playlist.

- Select the *Paste* command from the Edit menu.

To rename any region within a Playlist:

- Select that region and choose *Rename Region* from the Playlist menu.

To rename any Playlist:

- Choose *Rename Playlist* from the Playlist menu.

To delete a region from all Playlists:

- Select the region in the Regions display.

- Choose the Clear command in the Edit menu or press the Delete Key on the Mac's keyboard.

---

**Fine Tuning Regions with the Edit Regions Dialog**

The Edit Regions dialog allows you to make fine adjustments to the start and end points of any defined region, adjust the volume of regions in 0.1db increments, and adjust pre- and post-roll for previewing your edits. You can save the change to the original region, or as a new region. Its loop play mode is particularly useful for fine tuning the rhythmic transitions between regions of a Playlist.

To set up the Edit Regions dialog:
• With the Playlist window open, select a region in the Playlist area and double-click on its name, or choose Edit Regions from the Playlist menu. The Edit Regions dialog will appear.

![Edit Regions dialog]

The Edit Regions dialog

SHORTCUT: If you double-click on the left half of the name, the dialog will appear with the start of that region selected for editing. If you double-click the right half of the name, it appears with the end of that region selected for editing.

The name of the selected region, its length, and those of the regions before and after it appear here with “Nudge” buttons to adjust the start and end points in small or large increments. Crossfades and their durations can be set, as can volume for each region.

Clicking the Speaker icon will play back the region located directly below it: the left icon plays across the first splice point, the middle icon plays the selected region, and the right speaker icon plays across the second splice point. Pre- and post-roll times can be set to extend playback to include areas before and after the playback areas. (Pre- and post-roll values both set to zero will effectively disable the right and left Speaker icons.)

NOTE: Default pre- and post-roll times can be set using the Preferences command in the Setup menu.
The *Play Mode* controls the playback of the regions being edited. **One Shot** tells Sound Designer II to only play the selected region (with pre/post roll) once each time the Speaker icon is clicked/held or the spacebar is hit. When **Loop** is selected, the selected region will repeat continuously until the Speaker or the Spacebar is clicked again.

The horizontal black bar directly below the speaker icons functions in the same way as the Overview Display — holding the mouse down at any point in this display will start playback from that point in the three displayed regions.

**To adjust the start or end points of a region:**

- Audition the selected region by clicking on the appropriate speaker icon. Adjust pre and post roll times as necessary.
- Click on the small vertical rectangles corresponding to the beginning and/or end of the region you wish to edit.
- Click on one of the Nudge buttons to move the selected start and/or end points by the amount displayed in the associated boxes. Two sets of buttons are provided for making large or small incremental changes. To change the Nudge increments, type a value into the boxes below the Nudge buttons and/or select a value in milliseconds, frames, or samples using the associated pop-ups.
- Click on the appropriate Speaker button to audition the change.
- Use the two arrow buttons located on the right side of the Region Edit dialog to scroll through and fine tune an entire Playlist.
- When you are completely satisfied with your Playlist, click OK. The Playlist will be automatically updated to include your changes.

**NOTE:** Clicking the “Trigger on Nudge” box will automatically audition your changes each time you nudge your start or end points. Clicking on the icon a second time or pressing the Spacebar will stop playback.

**NOTE:** It is possible to edit more than one region’s start/end points at the same time simply by selecting them and using the nudge buttons. Conversely, if no start/end points are selected, the nudge buttons will have no effect.
Creating a Fade In/Out in a Playlist

Another useful feature of the Playlist is its ability to create a non-destructive, real-time fade in and fade out with a user-editable envelope. The Playlist’s Fades editor makes the creation of smooth, natural fade ins/outs very simple.

To create a fade in/out for a Playlist:

- Choose Fades from the Playlist menu. The Fades dialog appears.

![The Fades dialog](image)

- Choose Fade In or Fade Out from the pop-up menu at the top of the dialog, or type “i” or “o” on the keyboard.

- With the Breakpoint tool selected, click and drag anywhere on the diagonal line to modify the fade in/out envelope, then let go of the mouse. Repeat this process until you are satisfied with your envelope.

To remove an envelope definition point:

- Click on the Eraser icon and then click on the point that you wish to remove.
To use one of Sound Designer II's preset envelopes:

- Click on the one of the Preset Envelope icons below the Eraser tool and drag it into the envelope display area.
- Type the desired length of your fade in/out into the Length box at the bottom of the screen.
- Click and hold the Speaker icon to preview your fade in/out.

To create symmetrical fade in and fade out envelopes:

- Create either the fade in or fade out envelope.
- Use the pop-up at the top of the dialog to select the opposite function.
- Click the Copy Fade In or Copy Fade Out button (depending on which you have selected in the pop-up menu).

To implement a fade in/out:

- When you are satisfied with your fade in/out, click OK. Sound Designer II will create the non-destructive fade in/out for your Playlist and implement them in real time during playback of your Playlist. The fade parameters will be stored with your Playlist when you save the file.

To disable a fade in/out:

- Set the length of the fade in/out to zero.
Summary

This chapter has covered the essentials of hard disk recording and non-destructive editing. In the next chapter you will learn how to use Sound Designer II’s destructive editing and digital signal processing tools.
Chapter D

Destructive Editing
Destructive Editing and Digital Signal Processing

Introduction

This chapter examines the various tools and techniques available for permanently modifying your soundfiles, including cutting, pasting, reversing, trimming, and normalizing audio. This type of editing is called **destructive** editing because it permanently changes the soundfile. Also covered in this chapter are Sound Designer II’s DSP (digital signal processing) functions, some of which can be applied either destructively or non-destructively to soundfiles.

As you saw in the previous chapter, non-destructive editing techniques are extremely powerful when it comes to remixes and alternate arrangements, or for working with several ideas using the same source material. In this chapter you will find, however, that destructive editing, too, can play an important role in creating your final mix, since there are certain destructive waveform editing functions that cannot be replicated in the non-destructive realm. Click and pop removal, time compression/expansion, mixing, and reversing sounds are examples of such functions.

Be aware however, that destructive editing has its disadvantages as well: not only does it alter your soundfiles forever, but it is also very RAM-intensive and can therefore require quite a bit of time to perform large edits.

Digital Cut and Paste Editing

Audio data can be destructively cut, copied, and pasted in Sound Designer II much like text can be manipulated in a word processor. If you are accustomed to using the Macintosh you will find many of these editing functions familiar. Most cut and paste-type edits can be performed faster in the Playlist. Large destructive edits require a significant amount of time for hard disk access and screen updates.
Editing Out a Passage
A selected area can be cut out of the soundfile and the remaining pieces joined together in the digital equivalent of a tape splice.

To permanently remove a portion of the soundfile:

• With the Selector, select the portion of the waveform that you want to remove.
• Choose Clear from the Edit menu (or press the Delete key).

Moving a Passage
A selected area can also be physically moved to another place in the soundfile.

To remove a portion of a soundfile and place it elsewhere:

• With the Selector, select the portion of the waveform that you wish to move.
• Select Cut from the Edit menu (or press Command + X). This places the selected audio data on the Mac’s Clipboard.
• Position the cursor at the location you wish to place the audio data and click.
• Select Paste from the Edit menu (or press Command + V). The audio data on the Clipboard will be placed at the selected location and all soundfile data to the right will be shifted to accommodate the pasted data.

Please be aware that editing data with radically different amplitudes can result in clicks or pops at the edit points. These undesirable effects will generally not occur if you turn on the Smoothing option (in the Edit menu). With this option on, Sound Designer II automatically performs very fast crossfades at the edit points to eliminate abrupt changes in amplitude. The Smoothing command can be toggled on or off. A check next to this menu item indicates that it is on.

Duplicating a Passage
A selected passage can be duplicated as many times as necessary.

To copy a portion of the soundfile and place it elsewhere:
• With the Selector, select the audio that you want to copy.
• Select Copy from the Edit menu (or press Command + C). This places the selected audio data on the Clipboard.
• Position the cursor at the location you wish to place the wave data and click.
• Select Paste from the Edit menu (or press Command + V). The Clipboard wave data will be placed at the selected location and all soundfile data to the right will be shifted to accommodate the pasted data. These last two operations can be repeated as many times as needed.

Please be aware that unlike the Playlist, pasting audio in this manner will actually lengthen the soundfile. Pasting will only be permitted if there is enough space on your hard disk to accommodate the additional data.

NOTE: If the data on the Clipboard is from a single channel and you select a destination that includes both channels, a dialog will appear allowing you to select the specific channel you wish to paste the data into.

To paste audio without altering the soundfile’s length:

• Cut or copy audio data to the Clipboard as previously described.
• Position the cursor at the location you wish to place the audio data and click.
• Select Replace from the Edit menu. The Clipboard data will replace the audio starting from the cursor location.

If you select a waveform range (instead of just placing the cursor into the file), the Replace command will only fill the range with as much data as will fit from the Clipboard.

Trimming Excess Data
Audio before and after a selected waveform range can be removed from a file with the Trim command. This command provides a handy means of quickly removing all data but the selected range.

To trim excess data from a soundfile:

• Select the area of the soundfile that you wish to keep.
• Select Trim from the Edit menu. All data but the selected area will be removed from the soundfile.

Reversing a Passage
Reversed sounds (such as cymbals or drums) is a popular effect in many recordings. Sound Designer II lets you perform this type of edit very easily.

To reverse a passage:

• Select the desired passage.

• Select Reverse from the Edit menu. The selected data is written back to the disk in reverse order.

Permanently Silencing A Passage
Sometimes you may wish to permanently mute a section of audio where unwanted noise occurs, or where you wish to maintain the timing of an audio event preceded or followed by silence. The Silence command is particularly useful in these cases.

To replace a selected range in a soundfile with silence:

• Select the passage to be silenced.

• Select Silence from the Edit menu. All amplitudes will be set to zero while preserving the length of the soundfile.

Fading a Passage In and Out
While the Playlist provides a method of fading passages or entire Playlists in and out non-destructively, you can also permanently create a fade in/out in the soundfile itself.

To fade a passage of a soundfile in or out:

• Select the passage you wish to fade.

• Select Fade In from the Edit menu for a fade in from zero amplitude to full amplitude over the duration of the selection. Select Fade Out from the Edit menu for a fade out from full amplitude to zero amplitude over the duration of the selection.
IMPORTANT

All of the previously mentioned operations will *permanently* alter your soundfile data. Use the Playlist if you wish to make non-destructive changes.

---

### Optimizing Playback Levels

Sound Designer II provides several tools for optimizing playback levels. These include the *Normalize* and *Change Gain* commands, which permanently change the playback level of audio data, and the *Find Peak* command.

Normalizing a soundfile or selection boosts its amplitude so that the loudest peak is set to maximum without clipping, whereas Change Gain allows you to boost or lower amplitudes in a file or selection by a specified amount.

Before you use Normalize or Change Gain, you might want to use the *Find Peak* command to identify the peak in your file/selection.

**To find the peak value in your file/selection:**

- Select a passage of your audio (if no selection is made, the Find Peak command will search the entire file).
- Choose *Find Peak* from the Edit menu. Sound Designer II will find the peak, set the insertion point there and scroll the Soundfile window to it.

In cases where a soundfile has been recorded with too little amplitude, or where volume is inconsistent throughout the duration of a soundfile (as in a poorly recorded narration), the *Normalize* function will allow you to boost all levels in a selected passage so that the loudest peak is set to the maximum amplitude possible without clipping, and all other levels are boosted uniformly.

**To optimize your playback levels automatically:**

- Select the passage to be optimized. (If no selection is made, the *Normalize* command will affect the entire file).
• Select Normalize from the Edit menu. The Normalize dialog appears:

![Normalize dialog box](image)

The Normalize dialog box lets you control how close to maximum level (i.e., the clipping threshold) the peak level of your selection/file will be boosted. You can enter this in either of two ways, as a decibel value below the clipping threshold or as a percentage of the threshold. Entering a value into one of the fields of this dialog box automatically calculates the equivalent value in the other field.

• Enter the amount of boost you want applied during the Normalize process. To set a specific decibel amount below maximum, enter that value in the upper (db) field. To set the amount of normalization as a percentage of maximum, enter the desired percentage in the lower (%) field.

• Click OK to permanently change the playback level of the file/selection.

Levels can also be uniformly boosted or lowered by a user-defined amount using the Change Gain controls.

**To change the playback levels in a passage manually:**

• Select the passage to be altered (or no selection to affect the entire file).

• Select Change Gain from the Edit menu. The Change Gain dialog appears.
• Click on the *Peak Value* button to see the percentage value of the highest amplitude in the selected range relative to clipping.

• Select the amount of change desired, either by entering a dB value, entering a percentage value, or sliding the *Gain* control.

• Click *OK*.

• Watch the clipping information as the amplitudes are altered. (The display shows both the number of individual samples clipped, as well as the number of continuous samples clipped over time.) If clipping occurs, select *Undo* from the Edit menu and try the *Change Gain* command again with a lower value.

**Some useful combinations**

When used together, the Normalize, Change Gain and Find Peak commands provide a powerful options for optimizing playback levels.

For example, let’s say you were working on a dialog track that had an overall level that needed to be boosted, but one particular peak that needed to be softened. Since the overall level of the track was too low, you would want to Normalize the file. However, the presence of the one peak would limit the effectiveness of the Normalize command, so that peak should be softened a bit prior to normalization. To accomplish this, you could first use the Find Peak command to identify the peak, then use the Change Gain command to lower it to a level closer to that of the rest of the dialog track (the amount you reduce this peak will depend on how much you will want to boost when you
normalize). With that accomplished, you could then use the Normalize command to uniformly boost the overall level of the entire track.

The effect of this process may seem similar to compression, but it differs significantly in that the dynamic range of the track is not reduced (i.e., the loud parts are still louder than the quiet parts) as would happen if you compressed the file. (Compression in Sound Designer II is discussed later in this chapter).

---

**Compare Files**

The Compare Files command compares two sound files of the same size, sample rate and number of channels, and then generates a third file that contains the difference of the two files.

There are several useful applications of this command. For example, it can be used for verifying data that has been archived/restored against the original source file. If you have suspicions about the restored file's integrity, you can use Compare Files to easily compare it against the original.

Comparing files will also allow you to hear the exact difference between a file that has been processed using any of Sound Designer II's DSP functions against the original file.

**To Compare Files:**

- Choose *Compare Files*... from the Edit menu. In the first dialog that appears, select the first file (when you select/highlight a file in this dialog, the Open button changes to read *Open File 1*) and click the button *Open File 1*.

- In the next dialog that appears, select the B file and click *Open File 2*.

- After you select the B file, another dialog will appear for you to name the resultant file. The default name is a combination of the A and B file names plus the suffix *.diff* (Difference). Enter a name for the file, choose a location for it, and click *Save.*
When Sound Designer II completes the comparison it will open the resultant file.

Tip: If you are verifying data integrity, use the “Zero Amplitude Indication” feature of the Change Gain command on the Difference file resulting from the Compare Files operation. If there was no difference between the A and B files, all samples in the Difference file should be zero amplitude. To check this, open the Difference file (if it is not already open) and choose Change Gain from the Edit menu. In the Change Gain dialog, click Peak Value. The “Peak Value” command will quickly check to see that all of the selected samples are at zero amplitude. If they are, the following dialog box will appear:

```
All selected samples in this soundfile are zero!
```

The Zero Amplitude Indication dialog

---

### Inverting Amplitudes

Though the Invert command has no audible effect on a soundfile, it is sometimes useful in situations were you would like to invert the amplitude or phase of a waveform.

One possible application for this is “phase cancellation”, where you could silence a portion of a soundfile by copying a mono waveform, pasting it into another channel, and inverting its phase. When the two channels play simultaneously the waveform cancels itself out and the result is silence.

**To invert the amplitude of a waveform:**

- Select the desired passage.

- Select Invert from the Edit menu. The amplitudes will be inverted (positive values become negative and vice versa). Performing the operation a second time (or selecting Undo) returns the waveform to its original state.
About Digital Signal Processing

The concept of digital signal processing (DSP) is one of the central ideas behind Sound Designer II. Sound Designer II is a sound workshop that can be used to manipulate sound in many ways. A large percentage of these “manipulations” fall into the realm of signal processing.

Traditionally, in the analog world, signal processing (EQ, compression, limiting, etc.) has been accomplished by running a signal through a series of circuits in outboard gear. The result of this is an output signal which has been changed in a specific way to produce a predictable effect.

Equalization is a good example of this. In the analog realm, a known signal is passed through an equalizer that lets you adjust circuit parameters to alter the shape, and hence the spectral content, of that signal. Unfortunately, this process generally yields an increase in overall noise in proportion to the amount of processing.

Digital signal processing is based on exactly the same concept, with one major exception—DSP functions accomplish their tasks entirely in the digital realm. Sound Designer II looks at sounds as a collection of data points (samples) indicating the instantaneous amplitudes of a sound wave over time. Instead of using a circuit to change the shape of a signal, Sound Designer II uses algorithms—mathematical descriptions of the relationship between one signal and another.

DSP has its advantages and disadvantages. Unlike most analog processing, DSP adds little or no noise to the signal, thereby maintaining the integrity of the sound. However, most digital signal processing involves very sophisticated algorithms, which require a long time to do their job, and this prevents real-time adjustment of parameters.

Now, with the advent of signal processing chips like the one on your Digidesign DSP card, some of these problems disappear. The card’s DSP chip takes over most signal processing tasks, and frees up your Mac for other tasks. For this reason, you will find that many of Sound Designer II’s DSP functions can be both adjusted and used in real-time.

You should, however, be aware that while DSP is a very useful and powerful Sound Designer II feature, it can’t work miracles. If you try to put a Sound Designer II DSP module to use beyond reasonable musical limits (such as time compressing a five
minute song down to 2 minutes, for example), you may be disappointed. If your soundfile is flawed from the start, “fixing it in the mix” may take longer and yield poorer results in the end than simply rerecording your original material.

Mixing Up to Four Soundfiles
Digital mixing and merging are the tools you’ll use to mix multiple soundfiles into a single soundfile. Using Sound Designer II’s digital mixing function, you can take up to four individual mono or stereo soundfiles and mix them together with full level, pan, and delay control to create a new mono or stereo soundfile.

A useful application of the Mix function is creating a mono mix of a stereo soundfile. Another useful application of this feature is found in broadcast situations where you have a music bed that you want to reuse under narration that changes from day to day, or week to week, etc. As long as you knew the length of time that the narration needed to be, you could record new narration in Sound Designer II and then Mix the new voice-over track with your archived musical bed. It might take some experimenting to get the levels just right, but it could save you from having to rerecord the music every time you change the content of the narration.

To mix two, three, or four soundfiles to create a new soundfile:

• Open all of the soundfiles you wish to mix.
• Choose the Mix command in the DSP menu. The Mix window will appear on your screen.

### The Mix window

[Image: A screenshot of the Mix window with channel boxes and Soundfile pop-ups labeled.]

---

Chapter D: Destructive Editing 89
• Click on either Mono or Stereo. This describes the format of the soundfile that will be created as a product of the mix.

• Click to place an X in the Scale box if you want the input soundfiles to be scaled automatically before the mix is done. Scaling makes sure that you don’t accidentally clip the output waveform by insuring that the mix creates no amplitudes that are over 100% of the allowable maximum amplitude.

• Select an input soundfile for two or more of the fader channels by clicking and holding on the Soundfile pop-ups.

• If you are using stereo input files, make sure that the channel number boxes show both left (1) and right (2) channels.

• Use the mouse to set the fader levels of each channel of the input soundfiles—either by dragging the fader or by clicking and dragging anywhere inside the fader area. The fader levels describe how much of each input sound will be present in the mixed output sound.

• If you are creating a stereo output file, set the stereo pan of each input channel by dragging the triangular stereo image markers to the right or left. These markers tell you where each channel will be placed in the output stereo image. Remember to set stereo input files to the correct full right and full left channel pan positions, if you want to maintain the stereo image.

• Enter the delay you want (if any) for each soundfile within the mix. The delay setting, specified in milliseconds, lets you set the length of the time offset before the soundfile appears in the output mix.

• When all settings are to your liking, click on the Mix button to perform the mix. After some computation, a Save dialog will appear.

• Enter a name for the file that will contain the new mix. (The new file cannot be set to replace one of the input soundfiles.)

• Choose a format, select the disk and folder where you want the new file to be created and then click on the New button.

Your mix will be completed after some number crunching. (The longer and greater the number of files, the longer the mix will take to calculate.) When the new mix soundfile appears, you can audition it to see if it came out as you intended. If not, try the mix again. All Mix window settings are retained until you quit Sound Designer II.
Merging Two Soundfiles
Sound Designer II’s digital merging functions are advanced crossfading tools that allow you to take any two mono or stereo soundfiles and create a new soundfile that crossfades from one of the original files to the other.

The merged soundfile fades between marker positions in two files as shown in the following diagram:

![Diagram of a merge]

Anatomy of a merge

The difference between mixing and merging is that mixing can only be used to create a new soundfile that is a static mix of all the input soundfiles. You can adjust the level (amount) of any soundfile that will be mixed, but you can’t change or fade any of the input waveforms over time. Merging, on the other hand, makes it possible to fade out one of the input soundfiles as the other is faded in (commonly called a crossfade). The amount of time taken to fade between one waveform and the other is completely adjustable. To merge two soundfiles, both of the soundfiles must both have the same number of channels, and the same resolution (both must be 16-bit samples, for example).

To merge two soundfiles into a new soundfile:

- Open the two soundfiles you wish to merge.
- Place a numbered marker in the soundfile that will begin the new merge file. The marker must be placed at the point where the crossfade should begin.
Reminder: You can place markers “on-the-fly” during playback by hitting the Enter key during playback.

- Place a numbered marker in the 2nd soundfile that will end the new merge file. The marker must be placed at the point where the crossfade between files should end.
- Choose the Merge command on the DSP menu. The Merge window will then appear (to cancel the Merge operation, click the Close box of the Merge window).

The Merge window

- Use the From: pop-up menu to choose the soundfile that will begin the new merge soundfile.
- Use the Marker: pop-up menu next to the “From” soundfile name to choose the name of the marker that designates the beginning of the crossfade.
- Use the To: pop-up menu to choose the soundfile that will end the new merge soundfile.
- Use the Marker: pop-up menu next to the “To” soundfile name to choose the name of the marker that designates the end of the crossfade.
- Set the Merge length to dictate how long the crossfade between the two markers will be. The merge length will default to the longest allowable setting. This will either be the distance between the merge “From:” marker and the end of the merge “From:” waveform, or the distance between the start of the “To:” file and the “To:” marker — whichever is greater.
NOTE: Be careful not to set the merge length to a value greater than the time between the “From:” marker and the “To:” marker. This will create a gap of silence in the crossfade.

- Click on the box in front of the crossfade shape you desire. Linear crossfades use linear fade curves, and generally produce better results. If you find that the center of your crossfade area seems to lose volume, try the equal power crossfade, which uses a fade curve that is pushed up by 3 dB at the crossfade center.

- When all merge settings are to your liking, click on the Merge button. After some calculation, a Save dialog will appear prompting you to select the name of a file that will contain the new merged waveform. (The new file cannot be set to replace one of the input soundfiles.)

- Choose a file name and format, then click on the New button.

When Sound Designer II completes the merge, the merged file will appear in the Soundfile Window. Longer files require more time to merge. If the merge didn’t turn out as planned, try it again. Merge window settings are retained until you quit Sound Designer II.

---

**Sample Rate Conversion**

Sound Designer II’s sample rate conversion capability makes it possible to alter the sample rate of any soundfile without changing that sound’s pitch. This is a very powerful tool that lets you transmit a sound file to a multimedia application or medium, or to another digital device such as a DAT player, CD Recorder, etc.

For example, if you had originally recorded some stereo music on a DAT player at 48 kHz but wanted to digitally transfer that file to your Digidesign system, edit it, and then master it to a CD Recorder at 44.1 kHz, you could easily accomplish this. You would simply transfer the music to Sound Designer II at the original 48 kHz, edit it, and then Sample Rate Convert the file to the desired 44.1 kHz before mastering it to the CD Recorder.

The sample rate conversion process requires that you create a new file to contain the converted sound. This ensures that the original soundfile will remain unchanged.
To convert a soundfile from one sampling rate to another:

• Open the soundfile you wish to convert.

• Choose SR Convert in the DSP menu. The Sample Rate Convert window will appear.

![Sample Rate Convert window](image)

The Sample Rate Convert window

• If necessary, use the pop-up soundfile menu to select the soundfile you wish to convert.

• Type in the sample rate of the new soundfile, or type in a ratio between the new and the original sample rate.

• When you are ready to create the new file, click on the Convert button. A save dialog will appear.

• Type in the name for the new soundfile, choose its file format, and click on the New button.

After a moment the newly created soundfile will appear in a Soundfile Window. If you want to verify its new sample rate, choose the File menu’s Get Info... command to open an info dialog containing pertinent soundfile information.

⚠️ TIP: If you work with multimedia, you may often need to change the bit resolution as well as the sample rate. To change the bit resolution of a 16-bit file to 8-bit, for example, create a new 8-bit Sound Designer II document (you set the bit resolution for new file in the New... dialog), then copy/paste the audio data from the 16-bit file to the new 8-bit file and save it.
Common DSP Functions

One of the most important aspects of working with Sound Designer II's DSP functions is the ability to apply them destructively or non-destructively. Non-destructive editing is optimal for hard disk recording where you might want the original data to remain intact. Destructive application of DSP would be necessary if the soundfile is to be transferred to a digital sampler or if more DSP functions are desired than can be accommodated simultaneously.

Many of Sound Designer II's DSP tools—such as Parametric EQ, Graphic EQ, Compressor/Limiter, Expander, and Noise Gate—share common concepts and functions such as the Bypass, Use for playback, Preview, and Process options. Let's take a moment to become familiar with these concepts before working with the remaining DSP functions.

Applying the DSP Settings Permanently
The digital EQ and Dynamics settings can be permanently applied to a file. This is a destructive process—the soundfile data will be permanently altered.

To permanently apply a DSP setting to the file or selection:

- Set the DSP function the way you want it.
- Click on the Process button. The setting will be applied to the part of the soundfile that is currently selected, or to the whole soundfile if you have not selected any part of the soundfile.

Applying DSP Settings Non-destructively
Some of Sound Designer II's DSP functions can be used non-destructively, during playback only, if you wish. By using the DSP function this way, the soundfile is not altered, making this a good processing method for hard disk recording.

To use DSP during playback only:

- Click on the Use for playback box in the window of the DSP function. It will then be applied only during playback (until you turn it off by clicking in the checkbox again).
You will always be able to tell when a DSP function is being used for playback, because a black diamond will appear in front of it in the DSP menu.

**To turn off a DSP function:**

- Choose the appropriate DSP function from the DSP menu. Its control window will open.
- Click on the *Use for playback* box to remove the X. The DSP function will be turned off.

**Comparing Processed and Unprocessed Versions of a Soundfile**

It is sometimes convenient to toggle the DSP function on and off during playback to compare the processed and unprocessed sound of a soundfile.

**To compare processed and unprocessed settings:**

- Click the *Preview* button to begin playback, then click on the *Bypass* box to place an X in it. DSP processing will be disengaged.
- Click again on the *Bypass* box to remove the X. DSP processing will be re-engaged.
- Click Preview again to stop playback.

**Making Fader Adjustments**

Many of Sound Designer's DSP functions incorporate on-screen faders. Course adjustments can be made by simply dragging the faders to the desired position. Finer adjustments in values can be made by holding down the Option key while dragging.

⚠️ **TIP:** Although you can not adjust DSP faders during processing, you can get some interesting effects by patching Sound Designer II's outputs into a sampler, DAT deck or other recording device and “riding” faders during preview. By utilizing the digital outputs of your Digidesign hardware (which always output data) you can digitally “resample” your sounds with live fader adjustment, then digitally transfer them back into Sound Designer II with no generation loss.

**IMPORTANT**

You will not be able to use more than one real-time DSP function at the same time during playback.
Parametric EQ

Sound Designer II's Parametric EQ functions much like its hardware counterparts, allowing you to alter the equalization curve of any sampled sound at a specific frequency with pinpoint accuracy. The Parametric EQ window offers five equalization filter types, each with their own particular parameters. (Only one filter type may be used at a time.) Here are brief explanations of each:

**High-pass filtering.** A high-pass filter is essentially a filter that passes high frequencies through, but removes (attenuates) low frequencies. It is used to remove unwanted low frequencies. When you are using the Parametric EQ window to build a high-pass filter, only one parameter is available: cutoff frequency. Theoretically, all frequencies above the cutoff frequency are let through, and all frequencies below it are removed. In practice, the cutoff is never perfectly sharp. The actual EQ curve is always indicated in the Parametric EQ window's filter graph.

**Low-shelf filtering.** A low-shelf filter is one that boosts or cuts the level of all frequencies below a certain frequency, but leaves those above that frequency untouched. It is generally used to adjust the overall low end of a sound. When you are using the Parametric EQ window to build a low-shelf filter, two parameters are available: corner frequency, and boost/cut amount. Theoretically, only those frequencies below the corner frequency are adjusted by the amount (in dB) you specify in the boost/cut parameter. In practice, the corner is never perfectly sharp. The actual EQ curve is always indicated in the Parametric EQ window's filter graph.

**Peak/notch filtering.** The characteristics of peak and notch filters are very similar. A peak filter is one that boosts only a specific frequency, or range of frequencies, while leaving all other frequencies untouched. A notch filter reduces the level of a specific frequency or range of frequencies. Both filters are used to adjust only a specific part of a sound's harmonic spectrum. When you are using the Parametric EQ window to build a peak or notch filter, three parameters are available: center frequency, bandwidth, and boost/cut. The center frequency always indicates the actual location of the peak or notch. The bandwidth shows the actual number of frequencies that will be adjusted (half on either side of the center frequency). Boost/cut determines if your filter will be a peak (boost) or a notch (cut) filter.
High-shelf filtering. A high-shelf filter is one that boosts or cuts the level of all frequencies above a certain frequency, but leaves those below that frequency untouched. It is generally used to adjust the overall high end of a sound. When you are using the Parametric EQ window to build a high-shelf filter, two parameters are available: corner frequency, and boost/cut.

Low-pass filtering. A low-pass filter is one that passes low frequencies through, but removes high frequencies. It is generally used to decrease the presence of unwanted high frequencies. When you are using the Parametric EQ window to build a low-pass filter, only one parameter is available: cutoff frequency.

Adjusting Parametric EQ
Parametric EQ can be applied to a selection or the entire soundfile. EQ may be applied to either channel or both channels of a stereo file.

Multiple EQ passes may be made on a single soundfile if one filter type will not suffice.

To use the Parametric EQ functions:

• Make sure that the soundfile you wish to equalize is open, then choose the Parametric EQ command. The Parametric EQ window will appear.

• Use the “Soundfile” pop-up menu to select the soundfile (or selection) to equalize.
• Click on the button corresponding to the channel(s) whose EQ parameters you wish to adjust (left, right or both). The right and left channels can each have different settings.

• Click on the icon for the type of filter you desire.

• Adjust the volume of the soundfile by dragging the Vol fader up or down. This is your actual input volume setting. If you are boosting overall power, or leaving power approximately the same, you should decrease the input volume so the output does not clip. Hold down the Option key before you drag for higher resolution on the slider.

• Adjust the parameters of the EQ filter to your liking. To do this, you can either type values into the text boxes, or drag the corresponding mini-faders.

• Watch the filter response window to see your filter performance. This window is actually performing a real time FFT (Fast Fourier Transform) analysis that shows you the true performance of your filter.

• Use Bypass and Preview to audition the EQ. Use Process to apply the EQ destructively and select Use for playback to apply it non-destructively whenever playback from hard disk occurs. These parameters are documented earlier in this chapter under “Common DSP Functions.”

**Saving the Parametric EQ Settings**

EQ settings can be saved with the Sound Designer II application, or with individual soundfiles. This does not apply the EQ settings destructively to the file, but merely saves your EQ settings so they can be quickly loaded and used again and again.

**To save the EQ setting with the soundfile:**

• Click on the Settings button. The Settings dialog will appear.
Settings in: Sound Designer II™

Underwater EQ
Telephone Line

@ Application ○ Sound File
Save settings as:
Razor Edge

The Settings dialog

• Click on the Sound File button. An open dialog will appear, allowing you to select a soundfile where the EQ will be saved.

• Type in a name for the EQ, then click on the Save As button.

Settings you might use for a variety of sessions can also be saved with the Sound Designer II application.

To save the EQ settings with the Sound Designer II application:

• Click on the Settings button. The Settings dialog will appear.

• Click on the Application button. An open dialog will appear, allowing you to choose a name for the current settings.

• Type in a name for the EQ, then click on the Save As button.

Restoring EQ Settings
Use the same basic procedure to retrieve a previously-saved EQ setting.

To retrieve a saved EQ setting:

• Open the Parametric EQ window and click on the Settings button. The Settings dialog will appear.

• Choose the source of the EQ (Application or Sound File). If you choose Sound File, another Open dialog will appear for you to locate the Sound File in which the EQ setting was saved.
• Select the EQ and click on the Open button.

NOTE: Previously-saved EQ settings can also be deleted by clicking Delete instead of Open.

IMPORTANT
You will not be able to use more than one real-time DSP function at the same time during playback.

---

**Graphic EQ**

Like Parametric EQ, Sound Designer II’s Graphic EQ emulates its hardware counterpart. Graphic EQ allows you to alter the overall equalization curve of any sampled sound. Graphic EQ can also be used destructively or non-destructively.

The Programmable Graphic EQ window offers ten bands of Graphic EQ for mono soundfiles, and five bands of Graphic EQ per channel for stereo soundfiles. The frequency and bandwidth of each band can be adjusted, and you can save Settings files of graphic EQ setups for easy recall later. Each band is set to boost or cut a specific frequency and bandwidth in the soundfile’s harmonic spectrum. Unlike the Parametric EQ, the Graphic EQ allows you to create several peaks or notches at one time. Since the frequency and bandwidth of each band can be adjusted, you can think of it as a 5-band Parametric EQ.

**To use the Graphic equalization functions:**

• Make sure that the soundfile you wish to equalize is open.

• Choose the Graphic EQ command in the DSP menu. The Programmable Graphic EQ window will appear.
The Graphic EQ window

• Use the Soundfile pop-up to select the soundfile (or selection) to equalize.

• Click on the button corresponding to the channel(s) whose EQ parameters you wish to adjust (left, right, or both). Left and right channels can have different EQ curves.

• Adjust the input volume of the soundfile you’re previewing by dragging the Vol fader up or down.

• Adjust the level of each frequency band to your liking by dragging each single band fader up or down. Alternately, you can drag across the entire fader display to create the EQ curve you want. Use Bypass and Preview to audition your changes as described earlier in this chapter under “Common DSP Functions”. Hold down the Option key before you drag the slider for higher resolution.

• Click on the Flat button if you wish to set all boost/cut values to zero.

• Double-click on the number below any fader to alter the frequency or bandwidth. A dialog similar to the following appears:

![Changing the Frequency and/or Bandwidth for a Graphic EQ band](image)
Enter the desired frequency and bandwidth and click *OK*.

- Use *Process* to apply the EQ destructively or select *Use for playback* to apply it non-destructively whenever playback from hard disk occurs. These parameters are documented earlier in this chapter under “Common DSP Functions.”

Your frequency and bandwidth settings can be saved as part of an EQ Settings file.

**Saving Graphic EQ Settings**

Graphic EQ settings can be saved so that they may be quickly loaded and used again with other soundfiles. The process for saving and restoring (i.e., loading) Graphic EQ settings is identical to the method for saving and loading Parametric EQ settings. Please refer to the sections *Saving the Parametric EQ Settings* and *Restoring EQ Settings* earlier in this chapter for explanations. The instructions are the same for both Parametric and Graphic EQ settings.

**IMPORTANT**

You will not be able to use more than one real-time DSP function at the same time during playback.

---

**Dynamics**

Sound Designer II’s Dynamics functions allow you to control the dynamic characteristics of soundfiles by manipulating the ratios of their overall loudness and softness. Sound Designer II’s Dynamics functions can be used destructively or non-destructively.

Sound Designer II provides you with three types of dynamic effects: a Compressor/Limiter, an Expander, and a Noise Gate.

**Compressor/Limiter.** In simple terms, the Compressor/Limiter reduces a soundfile’s dynamic range by decreasing the volume of loud (high level) signals. It is useful in cases where your soundfile has a very wide range of dynamics (both very loud and very soft sections) and you wish to “average” its overall volume.
Expander. The expander's function is the opposite of that of the compressor/limiter: It increases the dynamic range of a soundfile by making soft sections softer.

Noise Gate. The Noise Gate's function is to "gate" or cut off audio signals that fall below a user-selectable threshold. It is typically used to reduce residual noise in a soundfile.

Using Dynamics Effects
All of Sound Designer II's Dynamics DSP (the Compressor/Limiter, Expander, and Noise Gate) all share a common window and similar controls. Let's look at the Dynamics window to learn about the controls that are common to each effect.

To open the Dynamics window:

- Make sure that the soundfile you wish to process is open, then choose the Dynamics command from the DSP menu. The Dynamics window will appear.

Input. As its name suggests, the Input fader allows you to change the input value of your soundfile's signal. It has a minimum value of -60 dB (very little signal input) and a maximum value of 0 dB (full signal input).

Detection. The Detection fader (labelled "Detect" in the Dynamics window) allows you to choose how Sound Designer II detects whether or not the soundfile's signal goes over the level set in the threshold parameter. With peak detection, Sound Designer II looks at the value of individual samples as they
are played back; in average detection it looks at the average energy of the signal over several milliseconds. The latter method is more similar to the way that the human ear measures sound. The fader allows you to use either method, or a variable mix of both.

Threshold. The Threshold fader adjusts the dB level at which the Dynamic effect takes place. For instance, if you set the Threshold fader to -35 dB (when using Expander or Noise Gate), any signal below* -35 dB would be affected. It has a minimum value of -60 dB (almost all signals will be processed) and a maximum value of 0 dB (no signals will be processed).

*NOTE: The Compressor/Limiter will affect all signals above the threshold.

Attack. The Attack fader adjusts the amount of time it takes in milliseconds before the Dynamic effect becomes fully active. It basically has a smoothing effect on the processing. The fader has a minimum value of 0.00 ms and a maximum value of 100.00 ms. Greater values will lengthen the reaction time of the detection mechanism and hence lessen the overall dynamic effect applied.

Release. The Release fader adjusts the amount of time it takes in milliseconds before the dynamic processing dies away. Again it has the effect of smoothing the transition between processed and non-processed signals. It has a minimum value of 0.00 seconds and a maximum value of 20.00 seconds. Greater values will lengthen the amount of time it takes for the signal to return to its unprocessed state and hence smooth dramatic changes.

Ratio. The Ratio fader adjusts the overall amount of the Dynamic effect applied to a soundfile. In compression, a ratio of 13:1 would mean that each 13 dB increase in input would yield only 1 dB increase in output. Greater values decrease the overall dynamic range of a soundfile. The opposite is true of expansion—an expansion ratio of 1:6 would yield 6 dB increase in output for every 1 dB increase in input. Greater values increase the overall dynamic range of a soundfile. (Ratio is not applicable to the Noise Gate.)

Output. As its name suggests, the Output fader allows you to adjust the output of your soundfile's signal. It has a minimum value of -60 dB and a maximum value of 26 dB.

To use the Dynamics effects:

- Click on the radio button corresponding to the desired function: Compressor/Limiter, Expander, or Noise Gate.
• Use the *Soundfile* pop-up menu to select the soundfile (or selection) to process.

• Adjust the parameters of the effect by dragging the appropriate sliders. Use the Preview and Bypass options to help audition your changes as described earlier in this chapter under “Common DSP Functions.” Hold down the Option key before dragging the slider for higher resolution.

• Use *Process* to apply the effect destructively or select *Use for playback* to apply it non-destructively. (These parameters are explained earlier in this chapter in the section *Common DSP Functions.*’

**IMPORTANT**
You will not be able to use more than one real-time DSP function at the same time during playback.

---

**Time Compression and Expansion**

Sound Designer II’s time compression and expansion tools allow you to adjust the duration of any sampled sound without changing its pitch. This is a particularly important function for those working in audio post-production environments, because it allows sounds to be adjusted to specific time or SMPTE durations for synchronization. Time compression/expansion works best when the range of compression/expansion is small (less than 20%). Compression or expansion of greater than 20% (for speech) or 5% (for music) may result in poor sound quality.

**To time-compress or time-expand a soundfile:**

• Open the soundfile you wish to compress or expand.

• Select the portion of the sound file that you want to compress or expand. If no selection is made, the entire file will be compressed or expanded (when time compressing/expanding stereo files, you do not need to select both channels).

• Choose the *Time Comp/Expand* command on the DSP menu. The Time Compression/Expansion window appears.
The Time Compression/Expansion window

- If necessary, use the Soundfile pop-up menu to select the soundfile you wish to time-compress or expand.

- Type the desired duration of the processed soundfile in the Desired Length box, or enter a ratio between the new length and the current length in the Time Ratio box. These two values are interrelated: changing one will change the other.

- Use the Min. Pitch slider to select the minimum (i.e., lowest) pitch that will be "looked for" during the Time Compression/Expansion process. The Minimum Pitch slider has a range of 40 Hz to 400 Hz. By being able to control the minimum pitch, you can focus the Time Compression/Expansion process for maximum efficiency. Generally you want to set it as high as you can while still retaining the sound you want. Setting this slider unnecessarily low forces Sound Designer II to do more calculating than it may actually need to do, resulting in slower response time and lower quality results. Experiment (be sure to use "Use Backup Files") to find the best setting for the desired results.

- Use the High Quality/Accurate Timing slider to move this parameter towards which of these qualities you wish to give priority to in the time compression/expansion process. Moving the slider towards "High Quality" generally means that there will be fewer audio artifacts and better sonic quality. Moving the slider towards "Accurate Timing" puts the emphasis on keeping the tempo consistent in rhythmic soundfiles such as music.

- When you have finished entering all of the parameters, click on the Compress/Expand button to process the sound file. (A dialog will appear asking you to confirm the operation, just in case. Click Yes to proceed with the Time Compression/Expansion procedure.)
If you do not have enough memory left to Undo the compression/expansion, Sound Designer II will display a dialog indicating this and allow you to cancel the operation. You may then either increase Sound Designer II’s memory allotment or create a copy of the file before processing.

**IMPORTANT**
The smallest time ratio allowed for Time Compression/Expansion is 0.5. The largest time ratio allowed is 2.0.

*NOTE: Normalizing a selection before Time Compressing/Expanding it can sometimes help produce better sounding results.*

---

**Pitch Shift**

Sound Designer II’s Pitch Shift function allows you to adjust the pitch of any sampled sound with or without changing its duration. This is a very powerful function which essentially allows sounds to be transposed a full octave up or down in pitch without altering playback speed. Like Time Compression/Expansion, this feature yields the best results when the range of transposition is relatively small (less than 4 semitones). Pitch shifts of greater than 4 semitones (speech) or 1 semitone (music) may result in poor sound quality. If you need to pitch shift more than 4 semitones try performing successive passes of small amounts of transposition instead of one wide ranging pass.

**IMPORTANT**
The *Time Correction* checkbox of the Pitch Shift window utilizes the Time Compression/Expansion windows current settings to alter pitch without adjusting playback speed.

**To use Sound Designer II’s Pitch Shift function:**

- Open the soundfile you wish to pitch shift.
- Select the portion of the sound file that you want to transpose. If no selection is made, the entire file’s pitch will be shifted.
- Choose the *Pitch Shift* command in the DSP menu. This opens the Pitch Shift window.
• If necessary, use the Soundfile pop-up menu to select the soundfile you wish to pitch-shift. Sound Designer II will automatically display the fundamental frequency of the selected soundfile.

• Check the Time Correction box if you do not want the time duration to change. This function utilizes the Time Compression/Expansion module's current settings, so make sure that they are set appropriately for the type of audio you are processing (pitched/unpitched, etc.). Although you may select time correction in this window, it is not available in Preview mode because of the extremely complex DSP calculations required.

• Adjust the pitch by dragging either of the two faders, or by typing values in the boxes below them. The Coarse slider transposes in semitones (half steps); the Fine slider transposes in cents (hundredths of a semitone).

• If you find a pitch shift setting you wish to make permanently to the soundfile, click on the Process button.

The Pitch Shift window provides a simple tuning reference for checking pitch. Click on the speaker icon to hear the reference tone. To change this tone, enter a new value or click on the pop-up Note menu, drag the mouse along the miniature keyboard, and let go at the desired note. It is possible to tune this reference tone by clicking the master tune button and dragging the fader, or by typing values into the box. Finer adjustments can be made by holding the option key while dragging the fader.

By clicking the time correction check box you have the option of enabling or disabling time correction. If time correction is disabled, playback speed will increase proportionally as the soundfile is transposed up in pitch and decrease proportionally as it is transposed down in pitch.
FFT Analysis

FFT analysis is the process of using the Fast Fourier Transform to determine the frequency spectrum of a sampled sound. The transform is able to look at any sampled sound and figure out what sine waves make up that sound, and how the presence of those sine waves changes over time. The results of FFT analysis are commonly displayed on a 3-D (XYZ) graph with frequency, amplitude, and time along the three respective axes.

As an example, here's what the Frequency Analysis window looks like when displaying the demo file Left/Right:

![Frequency Analysis of the file Left/Right](image)

The ability to examine the frequency spectrum of a sound can aid in many sound design tasks. In particular, knowing the frequency content of a soundfile can give you important insight into its EQ requirements.

To use Sound Designer II's FFT analysis tools, you'll need to familiarize yourself with two separate commands. The Setup menu's *Frequency Plot...* command is used to set all of the characteristics of the FFT display, and the DSP menu's *Frequency Analysis* command actually generates the FFT display. Each of these commands is explained below.

**Frequency Analysis Setup**

Although the actual FFT analysis is shown in the Frequency Analysis window, the characteristics of the window are adjusted using the *Frequency Plot...* command in the Setup menu.
To set the parameters for FFT analysis:

- Select the *Frequency Plot*... command from the Setup menu. The Frequency Plot dialog opens.

![Frequency Analysis Setup](image)

The Frequency Plot dialog

The FFT setup dialog has a number of parameters that each have a number of options.

**Bands.** The *Bands* pop-up menu allows you to choose how many frequency bands will be used to display the plot. By using this pop-up in conjunction with the Frequency Range fields (discussed next) you can control the level of detail displayed in the Frequency Analysis window. When you choose a higher number of bands, you increase the density of frequency resolution, thereby generating more displayed frequencies and smoother lines (although the more bands you choose, the more time will be required for the Frequency Analysis to compute and display).

**Frequency Range.** Sound Designer II lets you select the range of frequencies that will be included in the FFT analysis. With *All* selected, the FFT analysis shows all detected frequencies from under 20 Hz to over 20 kHz. This gives you an overall snapshot of the sound, but misses much of the intricate information. (Many sounds don’t have much frequency energy above 3 kHz.) By selecting a specific range of bands to view, you can zoom in and view fewer frequencies at a higher resolution.

**Amplitude.** The amplitudes can be viewed on either linear or logarithmic scales. The *Linear* scale shows you actual linear amplitude values, which will usually appear more subtle, and average much lower peak levels. The *Log* setting uses a logarithmic amplitude scale that emphasizes the slope of amplitude peaks, and generally produces visual results closer to what the ear hears.
Direction. The frequency plot can be displayed either forward or backward with regard to perceived screen depth. The backward setting shows you time slices beginning with the starting point in the back and projecting forward in time toward the front of the display. The forward setting shows you time slices beginning with the starting point in the front and projecting forward in time toward the back of the display.

Type. There are four different types of FFT displays you can choose. Mesh emphasizes amplitudes in both time and frequency domains. Time isolates the envelopes of specific frequencies over time. Frequency isolates the frequency envelopes of each time slice. Chart shows you simple vertical amplitude lines indicating all time and frequency data points.

Time interval. The time interval determines how much of the waveform will be analyzed and displayed. Shorter time intervals show you less of a sound’s spectral evolution, but with a higher time slice density. Longer time intervals display more of the overall sound, but at a lower time slice density.

To configure the Frequency Analysis parameters in the Frequency Plot... dialog:

- Use the Bands: pop-up menu to choose the number of frequency bands you wish to generate for the Frequency Analysis (FFT) window.

- Click on the All button to view all frequencies OR click on the From button and enter the range of frequency bands you wish to display.

- Use the Amplitude: pop-up menu to choose the type of amplitude scale you wish to see in the FFT window.

- Use the Direction: pop-up menu to choose whether time will be displayed front-to-back, or back-to-front.

- Use the Type: pop-up menu to choose the type of FFT graph that will be displayed in the FFT window.

- Type in the time interval from the selected soundfile that will be displayed.

- When you have adjusted the frequency analysis settings to your liking, click on the OK button.

The settings of the Frequency Plot... dialog are used each time the DSP menu’s Frequency Analysis command is selected in the DSP menu. They can be altered at any time and the current settings are stored with the soundfile the next time it is saved.
3-D Frequency Analysis Display

The FFT window is useful whenever you need specific information about a sound’s harmonic structure. In particular, it is a flexible tool for diagnosing corrective EQ settings.

To generate a 3-D FFT analysis of the current soundfile, choose the *Frequency Analysis* command on the DSP menu. An FFT window will appear:

![FFT of Microwave Cats](image)

The FFT window shows you how the current soundfile’s frequency spectrum evolves over time. The X-axis shows the different frequencies, the Y-axis shows the changing amplitude of those frequencies, and the Z-axis is time. The specific characteristics of the display depend on the settings you have chosen using the Setup menu’s *Frequency Plot...* command.
Summary

This chapter has covered most of Sound Designer II's destructive editing and DSP functions. The next chapter explores using Sound Designer II to edit and loop files for use with Digidesign's SampleCell or SampleCell II sample playback card.
Chapter E

Looping Samples
Looping Samples

Introduction

In addition to serving as a powerful direct-to-disk recording and editing system for audio production, Sound Designer II is also an excellent sample editing program. In particular, Sound Designer II is designed to work in conjunction with Digidesign's own sample playback card, SampleCell (available separately). Together, these two products form one of the most powerful and versatile sampling, sound design, and sample playback systems available. In addition to its wide array of sound editing and DSP capabilities, Sound Designer II provides a number of tools and functions that simplify the creation of smooth loops. Looped samples can then be quickly loaded into SampleCell and played via a Macintosh sequencer application or MIDI controller. While playing the sound via your MIDI controller, you can adjust the loop points in Sound Designer II's soundfile window and hear the effect of your adjustments in real-time.

Note: You must use SampleCell Editor version 2.0.1 or later. Contact your dealer or Digidesign Customer Support if you need information on ordering or upgrading.

In the following sections, you will learn how to define and create loops and send samples to a SampleCell card (if you have one) with these tools.

Loops and SampleCell

Sound Designer II allows you to create an unlimited number of loops in a soundfile by simply dragging Loop Start and Loop End markers into the Soundfile window. However, a maximum of two of these loops can be recognized and played by SampleCell.

If your soundfile has a single loop, SampleCell will treat this loop as a release loop. That is, when you hold a note on your MIDI controller, SampleCell will play the sample up to the loop's beginning, and then continue to play the looped portion of the sample while the note is held. When the note is released, SampleCell will continue to play the loop while the sound fades according to its current envelope.
Note: From within SampleCell Editor, this single loop is named “Loop 2” in the Sample Parameters window. For more information about SampleCell and looped samples, see your SampleCell User's Guide.

If your soundfile has two loops, SampleCell will treat Loop 1 as a Sustain loop (it plays while the key is held down), and Loop 2 as a Release loop (it plays after the key is released).

Sound Designer II/SampleCell Basics

While creating, editing and saving loops is the main task when using Sound Designer II and SampleCell simultaneously, there are several basic conditions and commands that you’ll want to be aware of before you begin.

Sending Samples to SampleCell

After you have edited and looped a soundfile to your satisfaction, Sound Designer II’s Mac-to-SampleCell button provides you with a fast and simple way to load the soundfile into SampleCell for immediate use.

To send the current soundfile to SampleCell:

- Make sure both Sound Designer II and the SampleCell editor are open.
- With the desired soundfile open, click on Sound Designer II’s Mac to SampleCell button.

The Mac-to-SampleCell button

The Mac-to-SampleCell button loads the current soundfile into SampleCell, transferring all loop information along with the audio data. If you have the SampleCell Editor software installed in your computer but it is not currently running, Sound Designer II will prompt you to locate and open it.

If the soundfile came from a SampleCell Instrument which is currently open in the SampleCell Editor, the soundfile will be automatically loaded in place of the old one. If the Instrument from which the soundfile came is not open, SampleCell Editor will create a new instrument and load the soundfile into it.
For more information on how to use SampleCell, refer to your SampleCell User's Guide.

After loading a sound into SampleCell, all destructive edits and Undos tell SampleCell to re-load from disk. Additionally, clicking the Mac-to-SampleCell icon tells SampleCell to re-load the file from disk.

**Listening to Loops**

Once you have placed loops in your soundfile, you'll use the Speaker icon exclusively to listen to them. Playback via the Spacebar will not let you hear loops. In order to hear loops from within the Soundfile window, you must be sure to configure Sound Playback for *Digidesign DSP Card* without the *Direct from disk* option.

**To configure playback in order to hear loops in the Soundfile window:**

- Choose *Sound Playback* from the Setup menu to display the Sound Playback dialog.

- Select *Digidesign DSP Card*, and make sure to turn off the *Direct from disk* option as shown in the following example:

![Sound Playback Options](image)

*Sound Playback configured so that loops can be heard in the Soundfile window*

- After you have configured the Sound Playback dialog, click *OK*.

With Sound Playback configured as shown above, loops will always be heard when playing back with the Speaker icon in the Soundfile window. (The Loop Window, discussed later in this chapter, always plays loops when playback is through *Digidesign DSP Card*, regardless of the status of the *Direct from disk* option.)
IMPORTANT
Remember these important rules when you are creating and playing back loops with Sound Designer II:

- Playback via the Spacebar will not play loops. In order to hear loops you must click the Speaker icon. In the Soundfile window, loops can only be heard when the Speaker icon is clicked while the Sound Playback option Direct from Disk is not selected (i.e., off). In the Loop window, clicking the Speaker icon will always play loops regardless of the status of the Direct from Disk option.

- A loop must fit in memory. You will not be able to audition Sound Designer II loops that are more than a few seconds in length unless you have more than 8 megabytes of RAM in your computer.

- Loop points will always be the same across all channels of a stereo sound file.

- Original Sound Designer format files (not Sound Designer II) will only save loops 1 and 2 regardless of the number of loops you have created.

Creating a New Loop

To create a loop in Sound Designer II:

- Open the soundfile you want to loop.

- Make sure you have configured Sound Playback as described in the previous section Listening to loops.

- Click on the Loop Start Marker icon. The mouse cursor will change to a Loop Start cursor whenever it is positioned over the waveform that you’re editing.

- Click the Loop Start cursor at the desired loop start point within the waveform. A loop start marker with the number 1 will appear.

- Select the Loop End Marker icon. The mouse cursor will change to a Loop End cursor whenever it is positioned over the waveform that you’re editing.

---

*The Loop Start Marker*
The Loop End Marker

- Click the Loop End cursor at the desired loop end point within the waveform. A loop end marker with the number 1 will appear at the bottom of the waveform display, along the time line.

You have now created a loop. To listen to it, click the Selector tool and hold down the Speaker icon. You should hear your looped soundfile — if you don’t check to make sure you have configured Sound Playback (Setups menu) for Digidesign DSP Card and turned off the Direct from disk option. Also, if you have selected a range of audio in the Soundfile window your loop start and end markers must be within the selected range.

You’ll probably find that your loop is far from perfect. If the timbre of your loop changes radically at the loop splice point, you’ll probably want to move the Loop Markers to new loop points. The simplest way to edit a loop is to drag the loop markers to a new position in the Soundfile Window until you are satisfied with the sound of your loop. To fine-tune your loops, however, you’ll want to use the Loop Window. The next section will show you how.

Using the Loop Window

If the loop is basically good, but is marked by clicks, pops, volume bumps, or a slight timbral bump across the splice, you can probably fix it using Sound Designer’s Loop window. The Loop window is designed to fine-tune basic loops that you’ve already created using the Loop Start and Loop End Markers. The Loop window cannot be activated unless both Loop Start and Loop End markers have been placed in a soundfile.

To open the Loop window:

- Choose Loop Window from the Display menu. The Loop window appears:
The waveform on the left side of the display is the loop end, and the waveform on the right is the loop start. The vertical line dividing them is the loop splice point, where playback jumps from loop end to loop start.

If you want to create a high-quality loop, you must make sure that the slopes and general shapes of the waves on both sides match, and the transition at the splice point is smooth. Here are brief explanations of the Sound Designer II Loop window tools that can help you to build a good loop:

**Speaker button**
Click and hold the mouse pointer on the Loop window’s Speaker button to hear the loop played back.

**Display Scale Arrows**
These arrows adjust the resolution (zoom) of the Loop window’s waveform display. They function in exactly the same way as the Soundfile Window’s Display Scale Arrows: Only the view is adjusted, not the actual sample data.

**Crossfade button**
The Crossfade button is one of Sound Designer II’s most important looping tools. Clicking the Crossfade button opens the Crossfade Looping dialog box:
The Crossfade Looping dialog allows you to create a crossfade loop. Crossfade looping is a destructive sample editing technique that uses a sound’s own natural waveform evolution to “smooth over” the loop splice point.

Essentially, Sound Designer II’s crossfade looping takes a copy of the loop end waveform and crossfades 50% of it with 50% of the loop start waveform. Then it takes the original loop start waveform and crossfades 50% of it with 50% of the loop end waveform. By doing this, it ensures that the loop end and loop start waveforms match, although neither has been radically changed.

In order to ensure that all transitions play back smoothly, including those before the loop start and after the loop end, the crossfades are centered right over the loop start and end points. The features of the Crossfade Looping dialog include the following:

**Crossfade Type** There are two choices for crossfade type. A *Linear* crossfade uses flat (linear) crossfade curves, and is better for most applications. An *Equal Power* crossfade uses a nonlinear fade curve. This type of crossfade is useful if the center of your crossfade seems to drop in volume.

**Loop Type** The Crossfade Loop dialog allows you to create either Forward or Forward/Backward loops. Forward loops are “normal” loops, i.e., they play from Loop Start to Loop End, then repeat as long as necessary. Forward/Backward loops play from Loop Start to Loop End, then play in reverse from Loop End to Loop Start, then repeat. SampleCell can recognize and play both of these types of loops.

The **Length** of the crossfade determines how much waveform on either side of the loop points will be involved in the crossfade. For this reason, crossfade length must be shorter than the total length of the loop, shorter than the length of waveform between the very beginning of the soundfile and loop start, and shorter than the length of waveform between loop end and the end of the soundfile.
Important
Crossfade Looping is a destructive edit! You should switch on Use Backup Files and/or Allow Edit Undo before you destructively edit your soundfile.

To create a crossfade loop:

- Click on the Loop window’s Crossfade icon. The Crossfade Looping dialog appears.
- Click on the button in front of the desired crossfade type.
- Click on the button in front of the type of loop you’re creating.
- Type in a value in the Crossfade Length box if you want a setting other than the default maximum length. (The maximum length is indicated in the dialog.) Generally speaking, the maximum crossfade length will produce the best results.
- Click on the Continue button to execute the crossfade.

NOTE: It is generally a good idea to create the best possible loop before resorting to crossfade looping. For more information on creating good loops easily, see the description of the AUTO arrows on the following page.

Information button
Clicking the Info button opens a dialog box that tells you all of the pertinent information about the loop you’re currently working on. In the dialog box you’ll find the name of the soundfile, the current channel number, the loop number, the loop start and end positions, and the loop type. If you wish, you can use this dialog to change loop start and end positions, and loop type. When you are done editing or viewing the information, click the OK button (to make changes), or the Cancel button to abort.

Pop-up loop selection menu
The number of the loop you’re editing is always indicated across from the icons at the top of the Loop window. To edit a different loop, click and hold on the loop number box. A pop-up menu will appear and you can select another loop to edit by choosing its number and letting go of the mouse button. Remember, only loops that have both a defined start and a defined end point will appear.

Pop-up channel selection menu
The number of the channel (Left/1 or Right/2) you’re seeing in the Loop window is always indicated to the right of the loop number. To see how the same loop affects a different channel, click and hold on the channel box. A pop-up menu will appear and you can select another channel to view. Remem-
ber, loops are always the same from channel to channel, so you can’t adjust a loop point in one channel without adjusting it in the other channel.

**Left and right scroll arrows**
The left and right scroll arrows located below the loop end and loop start waveforms are used to move the actual loop points from within the Loop window. The left arrows move the loop points toward the soundfile beginning, and the right arrows move the loop points toward the soundfile end.

To bring any displayed waveform spot to the splice point, just click on that waveform spot in the Loop window’s waveform displays.

**Left and right AUTO arrows**
The left and right AUTO arrows are particularly useful loop point positioning tools. Rather than just sliding the loop points to the right or left in small increments, the AUTO arrows automatically move the loop point to the next point that preserves both the value and the slope of the splice. If you’re adjusting the loop end, the AUTO arrow matches the loop start. If you’re adjusting the loop start, the AUTO arrow matches the loop end. For this reason, you can almost be assured of the best possible loop transition if you adjust your loops with the AUTO arrows.

**Deleting Loops**
Sound Designer II allows you to remove a loop at any time if necessary.

**To delete a loop:**
- In the Soundfile Window, drag the loop start and loop end markers you wish to delete to Sound Designer II’s Trash in the lower left corner of the Soundfile window. This will delete the loop permanently.

**Find Markers/Loops**
Sound Designer II’s Find Marker command provides a fast way to locate specific text and loop markers.

**To find a loop marker:**
- Choose *Find Marker* from the Display menu. The Find Marker dialog appears:
The Find Marker dialog box lets you search for Text markers as well as Loop markers. In the example shown above, the Markers pop-up list is shown to contain four text markers. Below the Markers pop-up is the Loop pop-up.

- Click the pop-up next to Loops to display a list of the currently defined loop start and loop end markers and select the desired marker.

- After selecting a loop marker, click Find. Sound Designer II will now center the Soundfile window display on the selected loop marker.

Summary

This chapter has covered the techniques associated with looping files for use with SampleCell. The next chapter explains how to use Sound Designer II with SMPTE.
Chapter F

Working with SMPTE
Working with SMPTE

Introduction

This chapter covers the basics of using your Digidesign system with SMPTE time code. It explains the commands and functions needed to achieve proper and accurate synchronization of Sound Designer II to an external source.

About Time Code and Synchronization

SMPTE (Society of Motion Picture and Television Engineers) time code is a running “clock” in the form of a digital data stream that can be recorded on magnetic tape as an audio signal. SMPTE time code can be used to synchronize the playback and recording of your Digidesign system with another audio system, such as an analog multitrack tape machine, or a video tape recorder (VTR).

SMPTE time code is based on hours, minutes, seconds, frames and sub-frames. Depending on the SMPTE format (covered in the next section), one frame is equal to 1/24th, 1/25th, or 1/30th of a second. The frame unit is used as a unit of time measurement due to SMPTE time code’s origin in film and video applications.

Because SMPTE stores an absolute time reference on the tape in the form of time code, any location on that tape can be precisely located by devices that read time code. Once the time code has been recorded or “striped” on a tape, it provides a permanent time reference that allows Sound Designer II to link the playback of an event to an exact tape location. Thanks to SMPTE synchronization, a gunshot sound effect can be played at the precise instant that the gun’s flash appears on-screen, and so on.

There are two basic techniques used to record SMPTE time code on magnetic tape: Longitudinal Time Code (LTC) and Vertical Interval Time Code (VITC). LTC is recorded...
as an audio signal on one of the audio tracks on the audio or video tape. VITC is recorded within the video signal in the vertical “blanking area” of each video frame. VITC offers powerful features for post production professionals that work with video.

Each type of SMPTE has its own set of pro and cons:

**LTC** can be read at high tape shuttle speeds, allowing professional time code readers to communicate with synchronizers and stay “in sync” at rewind or fast forward speeds exceeding 50 times playback speed (provided the tape recorder is able to reproduce the time code at this speed). Unfortunately, LTC cannot be read at very slow shuttle speeds (such as when you are “crawling” the tape frame by frame) or in pause. Sound effects editors often shuttle the video tape frame by frame to locate the exact point at which the sound effect should occur. With LTC, the VTR must be running (usually at a minimum speed of about 1/10th normal playback speed) in order to capture a SMPTE time address.

When **VITC** is used, Sound Designer II can capture the current SMPTE time from the VTR when it’s paused or in “crawl” mode. However, most synchronizers cannot read VITC at speeds exceeding about 10 times playback speed, preventing slaved machines from maintaining synchronization during rewind and fast forward. Also, because VITC is recorded as part of each video frame, it must be recorded at the same time as the video signal—it cannot be added later as LTC can.

Because VITC cannot be recorded on audio tracks, it’s never used to synchronize audio-only recorders. As a result, LTC is more commonly used in audio-only applications. VITC’s ability to capture a time code value when moving at slow speeds or stopped makes it much more useful in audio-for-video environments.

---

**SMPTE Formats**

Five different formats of SMPTE time code exist: 30 frames per second (fps), 29.97 fps, 29.97 fps Drop frame, 25 fps (EBU) and 24 fps.

The 30 fps frame format is based on a frame rate of 30 frames per second. This is the original SMPTE format developed for monochrome (black and white) video.
NOTE: There is sometimes confusion in the audio/video world regarding SMPTE terminology referring to the “30” fps or “29.97” fps frame rates. This is largely due to the fact that in recent years, a “nonstandard” frame rate referred to as “30 drop-frame” (which is not part of the official SMPTE specification) has come into use by musicians who use low-cost MIDI Time Code Converters that cannot generate the true NTSC color video frame rate of 29.97 fps. However, this rate is not used in professional applications—particularly not in the professional video world. When working with NTSC video (the standard in North America), one generally works with one of two formats: 29.97 fps or 29.97 fps Drop-frame. An explanation of these frame rates follows.

The “Drop-Frame” format was developed for use with NTSC color video, which has an actual frame rate of 29.97 frames per second. This slight deviation from the standard 30 frames/second rate causes time code numbers to be out of sync with “wall clock” time, such that an hour of elapsed 29.97 frame rate SMPTE time code is not equal to one hour of real time due to the fact that the time code is actually running slower. To compensate for this discrepancy in frame rates, the first two frames of each minute are “dropped” (omitted) with the exception of every 10th minute. This results in 108 frames being dropped each hour, exactly the number required to avoid accumulation error (and reflect true “wall clock” in the time code clock values).

The 29.97 Non-Drop frame format is also used with color video (and all audio/video transport synchronizers that utilize video house sync). It runs at the slower 29.97 frames per second rate, but makes no compensation for the discrepancies in “wall clock” time versus SMPTE time. It’s important to note that “one hour” of 29.97 Non-Drop frame time code is actually one hour and 3.6 seconds of “real time” due to the fact that the slower frame rate does not match “wall clock.”

The 25 fps (EBU) format is the European PAL video standard, which runs at a 25 fps. This format is also called the EBU (European Broadcast Union) format because it’s used by broadcasters throughout Europe.

The 24 fps format is used exclusively for film applications. Film is most often photographed and projected at a rate of 24 frames per second, so this SMPTE format is useful when one time code frame should equal one film frame.
Why Synchronization is Necessary

Synchronization is necessary for two reasons. First, it allows connected systems to start and stop their transports together, without requiring an operator to run all the transports individually. Secondly, it keeps the systems in lock-step while their transports are running, so that no individual system gets ahead of, or behind any other system.

Without synchronization, even if the operator were able to start and stop each individual transport manually at precisely the same time, once the transports began running, they would all run at slightly different rates over time. Analog tape transports, being mechanical, have small fluctuations in tape speed called “wow and flutter.” The capstans on tape machines can slip over time as well, generating changes in tape speed.

With disk-based systems such as Sound Designer II, playback and record speeds are controlled by quartz crystal oscillators. However, no two oscillators are exactly the same, and an oscillator’s frequency can vary with time and temperature. What all this means is that when any two systems, analog or digital, are started at exactly the same time, they will begin to drift apart over time, and the audio on the different systems will eventually drift out of sync.

Synchronization is achieved in these systems by constantly checking to see the current SMPTE frame, and adjusting the playback speed to keep all devices locked. In analog systems, this is achieved by automated motor speed control. In digital systems it is achieved by adjusting the playback sample rate. The process of forcing a slave device to change its playback speed or sample clock (in the case of a digital audio system) in order to follow a master, is called resolving.

Using SMPTE

The basic idea behind a SMPTE-synchronized network of devices is that each device (analog tape machine, video tape machine, etc.) is initially “striped” with SMPTE before anything else is recorded. One of the devices is assigned to be the “master” and all other devices read and follow the SMPTE time code from the master. They follow (or
synchronize to) the master device by comparing their own SMPTE time code “stripes” to the incoming code from the master device, and continually adjust their own transport speed so that all devices are registering the exact same SMPTE time code value at the same time.

In such a system, if the master device begins to slow down, all other devices will slow down right along with it, matching the master’s speed variations so that all devices are playing back at the same speed. Even after long periods of time they will still be exactly locked to each other because the current master SMPTE time is mirrored by all slave devices.

To set up such a system, you must first stripe each medium (video tape, audio tape, etc.) with SMPTE time code. On analog tape machines, this means recording longitudinal SMPTE time code (LTC) on one of the tracks of the audio tape. On video tape machines, you can either record LTC on one of the audio tracks or the control track of the video tape, or you can record Vertical Interval SMPTE time code (VITC) in the vertical blanking interval of the video signal itself (VITC cannot be striped ahead of time, however — it must be recorded with the video signal).

If you expect to send any of your SMPTE striped material to someone else, or especially if you intend to provide it to professional broadcasting, you must be sure that the SMPTE time code that your generator is producing is very accurate. This is accomplished by resolving (or synchronizing) the actual SMPTE time code generator itself to a very accurate clock signal, such as video “house sync” or “black burst.” This is the only way to guarantee that the SMPTE time code on tape is within the tight timing tolerances that professional broadcasting requires.

If you do not resolve your generator, or if your generator is incapable of being resolved (most low-cost SMPTE generators cannot be resolved), then you should not expect a professional broadcaster to obtain accurate results from the tapes you produce. If you only use SMPTE within your own work environment, and especially if you do not use it in context with video, then an unresolved generator provides less of a problem. However, the most flexible choice is to buy the best resolvable generator (and black burst source, if needed) that you can afford, since this generator really provides the heartbeat of your entire SMPTE system.

Because your Digidesign audio system is a completely digital system, you do not need to stripe any track with SMPTE. You only need to specify the SMPTE time at which you want a region to start, and Sound Designer II can translate SMPTE times to digital sample numbers “on the fly.”
Any slave devices in the system other than your Digidesign system will require their own transport synchronizer in order to follow the master SMPTE time code. The master device itself does not need a synchronizer, since it is generating rather than reading.

Sound Designer II synchronizes to SMPTE time code by getting positional information from an LTC-to-MIDI Time code Converter such as Digidesign's SMPTE Slave Driver, Opcode's Time Code Machine, Opcode's Studio 3, or Mark of the Unicorn's MIDI Time Piece. These converters take the SMPTE signal and convert it into a MIDI-based version of SMPTE that is fed into your computer's serial (modem or printer) port.

Note that the SMPTE time code formats striped on all devices must match. Different devices must not have different frame rates.

---

**About Sync Modes**

Your next task is to choose a synchronization mode for your session. Sound Designer II provides two types of synchronization: SMPTE Trigger and Continuous SMPTE Sync. Each of these has its advantages and disadvantages.

**SMPTE Trigger**

SMPTE Trigger is Sound Designer II's default synchronization mode. In this mode, when Sound Designer II is placed "on-line", the system waits for incoming SMPTE to "trigger" or begin playback. When it receives SMPTE, it begins playback using only its own internal crystal oscillator (which is very stable) to control playback speed.

Unfortunately, if the playback speed of your master sync source is not perfectly stable, there is a potential for trouble with this method. Sound Designer II's audio will be triggered in perfect sync with the master source, but it may not remain in sync because the master source's playback speed is fluctuating relative to the crystal oscillator in the Audio Interface. If the audio regions triggered with Sound Designer II are short (30 seconds or less) there probably won't be a noticeable problem. But if they are lengthy, the master source and Sound Designer II could get farther and farther out of sync as playback progresses.
Continuous SMPTE Sync

Continuous SMPTE Sync is Sound Designer II’s other synchronization mode, and can be enabled in the Sound Playback dialog. In this mode, playback of Sound Designer II is also triggered by incoming SMPTE. However, in this case, Sound Designer II is constantly looking at incoming SMPTE frame numbers and adjusting its playback sample rate to compensate for any discrepancies in the timing of the master sync source.

However, just as with Trigger, if your master sync source is very unstable, there is a potential for poor results. In this case, the real-time sample rate conversion that Sound Designer II must perform in order to stay locked with your master source may cause the fidelity of your digital audio playback to suffer. This audio degradation can range from very subtle to very noticeable, depending on how poor your master sync source is. The best way to avoid this type of problem is to obtain a rock-solid master sync source.

NOTE: Because of the DSP processing power required to implement the Continuous SMPTE Sync feature, you will not be able to implement real time DSP functions such as Graphic EQ and Dynamics.

For stable, long-term, synchronization, two better alternatives exist, both of which use hardware synchronization peripherals from Digidesign.

The Digidesign Video Slave Driver

The Video Slave Driver is a peripheral device that allows you to control Sound Designer II’s recording and playback clock via an external video black burst or word clock signal. The Video Slave Driver accepts either of these signals and then converts it into a master clock signal which it sends to your Digidesign Audio Interface (Pro Tools™, ProMaster 20™, 882 Studio™, 882 I/O™ or Sound Tools II™). By sending the same master black burst clock signal to Sound Designer II and your video deck or synchronizer system, all elements of your system will run at exactly the same speed, thereby staying in sync, by ensuring that the rising edge of a video frame corresponds to the rising edge of a SMPTE frame.

In this case, SMPTE Time Code is only used to locate, chase, and trigger playback or recording. As explained above, playback speed of both Sound Designer II and the video tape or synchronizer are then controlled by the black burst or word clock signal. This technique will produce more reliable long-term synchronization than SMPTE Trigger alone by ensuring that your Digidesign system remains tightly locked to the sync source. If all transports are resolved to a common video sync reference, long-term synchronization can be ensured.
For applications which require high fidelity, long-term synchronization to free-running LTC, Digidesign provides another alternative in the form of the *SMPTE Slave Driver*.

**The Digidesign SMPTE Slave Driver**

The SMPTE Slave Driver is a peripheral device that provides high-fidelity direct hardware synchronization between your Digidesign system and external Longitudinal SMPTE time code (LTC) using a special purpose Apogee™ clock chip. The SMPTE Slave Driver accepts an external longitudinal SMPTE time code signal and then converts it into a master “superclock” clock signal which it sends to the Digidesign Audio Interface. The SMPTE Slave Driver monitors any variations in rate of the external time code. Then, via the superclock connection between the SMPTE Slave Driver and the Audio Interface, Sound Designer II's actual sample rate is varied directly by the SMPTE Slave Driver. This uses none of Sound Designer II’s audio processing power, thereby preventing the audio degradation common to other software-based synchronization schemes.

In addition, since a hard disk digital recording system such as your Digidesign system is a much more stable timebase reference than a tape recorder, the SMPTE Slave Driver is also designed to generate LTC, allowing Sound Designer II to function as a very stable master sync source. Thus the SMPTE Slave Driver can function as both a resolving SMPTE-to-MIDI time code converter and as a SMPTE/MTC generator. In addition, in generate mode, the SMPTE Slave Driver can output a word clock digital audio reference signal, and also allows users who work in post-production access to “pull-up” and “pull-down” sample rates for Sound Designer II sessions.

**In summary, you have four choices for synchronizing to an external source:**

1) Using SMPTE Trigger by itself, which could result in timing errors if you are working with lengthy regions and an unstable sync source.

2) Using *Continuous SMPTE Sync* (which could result in audio degradation if you have a very unstable sync source).

3) Using SMPTE Trigger with the optional Video Slave Driver to control Sound Designer II’s recording/playback speed with a black burst generator or word clock. This enables long-term synchronization when all transports within the system are resolved to this common sync source. (This option is not possible with an Audiomedia system.)

4) Using SMPTE Trigger with the optional Pro Tools SMPTE Slave Driver to resolve Pro Tools’ recording/playback speed while slaving to LTC. This enables long-term, high-fidelity synchronization by resolving to any variations in
incoming time code. (This option is not possible with an Audiomedia system.)

By adding a SMPTE Slave Driver to your Digidesign system, you actually have a fifth choice: using Sound Designer II as the master device in your synchronization setup. All other devices are then slaved to your Digidesign system. This is possible because Sound Designer II and the SMPTE Slave Driver together have the ability to generate SMPTE/MIDI Time Code. Which of these solutions you choose depends on your needs and the nature of your audio projects.

Preparation your System

Before you proceed, your Digidesign system should be properly connected with your external synchronization devices. If you haven’t made the appropriate connections, do so now by referring to the following illustrations. These show two possible setups for synchronizing your Digidesign system to video tape. The first setup utilizes Sound Designer II’s Continuous SMPTE Sync feature to achieve synchronization. The second setup utilizes Digidesign’s Video Slave Driver (available separately), and requires a Digidesign Pro Tools™, ProMaster 20™, 882 Studio™ or 882 I/O™ Audio Interface.

Setup A

---

Synchronizing with Continuous SMPTE Sync

Chapter F: SMPTE
Choosing a SMPTE Frame Rate

Your first task in preparing your Digidesign system for synchronization is choosing a SMPTE frame rate.

**SMPTE Formats**

Sound Designer II supports all current SMPTE frame rates as described in the previous section *SMPTE Formats*. Make sure that you know *without a doubt* which of these formats your project’s tape has been striped with *before* you begin your session. A little extra care up front is always preferable to hours spent redoing work later.

**To choose a SMPTE format:**

- Select *Set Current Time...* from the Setup menu. This dialog appears (if the menu item is disabled, click in the waveform display to create an insertion point instead of a selection):
Displaying Time in SMPTE Frames

The next step in preparing your Digidesign system for synchronization is setting the Time Scale to SMPTE. Though Sound Designer II will still synchronize to incoming SMPTE time code if the Time Scale is displayed in other formats (such as Hr:Min:Sec.Msec), it is probably more useful to use SMPTE frames as your reference.

Setting the Time Scale to SMPTE frames:

- From the Setup menu, choose Scale Marks... This dialog appears:

![The Scale Marks... dialog](image)
• Select SMPTE.
• Click OK.

Alternately, you can hold down the Option key and click on the Time Scale to bring up this pop-up menu:

```
Time
Hr:Min:Sec.Msec
Sample Numbers
Hex Sample Numbers
☑ SMPTE Time Code
Feet+Frames
Bars|Beats
```

Option-clicking on the Time Scale brings up this pop-up menu.

Sound Designer II will now display time in the currently selected SMPTE frame rate.

Note: The Playlist window always displays region start, end, and length in Hours:Minutes:Seconds:Frames in the currently selected frame rate, regardless of the currently selected Time Scale option.

Choosing a Synchronization Mode

Earlier in this chapter, the two types of Sync modes which Sound Designer II supports were discussed in the section About Sync Modes. Your next task is to configure Sound Designer II for the sync mode you have chosen to work in.

To choose a synchronization mode:

• Choose Sound Playback... from the Setup menu. The Sound Playback Options dialog appears:
• If you want to use *Continuous SMPTE Sync*, click its box in this dialog as shown in the example above. An “X” indicates that it is in enabled.

• Alternately, if you want to use SMPTE Trigger, turn off *Continuous SMPTE Sync* by clicking and removing the “X” from the *Continuous SMPTE Sync* box. Sound Designer II will default back to SMPTE Trigger mode.

• If you are using Digidesign’s Video Slave Driver or SMPTE Slave Driver, make sure that *Continuous SMPTE Sync* is off and refer to your Video Slave Driver or SMPTE Slave Driver User’s Guide for additional instructions.

**SMPTE Offset**

The *SMPTE Offset* command is used to compensate for short SMPTE offsets associated with some hardware connected in the SMPTE path. In a normal working environment, this command will probably never be used. However, if you feel that you are experiencing SMPTE offsets (either delayed triggering or early triggering), use this feature.

**To choose a SMPTE trigger offset for your session:**

• From the Setup menu, choose *SMPTE Offset*... This dialog appears:

```
SMPT£ trigger offset: 0 msec
```

• Type in a value in milliseconds (between -10 and 10 msec should be sufficient).

• Click OK.
Putting Sound Designer II On Line

In order to trigger playback of Sound Designer II from an external source, you must put the system on-line. In this state, Sound Designer II waits for incoming SMPTE. When Sound Designer II sees SMPTE time moving forward, it will begin audio playback or recording.

To put Sound Designer II on-line:

- From the Setup menu, choose Online (or press Command + J). A check appears in front of the command to indicate online status. At the same time, the large Current Position Indicator box at the upper right of the Soundfile window will display the current SMPTE frame location of your incoming Time Code.

Or:

- Click the Tape Deck icon to make the Record dialog appear.
- Click the Online box in this dialog. This method is most often used if you plan to trigger Sound Designer II's direct to disk recording with SMPTE (covered later in this chapter).

Sound Designer II is now online and waiting for SMPTE time code to trigger playback.

To take Sound Designer II off-line, choose online from the Setup menu again, or open the Record dialog and click to remove the “X” from the On line box.

NOTE: While Sound Designer II is online, pressing the Spacebar on the keyboard will not cause audio to playback. The system must be off line to play audio with this method. You can play back by clicking the speaker icon or holding down the mouse button in the overview.

Synchronizing Audio Playback to SMPTE Frame Locations

One of the most common and useful applications of audio synchronization is its use in audio post production to “spot” or assign music and sound cues to specific SMPTE frame locations in a film or video. Sound Designer II provides a convenient method for doing this and can spot:
1) Playback of an entire audio file, the start point being defined in the main Waveform Display with the Set Current Time ... command.

2) Playback of an entire Playlist, by setting a SMPTE start frame for the first region occurring in the Playlist.

3) Playback of specific regions within a Playlist, by assigning specific SMPTE times to each region to be triggered within the Playlist.

By simply identifying a location in your audio file and entering an appropriate SMPTE frame number in a dialog box, Sound Designer II will then trigger the audio upon receipt of SMPTE time code.

Though SMPTE frame numbers can be typed into dialog boxes, the process is much faster (and less error-prone) if you are using Vertical Interval Time Code (VITC). In this case you can immediately “capture” a frame location by pushing the Capture button in the dialog.

Be aware that although the Capture button will work with Longitudinal Time Code (LTC), frame numbers of a paused frame can only be accurately captured with VITC. This is because LTC, being on the audio track, is NOT refreshed when a tape is paused or played at very slow speeds—such as those used when “crawling” through a video to isolate “hit” points.

**NOTE: When spotting a region, the time entered in the Spot Region... dialog must not be less than or 12 hours greater than the SMPTE start time of the playlist itself.**

**To spot an entire audio file with SMPTE:**

- Identify the SMPTE frame location where you wish to trigger playback of your audio by pausing your video deck on that frame.

- In the Soundfile window, locate the exact spot in the audio file that should correspond with the video frame you are paused at.

- Click the Selector at this spot.

- From the Setup menu, choose Set Current Time. This dialog appears:
The insertion point is at:

<table>
<thead>
<tr>
<th>SMPTE</th>
<th>Feet + Frames</th>
<th>Bars/Beats</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:01.02</td>
<td>1:09</td>
<td>1</td>
</tr>
<tr>
<td>24 FPS</td>
<td>16 mm</td>
<td>35 mm</td>
</tr>
<tr>
<td>25 FPS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.97 FPS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30 FPS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- 24 FPS
- 25 FPS
- 29.97 FPS
- 29.97 FPS Drop
- 30 FPS

Capture OK

The Set Current Time dialog

- Type in the desired SMPTE frame location or Click Capture. The current frame’s SMPTE number appears in the boxes.
- Click OK.

The audio file is now spotted to the chosen SMPTE frame location. When the system is On line, SMPTE will trigger playback of the audio file.

To spot an entire Playlist to a specific SMPTE frame:

- Identify the SMPTE frame location where you wish to trigger playback of your audio by pausing your video deck on that frame.
- In the Playlist window, double click the Start Time box of the FIRST region to appear in the Playlist (or choose SMPTE Start Time... from the Playlist menu).

<table>
<thead>
<tr>
<th>Start Time</th>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:04.10</td>
<td>Slap</td>
</tr>
<tr>
<td>00:00:05.10</td>
<td>Chuckle</td>
</tr>
<tr>
<td>00:00:06.08</td>
<td>Chuckle</td>
</tr>
<tr>
<td>00:00:06.22</td>
<td>Slap</td>
</tr>
<tr>
<td>00:00:00.14</td>
<td>Car Horn</td>
</tr>
</tbody>
</table>

The Start Time Box

Sound Designer II User's Guide
The Set SMPTE Time dialog appears:

![Set SMPTE Time dialog]

*The Start Time dialog*

- Type in the desired SMPTE frame location or Click *Capture*. The current frame's SMPTE number appears in the box.
- Click *OK*.

The Playlist is now spotted to the chosen SMPTE frame location. When the system is *On line* SMPTE will trigger playback of the Playlist.

*NOTE: When the system is online, the Playlist window’s Stop button says Play, and incoming SMPTE is indicated in the upper right corner of the window. The Playlist will remain this way until SMPTE start time code triggers playback of the playlist.*

**To spot a single region to a specific SMPTE frame:**

- Identify the SMPTE frame location where you wish to trigger playback of your audio by pausing your video deck on that frame.
- In the Playlist window, double click the *Start Time* box of the region you wish to spot.
- Type in the desired SMPTE frame location or click *Capture*. The current frame's SMPTE number appears in the box.
- Click *OK*.
The region is now spotted to the chosen SMPTE frame location. When the system is *On line* SMPTE time code will trigger playback of the region.

Repeat as necessary for other regions in the Playlist.

**Unlocking Time Locked Regions**

After you have spotted a region, it automatically becomes “time locked” to the specified SMPTE frame and cannot be moved even if other regions are added to the Playlist. This is to prevent you from inadvertently moving its position in a Playlist. Regions which are time locked appear in **bold face** type in the Playlist to be easily recognized.

A locked region cannot be moved from its location in the Playlist unless you “unlock” it with the *Un-Timelock Regions* command in the Playlist menu.

<table>
<thead>
<tr>
<th>Start Time</th>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:04:00.00</td>
<td>Slap</td>
</tr>
<tr>
<td>00:04:01.03</td>
<td>Chuckle</td>
</tr>
<tr>
<td>00:04:01.07</td>
<td>Car Horn</td>
</tr>
</tbody>
</table>

*A time locked region appears in bold face type*

**To unlock a timelocked a region:**

- In the Playlist, click on the region you wish to un-timelock (or Shift-click and select multiple regions).

- From the Playlist menu, choose *Un-Timelock Regions*. The regions are now unlocked and can be moved from their current positions.

**Important**

Simply selecting a region and pressing the Delete key will NOT remove the time-lock; it will simply remove the region from the Playlist and cause the region following the deleted region to be moved into the locked region’s position.
Triggering Direct to Disk Recording with SMPTE

Another useful application of SMPTE synchronization is triggering direct to disk recording from Sound Designer II. By doing this, music and sound cues can be recorded digitally by Sound Designer II in sync with the playback of additional material on multitrack tape or video.

To trigger direct to disk recording at a specific SMPTE frame:

- Identify the SMPTE frame location where you wish to trigger Sound Designer II’s direct to disk recording.

- Click the Tape Deck icon to open Sound Designer’s Record dialog. This dialog appears:

![Record dialog]

- Make sure that the On Line box is checked.

- Enter the desired SMPTE start frame location in the Record Start box.

- Enter the desired SMPTE end frame location in the Record Stop box.

- Click OK.
When Sound Designer II receives the SMPTE Record Start frame number it will begin recording at the current cursor location! It will stop recording when it receives the SMPTE Record Stop frame number. If no number is entered in the Record Stop box, Sound Designer II will only stop recording if you stop it manually.

**Important**

WARNING: If you are using SMPTE to trigger recording in a file that already contains audio, be careful to avoid recording over existing material. If your SMPTE start frame is earlier than the end of the soundfile, it is likely that you will record over existing audio.

---

**Troubleshooting SMPTE**

If you’re having trouble getting your system to work properly with SMPTE, the following may help.

**(1) Striping SMPTE after music has been recorded**

All tape machines in your setup (both audio and video) *absolutely* must have been striped with SMPTE Time Code before any audio is recorded onto them or to the Sound Designer II system. Not doing so is like trying to write data on a hard disk without formatting it first. The system may *seem* to work, but synchronization will never properly occur. The machines and Sound Designer II will drift farther and farther apart the longer they run.

The same problem occurs when audio is recorded onto Sound Designer II without any SMPTE sync (if, for example, it was recorded before the current session). The audio cannot be accurately synchronized with an analog tape recorder or video tape deck, since the original audio on the Mac was not recorded based on the SMPTE Time Code from the analog tape deck or video tape deck.

**(2) Not knowing the actual frame rate on your tape**

You may think this unlikely, but if you get your video tapes from a production company instead of recording them yourself, you are at their mercy as to what SMPTE frame
rate is actually used on that tape. It may have been incorrectly labeled. Worse, it may be different than the frame rate of the SMPTE you have already striped on your audio tape! Be absolutely sure you know what SMPTE frame rate is used on any material you work with.

(3) **29.97 FPS Non-Drop can be difficult.**

29.97 FPS Non-Drop is achieved by sending the 30 FPS non-drop time code slightly slower. When used with color video, each video frame now matches up with each SMPTE frame without having to use a drop-frame coding. This makes any frame number mathematics much simpler, since no frame numbers are dropped.

The problem is, many hardware and software devices do not recognize this frame rate. The Apple MIDI Manager, for example, still does not explicitly recognize it. The user must tell the MIDI Manager to expect 30 FPS non-drop instead. In fact, most devices that read SMPTE work acceptably reading 29.97 non-drop if they are set to expect 30 FPS non-drop. That is why this format has achieved such popularity.

Unfortunately, any SMPTE reader that uses the time code numbers to make real-time calculations (as Sound Designer II does when it tries to trigger and sync to SMPTE) also needs to know that the frame format is 29.97 and not 30 FPS. Since Sound Designer II allows this choice of frame rate this does not really pose a problem. The problem exists because the user cannot readily distinguish 29.97 from 30 FPS. More importantly, many production companies will distribute video work prints striped with 29.97 FPS but mark them as “30 FPS NTSC”, by which they actually mean 29.97 FPS. By the time the tape gets to you, you may have no idea what’s on it. Feeding 29.97 non-drop to Sound Designer II when it’s set for 30 FPS non-drop will result in timing errors of about 1.8 frames per minute.

(4) **Appletalk, networks and screen savers cause problems**

These types of software can cause the Macintosh to ignore MIDI data (such as MIDI Time Code) coming into its serial ports. The net effect of this is that an application (such as Sound Designer II) will appear to lose SMPTE lock and sync, and drop in and out of lock repeatedly, every 5 or 10 seconds. Make sure Appletalk is inactive in the Chooser, disconnect Appletalk cables, and remove any INIT-based network software from your System folder (QuickMail, Microsoft® Mail, AppleShare™, TOPS, etc.).

(5) **Resolve all components of your system, if possible**

When striping time code, make sure that the time code generator and the record deck are resolved to the same crystal reference. For example, when striping 29.97 Drop Frame time code onto a VTR, both the SMPTE generator and the VTR should be resolved to the
same “black burst” or house sync generator. During playback, the master deck should be resolved to “black burst” or house sync. This convention provides compatibility for your tape between the record and playback passes, and when it's played back in other facilities on different equipment. This also means that when playing back a tape striped with time code, the playback deck should be resolved to the same sync rate as the record deck was resolved to at the time of the striping.

(6) Be careful when changing frame rates
If you change time code rates in the middle of a session, many SMPTE-to-MIDI Time Code converters need to be turned off and turned on again to be able to read the new frame rate correctly.

(7) Consistent use of clock sources in Sound Designer II
A soundfile should be played back using the same peripheral and sample rate it was recorded with, if at all possible. This assures the closest match between record and playback sample rates. For example, if an audio file was recorded at 44.1 kHz with the Sound Designer II Audio Interface then the Sample Rate should be set to 44.1 kHz during playback with the Audio Interface as well.

Summary

This chapter explained how to synchronize Sound Designer II’s recording and playback with SMPTE time code. The next chapter is a reference chapter which lists and briefly describes each menu command found in Sound Designer II.
Chapter G

Reference
Reference

Introduction

This chapter explains, in sequence, all of the commands found in Sound Designer II's six menus: File, Edit, DSP, Playlist, Display and Setup. Brief descriptions are given of each command and its use. If you want to know how to perform a specific task, consult the index in the back of this manual and refer to the appropriate chapter.

The File Menu

Sound Designer II’s File menu contains all of the commands you’ll use to create and maintain your soundfiles. Here are brief explanations of each command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Creates a new soundfile from scratch.</td>
</tr>
<tr>
<td>Open...</td>
<td>Opens an existing soundfile.</td>
</tr>
<tr>
<td>Open Resource...</td>
<td>Opens a resource file.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the currently open file.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the currently open file.</td>
</tr>
<tr>
<td>Save a Copy...</td>
<td>Saves a copy of the currently open file.</td>
</tr>
<tr>
<td>Revert to Saved</td>
<td>Reverts to the last saved version.</td>
</tr>
<tr>
<td>Delete...</td>
<td>Deletes the currently open file.</td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Sets the page setup for printing.</td>
</tr>
<tr>
<td>Print...</td>
<td>Prints the currently open file.</td>
</tr>
<tr>
<td>Get Info...</td>
<td>Displays information about the file.</td>
</tr>
<tr>
<td>Quit</td>
<td>Exits Sound Designer II.</td>
</tr>
</tbody>
</table>

New...

The New... command is used to create a new soundfile from scratch. A new (and therefore empty) soundfile is used to record a new hard disk recording, or as a paste destination for sample data currently on the Clipboard. Choose one of the soundfile formats, name the soundfile, and click the New button. Sound Designer II supports Sound Designer, Sound Designer II, Mono/Stereo, AIFF, PC .WAV, Compressed, System 7 Sound and snd Resource files. Refer to the section Sound Designer II Basics in Chapter B for more information.

NOTE: Compressed and Resource formats must be created using the Save a Copy command. Some options are not available with certain file formats.
Open...
The *Open*... command lets you open any compatible soundfile (or its alias) for editing and playback in Sound Designer II. When the *Open*... dialog is on your screen, check the box in front of every file format you wish to look for. Refer to Chapter B for detailed information about the different formats. Use the dialog to navigate to the folder that contains your soundfile and click on *Open*.

Open Resource...
The *Open Resource*... command is used to open Macintosh snd Resource files. Resources are embedded within documents and applications, so the *Open Resource*... dialog will show documents and applications, instead of showing only soundfiles.

Close
The *Close* command performs the same function as the Close Box in the active window's title bar. It closes the active file or window, thereby removing it from the screen. If you attempt to close any soundfile which contains changes that have not been saved, a warning dialog will appear, allowing you to save your changes. If you click *No*, your changes will not be saved.

**Important**
Files that have "No Backup" in their title bar will retain all waveform edits, regardless of whether you choose to save before closing the file or not. However, you must still save the file to retain Playlist edits, EQ settings, loop and marker changes, and other similar edits.

Save
The *Save* function operates differently depending upon the *Use Backup Files* setting in the Setup menu. With *Use Backup Files* engaged, the changes you have made since your last save are stored over the old version. Once you have saved, you cannot use the *Revert to Saved* command to return to the soundfile's original form. With *Use Backup Files* disengaged, all non-destructive edits are saved. Destructive edits have been made directly to the soundfile, so they do not need to be saved.

Save a Copy...
The *Save a Copy*... command saves a copy of the currently selected soundfile under a different name or in a different format. To save a copy of the soundfile, choose the destination disk and folder, type in the name of the new file, and select the desired format options, then click on *Save*.

**NOTE:** Not all options are available in all formats.
Revert to Saved
If *Use Backup Files* is engaged, the *Revert to Saved* command ignores the changes you have made since your last save and returns to the old version. Remember, once you have reverted to your previously saved version, the changes you have made will be lost. This command is disabled if the *Use Backup File* option is turned off, since all wave data edits are made directly to the disk file.

Delete...
The *Delete...* command is used to permanently remove a file from a disk. Click cancel to exit this dialog.

Page Setup...
The *Page Setup...* command brings up the standard Macintosh printer Page Setup dialog. The actual dialog depends on the printer that you have selected with the Macintosh system Chooser. To learn more about these settings, click this dialog box’s *Help* button, or refer to your printer manual.

Print...
The *Print...* command brings up the standard Macintosh Print dialog. As with the Page Setup dialog, the actual dialog that appears depends on the printer you have selected with the Chooser. Sound Designer II allows you to print the active soundfile window, FFT window, or Playlist window. Only the currently active window will be sent to the printer.

Get Info...
The *Get Info...* command displays information about the currently selected soundfile, including file size, data format, sample rate, and creation and modification dates. Space is provided to add general comments about the soundfile. Only the sample rate and comments field can be edited. Here is what the Get Info... dialog looks like for the demo file *Left/Right*:

![The Get Info... dialog](image)
To change the playback sample rate, type in a new rate. Remember, changing the sample rate simply changes the playback rate. If you wish to change a sound’s sample rate without changing its pitch, use the SR Convert... command on the DSP menu. Enter any comments you want saved with the soundfile into the Comments field.

**Quit**

The *Quit* command ends your Sound Designer II session, and returns you to the Finder. Although Sound Designer II will warn you before allowing you to quit without saving changes, it is still a good idea to save your work using the *Save* or *Save a Copy...* command before quitting.

---

**The Edit Menu**

Sound Designer II’s Edit menu contains all of the standard Apple Edit commands, as well as a host of specific sound-oriented processing commands. Here are explanations of each command:

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>⌘Z</td>
</tr>
<tr>
<td>Cut</td>
<td>⌘X</td>
</tr>
<tr>
<td>Copy</td>
<td>⌘C</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘V</td>
</tr>
<tr>
<td>Clear</td>
<td>⌘B</td>
</tr>
<tr>
<td>Replace</td>
<td>⌘Y</td>
</tr>
<tr>
<td>Reverse</td>
<td>⌘E</td>
</tr>
<tr>
<td>Silence</td>
<td>⌘T</td>
</tr>
<tr>
<td>Trim</td>
<td>⌘I</td>
</tr>
<tr>
<td>Invert</td>
<td>⌘L</td>
</tr>
<tr>
<td>Fade In</td>
<td>⌘J</td>
</tr>
<tr>
<td>Fade Out</td>
<td>⌘K</td>
</tr>
<tr>
<td>Normalize</td>
<td>⌘N</td>
</tr>
<tr>
<td>Find Peak</td>
<td>⌘F</td>
</tr>
<tr>
<td>Change Gain...</td>
<td>⌘P</td>
</tr>
<tr>
<td>Compare Files</td>
<td>⌘C</td>
</tr>
<tr>
<td>Smoothing</td>
<td>⌘S</td>
</tr>
<tr>
<td>Allow Edit Undo</td>
<td>⌘A</td>
</tr>
<tr>
<td>Select All</td>
<td>⌘A</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td>⌘V</td>
</tr>
</tbody>
</table>
Undo
The **Undo** command keeps track of your last action and allows you to reverse that action if you don’t like the outcome. After you undo something, you can “Redo” it by choosing the **Undo** command again, which will now read **Redo**... This is a good way to compare “before and after” tests of any process. The **Undo** command only tracks the last action, so use it with caution. You can use the Temp File Location command in the Setup menu to designate a hard disk volume to store Sound Designer II’s Clipboard and Undo files. See also Allow Edit Undo.

**NOTE:** Sound Designer II will always warn you if a process can’t be undone, (due to processing requirements, lack of disk space, etc.) before allowing you to do it.

Cut
The **Cut** command cuts the selected waveform range out of its current position and holds it on the Macintosh Clipboard. The wave data previously to the right of the excerpted selection is shifted to the left to close the gap. After a waveform selection has been cut, it remains on the Clipboard until another cut or copy is made, or until the Macintosh is shut down. (You can use the Temp File Location command of the Setup menu to designate a hard disk volume to store Sound Designer II’s Clipboard and Undo files.)

Copy
The **Copy** command places a copy of the selected range on the Macintosh Clipboard. After a waveform range has been copied, it remains on the Clipboard until another cut or copy is made, or until the Macintosh is shut down. (You can use the Temp File Location command of the Setup menu to designate a hard disk volume to store Sound Designer II’s Clipboard and Undo files.)

Paste
The **Paste** command is only active after sample data has been placed on the Clipboard by using the **Cut** or **Copy** command. The **Paste** command inserts the Clipboard contents into the current soundfile, beginning immediately after the blinking insertion point. If a range is selected, the selection is deleted prior to insertion of the Paste data. All wave data to the right of the paste point is pushed farther to the right to accommodate the newly pasted range. Pasting may increase the size of a soundfile, and will only be allowed if there is enough disk space to accommodate storage of the resulting file.

If your paste destination has two (or more) channels, and your paste source does not have the identical number of channels, a dialog prompts you to set the destination channel for each channel you are pasting.
Clear
The Clear command deletes the selected waveform range from the soundfile without placing it on the Clipboard. When a waveform range is cleared, the entire waveform area to the right of the range slides to the left so that no gap remains.

Replace
Like the Paste command, the Replace command is only active after sample data has been placed on the Clipboard by using the Cut or Copy command. It pastes the Clipboard contents over sample data in the current soundfile. If a blinking insertion point is present, the replacement begins at that point and covers all of the wave data required to place the entire Clipboard contents. If a range of audio is currently selected, the replacement begins at range start and proceeds only to range end. Replacing is destructive, in that it overwrites the waveform range covered by the new data, but it always preserves the soundfile’s overall duration.

Reverse
The Reverse command reverses the order of the samples in the range and causes it to play backward. Reversing the same range a second time will return it to its original form. This command is sometimes useful in creating special sound effects.

Silence
The Silence command sets the value of all samples in the selected waveform range to zero, muting the passage. Unlike the Cut or Clear commands, the Silence command does not close up the space it creates. Instead, it maintains the space, and therefore the overall duration of the soundfile.

Trim
The Trim command deletes all waveform data except the currently selected range.

Invert
The Invert command takes the selected waveform range and turns it upside down. This is accomplished by making all positive sample amplitude values negative, and all negative ones positive. Inverting a waveform range will not change its sound in any noticeable way, but it may simplify the creation of certain loops and mixes. Inverting the same range a second time will return it to its original form.

Fade In
The Fade In command creates a fade in at the beginning of the selected waveform range using a linear fade curve. Starting at the beginning of the range, it fades from zero amplitude to 100% of the original amplitude at range end.
**Fade Out**
The *Fade Out* command creates a fade out at the end of the selected waveform range using a linear fade curve. Starting at the beginning of the range, it fades from 100% of the original amplitude to zero amplitude at range end.

**Normalize**
The *Normalize* command scales the amplitude of a selected waveform range so that its peak value is set to a selectable maximum amount. This is particularly useful for sounds that were sampled at a low amplitude.

**Find Peak**
This command finds the peak in the current selection (or entire soundfile, if there is no selection), sets the insertion point there and scrolls the waveform display to that peak.

**Change Gain...**
The *Change Gain...* command proportionally increases or decreases the amplitudes of all samples in a selected waveform range by a user-defined amount. The *Peak Value* button displays the percentage value of the highest selected amplitude, and will also alert you when all of the selected samples are at zero amplitude. The *Change Gain...* function has a -75% to +200% limit in its gain parameter. After the gain change is executed, you will be returned to the soundfile window to see the new amplitude of your selected waveform range.

**Compare Files...**
*Compare Files...* compares two sound files of the same size, sample rate and number of channels, and generates a third file that contains the difference between the two. When you choose *Compare Files* from the Edit menu, Sound Designer II will prompt you to select the A and B files by displaying two successive open-file dialogs. After you select the A and B files to be compared via the dialogs, a third dialog appears for you to name the resultant file. After you name the file and click *Save*, Sound Designer II will write the new file to the selected hard disk volume and open the file.

If no difference was found between the two files, all samples in the resultant file will have zero amplitude (zero indicates no difference between the two files at that sample). Any samples with amplitudes other than zero indicate a difference between the two files at that sample. The Compare Files command can be used to verify the accuracy of your backup medium by comparing a backed-up/restored file with the original source file. Comparing files will also allow you to hear the exact difference between a file that has been processed using any of Sound Designer II’s DSP functions against the original file.
**Smoothing**

Smoothing is an editing option that can be toggled on and off by selecting it in the Edit menu. When the smoothing function is turned on, extreme instantaneous amplitude changes at the edit points are automatically “smoothed over,” alleviating click and pop problems. Smoothing is a destructive option.

**Allow Edit Undo**

This option allows you to enable or disable Sound Designer II’s Undo command. Disabling the Undo command will sometimes speed up Sound Designer II’s performance and use less disk space. This is because when you perform an edit, Sound Designer II must write an “undo” version of the file to disk, so that it can revert to the original version if necessary. Please be aware however, that by giving up the ability to undo, any destructive edits that you make will be permanent. You can use the Temp File Location command of the Setup menu to designate a hard disk volume to store Sound Designer II’s Clipboard and Undo files.

**Select All**

Select All selects the entire soundfile for editing.

**Show Clipboard**

The Show Clipboard command opens a small window that displays the contents of the Macintosh Clipboard. In most cases this will consist of wave data. The Show Clipboard command is useful for checking to see what you have on the Clipboard for pasting or replacing. The contents cannot be edited or played back until placed in a soundfile again. You can use the Temp File Location command of the Setup menu to designate a hard disk volume to store Sound Designer II’s Clipboard and Undo files.

---

**The DSP Menu**

The DSP menu is your gateway to Sound Designer II’s digital signal processing tools and any software Plug-Ins that you have. For example, if you own Digidesign’s DINR™ noise-reduction Plug-In and have installed it in the SD II Plug-Ins folder, the DSP menu will include Broadband Noise Reduction and Hum Removal (see the section About Plug-Ins in the Appendix for more information).
All of the standard DSP commands are covered in depth in Chapter D of this manual. Here you will find short explanations of each.

### Mix
The Mix window allows you to digitally mix up to four mono and/or stereo soundfiles, and save the result as a new soundfile. All aspects of the mix can be controlled, including level, stereo pan, input scaling, and delay before mix start. To learn more about this function, see Chapter D.

### Merge
The Merge command allows the merging of two sound files, resulting in a third soundfile that begins with one of the original files and ends with the other. The Merge is performed by opening two soundfiles that contain Numbered Markers, define the crossfade between them in terms of the markers, and execute the crossfade. All aspects of the crossfade between them, including crossfade curve and length, can be adjusted. In order to merge two soundfiles, both files must have the same number of channels and the same number of bits (both must be 16-bit soundfiles, for example). Refer to Chapter D for specific merge instructions.

### SR Convert
The SR Convert command is used to alter the sample rate of a soundfile without changing the sound's pitch or duration. See Chapter D for more specific information.

### Parametric EQ
The Parametric EQ command opens the parametric equalization window. Use the Parametric EQ window to select, adjust, preview, and perform parametric equalization on one or two channels. Five different types of parametric filters are available: High pass, low shelf, notch/peak, high shelf, and low pass. Any number of specific parametric
EQs can be designed and saved either with your Sound Designer II program or with specific soundfiles. See Chapter D for more specific information.

**Graphic EQ**
The Graphic EQ command opens the Graphic equalization window. Use the Programmable Graphic EQ window to adjust, preview, and perform separate 5-band Graphic EQs on each channel of a stereo file, or a 10-band Graphic EQ on a mono file. The bandwidth and center frequency of each graphic band can be adjusted to provide a virtually limitless number of equalization options. Any number of specific Graphic EQs can be designed and saved either with your Sound Designer II program, or with specific soundfiles. See Chapter D for more specific information.

**Dynamics**
The Dynamics command gives you control over the overall dynamic characteristics (loudness and softness) of your soundfile with three different DSP tools: a Compressor/Limiter, an Expander, and a Noise Gate. All parameters, including input, output, threshold, attack, release, detection, and ratio can be fully adjusted. See Chapter D for more specific information.

**Frequency Analysis**
The Frequency Analysis command generates a 3-D Fourier analysis display that shows the spectral evolution of the waveform in the soundfile window versus time. The characteristics of the 3-D display are set using the Setup menu’s Frequency Plot... command. See Chapter D for more specific information.

**Time Comp/Expand**
The Time Comp/Expand command is used to adjust the duration of a soundfile without changing its pitch. This function is particularly useful for sound design in audio post-production environments, because it allows you to match sounds to time or SMPTE frame durations. See Chapter D for more specific information.

**Pitch Shift**
Pitch Shift is use to adjust the pitch of a soundfile by a user-selectable amount. With the Time Correction option selected, it’s possible to do so without changing the soundfile’s duration. This function is particularly useful for audio production applications where pitch correction of vocals or instruments is necessary. See Chapter D for more specific information.
The Playlist Menu

The Playlist menu, along with the Playlist icon, is your door into Sound Designer II's non-destructive editing mode. Playlist menu commands are only available after the Playlist window has been opened by clicking on the Playlist button. The fine points of Playlist creation and editing are explained in Chapter C.

**New Playlist...**
The *New Playlist...* command is used to create and name a new empty Playlist. This command is most useful if you have already defined one or more soundfile regions using the *Capture Region* command. See Chapter C for more information.

**Open Playlist...**
The *Open Playlist...* command is used to open any existing Playlists attached to the current soundfile. See Chapter C for more information.

**Delete Playlist...**
The *Delete Playlist...* command is used to delete the Playlist that is currently open in the Playlist window. See Chapter C for more information.

**Rename Playlist...**
The *Rename Playlist...* command is used to rename the Playlist that is currently open in the Playlist window. See Chapter C for more information.
Save Playlist as Soundfile...
The Save Playlist as Soundfile... command is used to save the currently open Playlist as a new soundfile. All non-destructive edits in the Playlist—region playback order, fade ins/out, crossfades, and so on—are applied to create a completely new soundfile with these attributes. The new soundfile is the equivalent of digitally recording the output of a Playlist into a new file.

Rename Region...
The Rename Region... command is used to rename the currently selected region in the Playlist window's region list. See Chapter C for more information.

Edit Regions...
The Edit Regions... command is used to edit the currently selected region in the Playlist area of the Playlist window. It brings up a window in which all region parameters, including length, volume, crossfade duration and crossfade type can be fully adjusted and auditioned. See Chapter C for more information.

Un-Timelock Regions
The Un-Timelock Regions command allows you to unlock a frame-locked region that has been selected in the Playlist's regions list. The region will be placed at the end of the previous region. See Chapter F for more information on using SMPTE with Sound Designer II.

NOTE: A region cannot be un-timelocked by merely deleting it from the regions list; doing so will merely cause the region following it to take its place, thus becoming time-locked.

SMPTE Start Time
The SMPTE Start Time command is used to set the SMPTE start time of the first Playlist region. All other regions' SMPTE start and stop times, including locked regions, will be adjusted accordingly. See Chapter F for more information.

Capture Region
The Capture Region command is used to specify a selected range of wave data in the soundfile window as a Playlist region. A waveform range must be selected in order for this command to be active. See Chapter C for more specific information.

Preview Edit
The Preview Edit command serves two purposes:
If you select a region in the region list at the top of the Playlist window, the *Preview Edit* command plays only that region, while displaying the section of the soundfile waveform that is contained in that region.

If you select a region in the Playlist area, the *Preview Edit* command auditions the transitions between the region and its neighbors. The specified pre-roll and post-roll times are used. This allows you to audition the crossfade or transition between regions without having to play the entire Playlist. See Chapter C for more specific information.

**Fades...**

The *Fades* command brings up the Playlist’s Fade Editor window in which user-programmable envelopes can be created for adding a fade-in and fade-out to the Playlist. Users can draw their own envelopes from scratch or start from two preset types. The duration of fade-ins and fade-outs is fully adjustable. See Chapter C for more specific information.

---

**The Display Menu**

Sound Designer II’s Display menu contains the commands you’ll use to organize your windows, add channels to a file, select windows for viewing or editing, search for markers, and display the screen cursor. Here are short explanations of the commands on the Display menu.

<table>
<thead>
<tr>
<th>Display</th>
<th>Add New Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Marker...</td>
<td>F</td>
</tr>
<tr>
<td>Screen Cursor</td>
<td></td>
</tr>
<tr>
<td>Loop Window</td>
<td>L</td>
</tr>
<tr>
<td>Tile Windows</td>
<td></td>
</tr>
<tr>
<td>Stack Windows</td>
<td></td>
</tr>
<tr>
<td>Music Session</td>
<td></td>
</tr>
</tbody>
</table>
Add New Channel
The Add New Channel command adds a channel to a mono Sound Designer II or AIFF file. When you are editing a file with one of these formats, the Add New Channel command adds a new empty channel below the existing channel. Once a new channel has been added, you can paste any desired waveform into it. This function is limited to a maximum of two channels.

Find Marker...
The Find Marker... command allows users to quickly locate text or loop markers in a soundfile. All text and loop markers placed in a soundfile automatically appear in pop-up menus within the Find Markers dialog. To find a marker, choose Find Marker from the Display menu, click on the button in front of the type of marker that you wish to find and select it from the pop-up menu containing the names of all placed markers of that type. With text markers, you have the option of typing in any part of the marker's name and Sound Designer II will match the rest of the marker's name for you. After you have selected the marker you wish to locate, click Find and Sound Designer II will scroll to that location in the soundfile.

Screen Cursor
The Screen Cursor command toggles Sound Designer II's large screen cursor on and off. Unlike the flashing insertion point, the screen cursor is attached to the window, not the waveform. It can be moved within the soundfile by dragging its triangular base to the left or right. The screen cursor is a gauging tool that can be used to determine the exact time and amplitude values for any single point in the current waveform.

When the screen cursor is moved, the upper and lower right data indicator boxes show the time and amplitude values of the current point. If a multi-channel file is being edited, the uppermost channel’s values will be displayed.

Loop Window
The Loop Window command brings up the window you’ll use to fine-tune the loops you have defined with the loop start and loop end markers. When the window appears, you will see two waveform sections divided by a vertical black line. The section on the left represents the wave data immediately before loop end, and the range on the right is the wave data immediately after loop start. The black line is the actual loop splice point where loop playback jumps from loop end to loop start. For specific directions for using Sound Designer II’s loop window, see the looping information in Chapter E.
Tile Windows
The *Tile Windows* command is very useful for cleaning up your screen when you have multiple windows open. All open Sound Designer II windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, and EQ windows) will be resized automatically to fit together on your screen, so you can see them all at one time.

After you have tiled the open windows, you can grow any window to full screen size by clicking on the window’s Grow Box in the right corner of its title bar. Clicking on the Grow Box a second time will shrink the window back to its tiled size.

Stack Windows
The *Stack Windows* command is another window clean-up command. Each open Sound Designer II window (excluding Mix, Merge, SR Convert, Time Comp/Expand, and EQ windows) will be resized automatically to fill your screen, and all will be placed in a pile one on top of the other, with the active window on top.

Window List
Any time Sound Designer II is running, you will see a list of all open windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, and EQ windows) at the bottom of the Display menu. A diamond always appears in front of the active window. To bring any listed window to the front and make it the active window, just choose the name of that window at the bottom of the Display menu.
The Setup Menu

You will use the various commands of the Setup menu to configure the various settings for your Sound Designer II environment.

Here are short explanations of each command:

**Frequency Plot...**

The Frequency Plot... command is used to set the characteristics of the 3-D FFT display that is created when you choose the DSP menu's Frequency Analysis command.

**Open Current OMS Studio Setup**

If your Macintosh MIDI studio setup uses Opcode Systems' OMS (Open MIDI System) this command allows you to load your current OMS studio setup. When OMS is running, choose the MIDI Interface command to open the OMS MIDI Setup dialog. Sound Designer II will access the ports as defined in the OMS MIDI Setup dialog, according to the current Studio OMS Setup. When OMS is active, choose the OMS Studio Setup command to open OMS directly from Sound Designer II.

**MIDI Interface...**

The MIDI Interface... command lets you set the clock rate of the particular MIDI interface(s) connected to your Macintosh's modem and/or printer ports. Most MIDI interfaces use a 1 MHz clock rate, but you will need to check your MIDI interface manual to make sure. An incorrect clock setting will prevent your MIDI interface from
functioning. Check the MIDI Thru box for each interface if you want it to re-transmit incoming MIDI data via the MIDI output.

If you use MIDI Manager, use the MIDI Manager PatchBay™ to configure Sound Designer II's ports. If Sound Designer II's Timecode Port (represented by a small clock icon) is not connected to anything in PatchBay, Sound Designer II assumes it will get MTC via its MIDI Input Port instead. If this is the case, make sure that Filter Timecode is NOT checked under the Apple MIDI Driver for that port.

If you use OMS and have configured Sound Designer II with the Open Current OMS Studio Setup command, Sound Designer II's usual MIDI Interface dialog will be replaced by the OMS MIDI Setup dialog. The OMS MIDI Setup dialog looks like this:

![OMS MIDI Setup dialog]

**Scale Marks...**

The Scale Marks... command lets you select the units that you'll see displayed on the vertical (Y) and horizontal (X) axes in the active soundfile window. Here are short explanations of the different vertical and horizontal scale units:

**Vertical Scales:**

**Percent Full Scale:** This unit indicates all amplitudes in percent of maximum allowable amplitude values: Values above 100% will be clipped. This is generally the most useful amplitude scale for sound design and hard-disk recording.

**Quantized Sample Value:** This unit indicates all amplitudes in the closest quantized sample value (between -32768 and 32768). Because this is machine-oriented, it is generally of less use.

**Horizontal Scales:**

**Time:** This unit indicates waveform duration in minutes, seconds, or milliseconds.

**Hr:Min:Sec:Msec:** This unit indicates duration in hours:minutes:seconds:milliseonds.
**Decimal Sample Number:** This unit indicates duration in decimal sample numbers. Although this unit gives a clearer picture of the memory required to contain a sound, it is not useful for normal time duration judgements.

**Hex Sample Number:** This unit indicates duration in hexadecimal (base 16) sample numbers.

**SMPTE:** This unit indicates duration in SMPTE time code, according to the SMPTE format chosen with the *Set Current Time*... command. This setting is most useful for video applications.

**Feet and Frames:** This unit indicates duration in feet and frames, according to the film format chosen with the *Set Current Time*... command. This setting is useful for film applications.

**Bars and Beats:** This unit indicates duration in bars and beats, according to the base unit defined using the *Set Current Interval*... command. This duration unit offers a more “musical” option, but is only useful on sequenced or steady meter music.

**Sound Playback...**
The *Sound Playback*... command is used to set Sound Designer II’s soundfile playback to match your system.

![Sound Playback Options]

Here are brief explanations of the different playback options:

**Digidesign Card.** Clicking this button will ensure that all soundfiles are played through the Digidesign DSP card currently installed in your Macintosh at 16-bit resolution. If you click on the *Direct from disk* box, you will set the speaker icon to play back directly from the hard disk. When the *Direct from disk* box contains no “X” the speaker icon only plays back the contents of memory.
NOTE: Direct from disk playback may cause a slight hesitation before playback begins, (unless Pre-allocate HD buffers is selected in Preferences... under the Setup menu) whereas memory playback is immediate. Loops can be played direct from disk from within the Loop window.

**Continuous SMPTE Sync.** If you plan to trigger playback of soundfiles with SMPTE, you may wish to enable *Continuous SMPTE Sync.* This option ensures that Sound Designer II playback remains perfectly synchronized to SMPTE throughout playback. However, because of the DSP processing power required to implement this feature, you will not be able to implement other DSP functions such as Graphic EQ and Dynamics in real time. For more information about this feature, refer to the chapter entitled “Working with SMPTE.”

**Sound Manager.** If wish to route playback to the Macintosh speaker instead of through your Digidesign DSP card, click the *Sound Manager* button. In order to do this, you must have Apple’s Sound Manager™ version 3.0 or higher in the Extensions folder inside your System folder.

**Hardware Setup**

The *Hardware Setup* command displays the Hardware Setup dialog:

![Hardware Setup Dialog](image)

The Hardware Setup dialog — a Pro Tools Audio Card is selected and configured

The Hardware Setup dialog allows you to configure Sound Designer II for the specific Digidesign DSP card (and Audio Interface, if any) installed in your system. Sound Designer II 2.8 can be used with an Audiomedia I, Audiomedia II, Audiomedia LC, Sound Accelerator II (Rev C or later), Pro Tools or Session 8 Audio Card. It also allows...
you to select analog or digital input if you have a Digidesign system that supports
digital input. For more detailed instructions on configuring your system with this
command, refer to the separate Hardware Installation Guide included with your
Digidesign system.

Use Dither
The *Use Dither* command toggles Dither on and off. The effect of dither is to replace
low-level distortion caused by re-quantization with a more analog-sounding, low-level
noise floor. Re-quantization occurs whenever the digital audio signal is manipulated,
because the results of arithmetic operations must be truncated (re-quantized) to fit back
into the original soundfile sample size (16-bit, 8-bit, etc.).

Operations such as Reverse, Invert, Cut, Copy and Paste only move blocks of audio data
around, and do not change the actual audio itself: Dither would not be useful in such
cases. Operations such as changing gain, fades, EQ, etc., DO change the actual audio
samples, and so are good situations for when to use dither.

Sound Designer II will apply dither to most processing, whether real-time or non-real-
time, when the Use Dither menu item is checked. However, there are a few exceptions.
Sound Designer II will not apply dither in the following cases:
- Using the Dynamics DSP function, whether using *Process, Preview or Use For Playback*
- During scrubbing (jog or shuttle)
- During playback through the Sound Manager

Sound Designer II will apply dither during most other processes, including the following:
- Gain Change
- Normalize
- Fade In
- Fade Out
- EQ (Preview, Process and Use For Playback)
- Graphic EQ (Preview, Process and Use For Playback)
- Real-time playback with no DSP function having Use For Playback selected
- Save A Copy (when the word length of the new file is smaller than that of the existing file)

Sound Designed II will ALWAYS apply dither during:
- Sample Rate Conversion
- Pitch Shifting (Process)

There are several instances where a more powerful and effective form of dithering —
complex dithering— is used. This type of dither is needed when the wordlength of the
audio samples is shortened. This is used for:
- Save A Copy (when the word length of the new file is smaller than that of the existing file.
- Real-time playback with no DSP function having Use For Playback selected, when the soundfile's sample size is greater than the wordlength (8-bit, 16-bit, etc.) of the playback device's DACs (as selected in the Hardware Setup dialog).

Because using dither will affect the audio to a greater or lesser degree, to accommodate your own tastes and the specific material being processed, you may want to try processing audio both with and without Use Dither selected to determine the best approach for you.

For an overview of Dither and its use in Sound Designer II, please refer to the Appendix of this User's Guide.

**On-Line**
The *On-Line* command puts your system into external sync mode. Sound Designer II will remain in a pause state until the correct SMPTE start frame is received. Choose the command again to take your system off line. See Chapter F for more information.

**Use Backup Files**
When the *Use Backup Files* command is checked, Sound Designer II will attempt to create a backup copy of any file that is opened. In this mode, all edits are made to the copy of the original soundfile, and are not saved to the original until the File menu's *Save* command is chosen. This is the safest way to edit soundfiles. To turn this option off, just choose the command again.

NOTE: The *Use Backup Files* option will only function if there is enough disk space to create and edit a backup file. Use the *Temp File Location...* command of the Setup menu to specify a hard disk volume to store backup files (i.e., Undo files) and Clipboard files. If the required space is not available, a warning dialog will alert you and allow you to open the soundfile as a No Backup soundfile.

**Scroll After Play**
When the *Scroll After Play* command is checked, the waveform editing area of the soundfile window will automatically scroll to the playback stopping point when you let go of the mouse button in Scrub mode. This is a very helpful function for pinpointing specific positions in long soundfiles. Selecting this command toggles the feature on (the command will have a check next to it in the menu) or off (unchecked).
HDPlay Buffer Size...

The HDPlay Buffer Size... command is used to tell Sound Designer II what size playback memory buffer you wish to use when playing back directly from the hard disk. It is saved with the soundfile, since its size is directly related to the media on which that file is. Generally speaking, a setting of 8 will function with the best results. If you are playing back from a slow or very fragmented hard disk, or you experience hesitations during hard disk playback, increase the HDplay buffer size until the problems cease. Optical drives usually require a setting of 32. The total amount of playback buffer is computed as [8 kbytes * HDPlayBuffer size * Number of Channels in Soundfile]. So for a stereo file, a buffer size of 8 yields 8k * 8 * 2 = 128 kbytes of buffer for hard disk playback.

At some point you may receive a warning that it is impossible to allocate a buffer that is large enough. If this happens, increase Sound Designer II’s memory size by selecting the program’s icon on the desktop, and using the Finder’s Get Info... command. In the Get Info dialog, increase the Preferred Memory Size to an appropriate amount.

RAM Buffer

The RAM Buffer command allocates the amount of memory (in seconds) Sound Designer II can access instantaneously for playback and record operations. Higher RAM Buffer settings also increase the quality of Scrubbing and the speed of waveform drawing, although files will take slightly longer to open. Increase or decrease the RAM Buffer setting until you find the most appropriate balance for your work preferences. It refers to the current (active) soundfile, and is saved with that soundfile.

Preferences...

The Preferences... command allows you to assign the default setting for various Sound Designer II parameters. These settings are saved with the Sound Designer II application upon quitting and are restored the next time the application is opened. When you choose this command, the following dialog box appears:

![User Default Options dialog]

The Preferences dialog
Vertical Scales sets the default units displayed in the vertical axis of new soundfiles.

Horizontal Scales sets the default units displayed in the horizontal axis of new soundfiles.

CS-10 Ports sets the default port for the JL Cooper CS-10, if used.

Clicking on Pre-allocate hard disk buffers makes hard disk playback more instantaneous by setting aside areas of available RAM for this function. This option is especially useful for reducing the lag that sometimes precedes hard disk playback when multiple files are open. However, you must restart Sound Designer II after selecting this for it to take effect.

Default crossfade sets the default crossfade type for new Playlist regions that are dragged into the Playlist.

Clicking on Preview edit pre-roll allows you to set the default pre-roll time for the Edit Regions and Preview Edit commands in the Playlist menu.

Clicking on Preview edit post-roll allows you to set the default post-roll time for the Edit Regions and Preview Edit commands in the Playlist menu. These defaults will also affect playback from the overview if the Option or Command keys are pressed while clicking the speaker icon.

Clicking on Auto-name regions automatically names regions “Region 1”, “Region 2”, and so on when created. Regions can be renamed later by using the Rename Region... command in the Playlist menu.

Clicking on Auto-name Playlists automatically names Playlists “Playlist 1”, “Playlist 2”, and so on when captured. Playlists can be renamed later by using the Rename Playlist... command in the Playlist menu.

.WAV File Type sets the Macintosh file type that denotes a .WAV file. The Macintosh File Type of any file can be viewed via the ResEdit application, available on many bulletin boards and on-line services.

Temp File Location
This command allows you to choose a hard disk volume to store Sound Designer II’s Clipboard and Undo files. The destination will default to the volume that Sound Designer II is installed on. If you plan to work with large audio files, choose the drive that has the most amount of free disk space.
**SMPTE Offset...**
Because each component involved in a SMPTE to MIDI system creates a delay or freewheels ahead of the actual system time code, it is sometimes necessary to compensate for this small, but significant offset. To correct timing errors, choose SMPTE Offset from the Setup menu, and enter a desired offset time in milliseconds. The value entered here is the amount of time added to the incoming SMPTE time. Experiment with values until the desired results are achieved. Also, because some MTC convertors/interfaces may be 1/4 to 3/4 frames behind, negative values may be entered to balance the offset. Offset values are not reflected in any of Sound Designer’s time axis or SMPTE displays.

In working with many MTC convertors, we have found that the accuracy differs widely between these units. As other variables are added to the system (MIDI interfaces, mergers, patchbays, etc.), the time code offset will accumulate. In most cases however, a single component’s affect will be negligible. Offsets are sometimes created between SMPTE window dubs and the time code during tape printing, in which the screen's display time may be between 1/8 to 1/4 frame behind the SMPTE audio.

**Ignore Bad Timecode**
When selected, this command will allow Sound Designer II to continue playing on-line even if it receives discontiguous time code for as long as 1/4 second.

**Set Current Time...**
The **Set Current Time...** command is used to select your SMPTE, Feet and Frames, or Bars and Beats format. The format you choose here dictates the form of each of these units when they are displayed as axis marks, or used for duration or synchronization units. This command is only active when the insertion point is blinking in your soundfile.

The **Capture** button provides a convenient way to enter a specific SMPTE value from an incoming time code signal with a mouse click. For specific information about SMPTE format, see Chapter F of this manual. Before you can really use Bar and Beat information, you should define your time units using the **Set Interval...** command.

You will also use the **Set Current Time...** command to set the absolute position of the current insertion point in your choice of format. All other time positions will then be displayed relative to that absolute position.

**Set Interval...**
The **Set Interval...** command is used to tell Sound Designer II what type of musical interval is represented by the selected section. It is only active when a range is selected.
in your soundfile. To view your soundfile in bars and beats, select a waveform range which corresponds to a sixteenth note, eighth note, quarter note, half note, or whole number of bars, and choose the *Set Interval...* command on the Setup menu. Click on the button in front of the unit that is represented by the currently selected waveform range, then click on the OK button.

*NOTE:* Bar and beat information will only be of use on sequenced and other time-locked material. Any soundfile that does not maintain near-perfect timing throughout its duration will fall out of synchronization with the bar and beats mark.

**Set Colors...**
The *Set Colors...* command lets you assign different colors or gray levels to the major components of Sound Designer II’s soundfile windows. (This command remains dimmed unless you have a Macintosh that is capable of color or gray scale display.) Click on a display component (overview, waveform, sound cursor or scale marks). This opens the Macintosh’s Color Picker, which you can use to select a color or gray level for the selected Sound Designer II component. The color settings dialog will reappear with the newly colored component. Repeat this procedure until all colors are to your liking.

*NOTE:* The color settings are used for all soundfiles, and cannot be set differently for different files.

---

**Summary**

This concludes the Sound Designer II Reference. We strongly recommend that you take the time to read through the Appendix, which contains additional information on such subjects as Dither, and sampling basics.
Basic Sampling Concepts

Sound Designer II accomplishes its direct-to-disk recording tasks using a digital technique called sampling. Unlike normal magnetic tape recording, which records an audio signal as a continuous charge on magnetic tape, a sampler converts an audio signal to discrete numbers, which are then stored on a digital storage medium (a hard disk, for example).

Digital sampling of audio tracks is generally superior to standard analog recording methods—not only because it offers extremely high fidelity, but because it avoids the standard noise problems associated with tape generation and playback degradation. Because sampled audio is stored as a set of numbers, there is no loss of fidelity when you copy those numbers, regardless of whether you are copying a first, second, third, fourth, etc. generation copy. Also, because the disk medium is not physically strained by playback (as is a reel of analog tape when it is pulled across the playback heads), repeated playback of a digital track will not alter or degrade that track in any way. For these reasons (among others), digital recording of audio tracks has become the method of preference for many contemporary producers.

The process of digital recording (or sampling) is really quite simple: An audio signal is fed into a computer (or dedicated sampling device). That signal is run through an analog-to-digital converter (ADC), which measures the amplitude (volume) of the signal at regular intervals and passes these measurements or ‘samples’ on to a storage medium. When the recorded track or tracks need to be played back, the samples are retrieved from the storage medium and run through a digital-to-analog converter (DAC), which converts those samples back into a continuous wave. The signal that comes out of the DAC is the output signal, and it is almost an exact image of the signal that was fed into the ADC. Following is a diagram illustrating the way in which samples of an incoming audio signal are taken:
Taking Samples of a Sound

• = one sample

As you can see, the incoming audio waveform is approximated by a series of discrete points that describe that waveform. This illustrates one of the central questions of digital recording: How accurate is the digital representation of the original analog signal? To determine this you will need to understand the concept of sample rate.

Sample rate is the number of samples of a waveform that you take in a single second, and it has a very strong influence upon the quality of the recording you make. At best, a collection of samples is an extremely good approximation of the original input signal. By taking many samples of an audio signal, you end up with a more accurate depiction of the wave — fewer samples yield a less accurate, ‘grainy’ depiction. Here is an illustration:

How Sample Rate affects Fidelity

How different sample rates affect fidelity
The preceding illustration should give you some idea as to how a higher sample rate yields a more accurate, and therefore higher-fidelity recording. Unfortunately each sample requires storage space. Since a higher sample rate is taking more samples per second, it will require more disk storage space for each second of audio than a lower rate. Sound Designer II uses base sample rates of 44,100 Hz and 48,000 Hz, which means it takes 44,100 (or 48,000) samples every second and puts them on your hard disk. 44,100 Hz is the same rate used on audio compact discs, and it allows you to record audio frequencies of up to 22,050 Hz. 48,000 Hz is available on most digital audio tape recorders, and it allows you to record audio frequencies up to 24000 Hz. Since normal human hearing ranges approximately from 20 Hz to 20,000 Hz (or less), the fixed sample rate of 44.1 kHz generally offers more than enough fidelity.

**Keeping Your Hard Disk Tuned-Up**

Hard disks, like most other recording devices, require a certain amount of maintenance in order to operate at their optimum level. In this section, you'll learn about formatting, optimizing and initializing hard drives and when you should perform each of these functions to keep your system running smoothly.

**Avoiding Fragmentation**

For maximum efficiency, files should be written to the drive in a “contiguous” fashion—that is, in an *unbroken stream* on the disk, where sound is recorded in one continuous groove from beginning to end. This helps keep the drive from having to go searching very far to find the data it needs to play back. Unfortunately, the computer can’t always store the soundfiles in this “linear” fashion because existing files are already taking up space on the disk. In this case, the computer writes the data of a new file wherever there is space. If there are a few relatively small files on the hard disk, there will be plenty of open space where files can be written “contiguously.” As the disk fills up, however, the areas of open space become smaller. The end result is that the drive breaks file data into smaller and smaller sections and scatters them around the disk, writing them wherever there is space. This slows down the drive because when it comes time to read the data, it has to do a lot of searching to find the different pieces that make up the file. This phenomenon is referred to as “fragmentation.”
To keep your drive's performance at a maximum, it's best to keep file fragmentation to a minimum. As fragmentation increases, it's harder for the drive to retrieve and send file information to the computer fast enough. What happens if the computer doesn't get the information on time? Disk errors occur that can interfere with the playback of audio. Even minor fragmentation can result in stuttering playback of soundfiles.

**Optimizing Your Drive**

You can actually avoid the effects of fragmentation by optimizing your drive. This means rearranging your files into a contiguous form. There are many software programs that do this for you. When you optimize a drive, each file is regrouped and arranged on the drive in a linear format, making it much easier for the drive to access the data when it's needed. Most optimizing software lets you run a check on a hard drive to find out the percentage of fragmentation. The amount of fragmentation found will determine whether your drive needs to be optimized. In most cases, if your drive shows over 5% or 10% fragmentation, you should consider optimizing it.

How often should you optimize? If you use your system several hours a day, five days a week, you may want to check your drives on a daily basis, since it doesn’t take long for even a large hard disk to become fragmented. This recommendation applies to less frequent usage as well. The more often you check your drives, the fewer problems you’ll have. However, optimizing a hard disk can take time. You should probably allow up to 30 minutes for a 600Mb drive and one hour for a gigabyte drive. This may take substantially less time if the drives are not completely full. Also, different brands of optimizing software may be faster or slower than others.

**Formatting a Drive**

Now you've learned how to keep your soundfiles in good shape: But there's more. In order for a hard drive to locate and rearrange its files, its directory must also be in good shape. The drive's directory is like a map that the drive refers to, in order to locate files when the computer asks for them. Hard drives are a magnetic medium, and over long periods of time, typically months, magnetic data can start to lose its “coercive properties.” When this happens, it may become difficult for the hard drive to locate files as efficiently.

To prevent directory problems from occurring on your system, it's important that you “format” your hard drives on a regular basis. Formatting a hard drive replaces the drive's directory and will also erase any data that is currently on the disk. That's why it's important that you back up all the soundfiles and other information on your drive before you reformat it. Formatting can take up to an hour for larger drives (e.g., 1 to 2 gigabyte drives): Smaller drives may take less time.
How often should you reformat? Most computer service departments recommend formatting every three to four months. It’s important to remember though that recording, processing, and playing digital audio is more demanding on a hard drive than something like word processing. Thus, it may be wise to tune-up your hard drive more frequently. If you find yourself using your system on a very frequent basis, many hours a day, you should consider reformatting on a monthly or even bimonthly basis.

**Initializing a Drive**
The final procedure that you should know about is “initializing” a drive. What’s the difference between formatting and initializing? As explained previously, formatting means completely erasing the hard drive. Initializing a drive is similar to formatting in that the drive’s directory, volume partition map and drivers are replaced with fresh versions, but in this case, the drive is *not* erased, nor is a process called *verification* performed, where each sector on the drive is read/write tested. In most cases, initializing a drive is not as thorough as reformatting, but it is much faster. Consequently, if you’re trying to get rid of a problem with your hard drive, reformating is recommended over initializing.

**Software Products that Can Help Maintain Your Hard Drive**
There are many software products available to assist you with drive maintenance. When the time to format your drive comes around, it’s probably best to use the formatting software supplied with your external hard drive. Most hard drives come with a floppy disk containing all the software you need to keep your drive running smoothly. If your drive didn’t come with maintenance software, some commonly used applications that you may wish to look into are Norton Utilities™ and Norton Speed Disk™, C.P.U.™ (Central Point Utilities), or NOW Utilities™: Most computer stores carry these products.

In the end, the time you spend keeping your drive in good shape will be time well spent. Take good care of your drive and your drive will take care of your files.

---

**About Plug-Ins**

A Plug-In is special purpose software that “plugs-in” to Sound Designer II (version 2.4 or later) to provide additional functionality. DINR, Digidesign’s revolutionary noise-reduction software, is just one of the many Plug-Ins now available from Digidesign and a host of Development Partners.
DINR is particularly adept at removing ambient background noise (air conditioning noise, etc.) and signal hum (caused by amplifiers, light dimmers, computer monitors, etc.). Installation of DINR and all other Plug-Ins is simple — just drop the DINR file into Sound Designer II's “SD II Plug-Ins” folder. DINR's two functions — Broadband Noise Reduction and Hum Removal — will appear in the DSP menu of Sound Designer II.

Because Digidesign has licensed Plug-In technology to qualified third-party developers, many Plug-Ins are now available. The list of Plug-Ins is constantly growing, and currently includes Plug-In equalizers, dynamics processors, and more. Consult your Digidesign dealer for the latest news on Plug-Ins for Sound Designer II, or contact Digidesign directly.

---

### How To Use Dither In Sound Designer II

#### What Is Dither?

Dithering is a technique that is used to reduce the audibility of noise that is generated when the number of bits in a digital audio word are reduced.

There are typically two scenarios when the number of bits would be reduced, and thus dither would be desired:

1. Due to Digital Signal Processing operations, such as gain changing, EQ, dynamics processing, etc., the size of the digital samples will grow, for example from 16- to 56-bits. This is because a simple gain scaling involves multiplying the sample word by a 24-bit number, producing a 56-bit result. Before that result can be returned to the Macintosh or played through a 16-bit DAC (digital-to-analog convertor), it must be reduced down to 16-bits. This is typically done by removing the lower bits, and leaving the most significant bits.

   This scenario happens quite often, even if the entire audio chain is “16-bit”. DSP processing uses 24-bits, with 56-bit intermediate results that must be reduced to 16-bit data before it can be sent back to the Macintosh.

   We will call the type of dithering needed here “Simple Dithering”.

---

186  

*Sound Designer II User's Guide*
(2) When the user wants to explicitly change the sample size of a sound file. This occurs when the user opens a 24-bit sound file, for example, and chooses the Save A Copy function in the File Menu. If the user specifies saving the file as a 16-bit file, then Sound Designer II must reduce the 24-bit samples to 16-bit samples before saving.

We will call the type of dithering needed here “Complex Dithering”, because the noise generated by this type of bit reduction is worse than that generated by Simple Dithering.

**How Is Dithering Done?**

There are typically three ways to reduce the number of bits in a sample. In order of increasing fidelity:

- **Truncation** - just throw away the least significant bits.
- **Rounding** - rounding to the nearest number in the final sample size, and then truncating.
- **Dithering** - Adding a dither signal, which is much like random noise, and then truncating.

When Sound Designer II is NOT using dithering, it is always using Rounding as the bit reduction method. Since truncation alone produces particularly poor results, it is NEVER used in Sound Designer II.

The reason that noise is generated by removing bits is that you are essentially “re-quantizing” the signal, at a lower fidelity. The added noise is really more quantization noise, and appears as harmonic distortion and noise modulation. The level and character of the noise is highly dependent on the level of the signal.

Simple Dithering uses the extra bits that are temporarily generated by arithmetic operations such as multiplication as a dither signal, by incorporating some of the information the extra bits contain back into the least significant bit of the original audio data before it is truncated.

Complex Dithering adds a very low-level random-noise signal (less than 1 lsbit RMS) to the original data before it is truncated. The audio data now modulates the random noise instead of generating harmonic distortion. The result is that the noise floor is now white and constant, and audio data BELOW THE LEAST SIGNIFICANT BIT can now be heard, without associated distortion or noise modulation.
How Do I Use Dither In Sound Designer II?
Sound Designer II uses both Simple Dither and Complex Dither. Each type of dithering is designed for the specific situations discussed above, and is automatically used there by Sound Designer II when the Use Dither menu item is checked. It is important to realize that there are times when you do NOT want to do ANY dithering. Let's talk about that first.

When NOT to use Dithering
If you are making digital transfers to and from Sound Designer II, and no DSP processing or sample-size changes are involved AT ALL, then you do not want to use dithering, and you should un-check the Use Dither function in the Setup menu.

An example would be simple DAT editing. You record 16-bit data from the DAT machine to Sound Designer II, to do some simple rearranging of data in a playlist, with NO region volume changes, fade-ins, fade-outs or DSP used for playback. You then want to play the result back out to DAT as a 16-bit sound file. If you are just playing back audio without processing it in any way (such as from the overview with no DSP used for playback) then you should not use dither if the interface DAC’s output resolution is the same as the sound file’s sample size. A 16-bit file played through an Audio Interface with no DSP processing requires no dither, for example.

When is Simple Dithering used?
If you do any of the DSP processing steps mentioned above, such as change region volumes in the playlist, or use the playlist fade-in or fade-out function, then Simple Dithering should be used.

Another example would be if you used the Process button within a DSP module to destructively change the sound file data on disk. As long as the FINAL sample size does not change from the ORIGINAL sample size, then Simple Dithering is the proper dithering to use. Other examples of DSP processing that use dither are Gain Change and Normalize. These are destructive DSP processes available in the Edit Menu. If you have the Use Dither menu item checked, simple dither will be used here.

Simple Dither is not as strong as Complex Dither, because these types of truncation errors introduced are not as significant, and the amount of dither noise added is very small. A sound file of silence processed using Simple Dithering would result in a sound file of silence. The Simple Dither signal would not change such a sound file.
When is Complex Dithering Used?
If you permanently change the sample size of your sound data, you need to use Complex Dithering. It will add more dither noise to the sound file, but it also corrects the additional noise generated by this more serious type of sample truncation. In other words, using dither when converting a soundfile from 16-bit to 8-bit reduces distortion but can increase noise. (For reference, a sound file of silence processed with this dither would result in a sound file consisting of very low level (less than 1 lsbit RMS) random noise.)

Complex Dithering is needed in the following situations:

- When you use Save A Copy to change the number of bits per sample from 16 to 8, or 24 to 8: in other words, for any downward change in sample size.

- When you use Save A Copy to change the number of channels from 2 to 1 (stereo to mono). In this case, dithering corrects the implicit truncation that occurs during the Left+Right addition, since the result is gain reduced by 6 dB to guarantee it fits back into the sound file.

- When the number of bits in the Digital-to-Analog Convertor (DAC) or Digital Audio interface (AES/EBU or S/PDIF) is LESS than the number of bits per sample in the sound file. Some of the bits will have to be thrown away in order to play this file. For example, you may be playing a 24-bit sound file to a DAT machine, which can only record 16-bits.

- When the number of bits in the Analog-to-Digital Convertor (ADC) or Digital Audio interface (AES/EBU or S/PDIF) is MORE than the number of bits per sample in the sound file. Some of the bits will have to be thrown away in order to record this file. For example, you may be recording a 16-bit sound file from the 20-bit analog inputs of a ProMaster 20 interface. Or, you may be recording an 8-bit sound file from a 16-bit interface.

How Do I Select Which Type Of Dither Is Used?
Simply, you don't; Sound Designer II does it for you. However, it is important to understand how Sound Designer II makes its decisions, and where it has limitations.

1) If you are in the Tape Deck dialog in Sound Designer II, and you have the Use Dither item checked in the Setup Menu, then Sound Designer II will use the Simple Dither if the ADC and DAC sample size is the same as the sound file's sample size. Otherwise it will use Complex Dither if it can (see below). If the Use Dither is NOT checked, then NO dithering is used, and rounding is used instead.
2) If you are playing back audio from the overview or playlist windows, Sound Designer II compares the sound file's sample size to the number of bits of resolution in the currently selected output device. If the sound file has more bits than the output device, then Complex Dither is used. Otherwise Simple Dither is used. If the Use Dither menu item is NOT checked, then NO dither is used, and rounding is used instead.

3) If you are playing back audio from within a DSP module, or if you have a DSP checked as Use For Playback, and are playing back from the overview or playlist windows, then the rules are a little different. None of the DSP modules have any additional time left to do the more complex dithering, so if the Use Dither item is checked, Simple Dithering will always be used.

3a) If you use the Process button of a DSP module to destructively process data on disk, then the rules are the same as above: Simple Dither is always used if Use Dither is checked.

3b) If you use destructive edits such as Gain Change or Normalize, then the rules are the same as above: Simple Dither is always used if Use Dither is checked.

4) If you use the Save A Copy function to save a sound file as another file with fewer bits per sample, then Complex Dither is used if Use Dither is checked.

4a) If you use the Save A Copy function to save a stereo sound file as a mono file, then Complex Dither is used if Use Dither is checked.

Limitations
The original Audiomedia DSP card is not fast enough to be able to offer real-time complex dithering during playback.

Please note that the Complex Dither used during the Save A Copy function can be run on ANY Digidesign DSP card.

Summary
Dither is a powerful tool that can remove the distortion and noise modulation that occurs as a result of re-quantizing digital audio. However, it does change the sound itself, and should be used carefully. Complex Dither removes quantization distortion
while adding a very low level white noise floor. Simple Dither reduces quantizing distortion without adding low level noise. It can subtly change the character of very low level material, however, and should be used with care.

In general, if you do not want to change the audio at all, or minimally change it if processing is used, you should avoid using dither by making sure the Use Dither menu item is not checked.

Backup and Archiving Suggestions

Recording audio to your hard disk will use a considerable amount of disk space—approximately 5 megabytes per minute of mono audio. For this reason it is a good idea to have some type of archiving medium for keeping master and backup copies of your recordings. Here are some devices that are very useful for archiving purposes:

**Erasable Optical Drives.** These drives store 600 megabytes (or more) on a single removable cartridge (300 megabytes per side). Since the medium is magneto-optical (a combination of magnetics and laser technology), the cartridges have few moving parts and a relatively long storage life. Although most are still too slow for multi-track recording, they are useful as an archiving medium.

**Removable Platter Drives.** These drives store 44 or 88 megabytes on a removable magnetic platter cartridge. Although most implementations of the mechanism are fast enough for four track recording and playback, some are not. Generally speaking, 44 and 88 megabyte removable drives are of limited use as a recording or archiving medium, because they hold only about 4 or 8 minutes (respectively) of total source audio at full stereo fidelity.

**WORM Drives.** WORM (Write Once, Read Many) drives can have data recorded onto them only once. They are extremely high-capacity (900 megabytes or more), but they cannot be erased or re-written. They have a very long storage life, and are useful as a long-lasting master archive.

**Streaming Tape Drives.** Streaming tape drives are generally the least expensive data backup devices, and because they use verification schemes, they guarantee file integrity. They store data on magnetic cassettes (DAT or otherwise) in sequential fashion, so they
tend to be very slow, but the media costs are minimal. Because the storage medium is magnetic, the storage life may be limited — but no more so than traditional magnetic audio tape. In many ways, the combination of a large, fast hard disk for recording and mastering, and a DAT backup drive (a WangDAT drive, for example) for archiving may be the best price-for-performance combination.

**DAT Recording Decks.** While digital audio recording decks are a reasonable and cost-effective archiving alternative for your audio files, they do have some drawbacks. One favorable fact is that any audio backed up digitally to a DAT recorder can be played back two tracks at a time and auditioned as normal audio.

However, remember that they use error-correction schemes, so you may encounter some loss of quality in your digital audio. Generally speaking, digital mixing/transfer to standard DAT recorders is best reserved for use as a client (or mastering) delivery medium.

**Digidesign’s DATa™ software.** If you are cost-conscious, you will find our DATa™ software a good option. This allows you to back up your audio files and edit information on to a standard audio DAT cassette, using your DAT recorder.

Because you are using an audio DAT recorder, the transfer will take place in real-time, and the DAT recorder will not alert you to any errors in transmission. You will need to listen to the entire tape to ensure that the files were transferred properly. However, it is still a convenient and affordable way to back up files. DATa is sent free of charge to all registered Sound Designer II users.

The backup method you choose should be weighed on how much you are willing to spend, versus how much time you want to devote to saving and restoring files and the value to you of the audio material. If you have more questions about Macintosh-compatible storage systems, we recommend that you check back issues of *MacintoshUser* and *MacintoshWorld* magazines for in-depth reviews and comparisons.
Using the JL Cooper CS-1 or CS-10 with Sound Designer II

The CS-1 and CS-10 control surfaces from JL Cooper Electronics offer an alternative to controlling Sound Designer II with a mouse. By providing faders, a jog wheel and function keys, these products combine familiar and responsive control for your Digidesign digital recording and editing system with exceptional speed and flexibility.

Here is how the CS-1 and CS-10 controls function in Sound Designer II (most controls are identical, exceptions are noted where relevant):

**Left Diamond:**
- Same as left zoom arrow in Waveform Window.
- Same as left zoom arrow in Loop Window.

**SHIFT-Left Diamond:**
- Same as left horizontal scroll arrow in Waveform Window.
- Same as left zoom arrow in Loop Window.

**Right Diamond:**
- Same as right zoom arrow in Waveform Window.
- Same as right zoom arrow in Loop Window.

**SHIFT-Right Diamond:**
- Same as right horizontal scroll arrow in Waveform Window.
- Same as right zoom arrow in Loop Window.

**Up Diamond:**
- Same as up zoom arrow in Waveform Window.
- Same as up zoom arrow in Loop Window.

**SHIFT-Up Diamond:**
- Same as up vertical scroll arrow in Waveform Window.
- Same as up zoom arrow in Loop Window.

**Down Diamond:**
- Same as down zoom arrow in Waveform Window.
- Same as down zoom arrow in Loop Window.
**SHIFT-Down Diamond:**
Same as down vertical scroll arrow in Waveform Window.

Same as down zoom arrow in Loop Window.

**Play:**
If the transport is currently in Stop mode, Sound Designer II will enter Play mode.

Equivalent to hitting the SPACE BAR. Works in both Waveform Window and Playlist Window.

Equivalent to hitting the SPEAKER icon in the Loop Window.

**SHIFT-Play:**
Equivalent to hitting the SPEAKER icon in the Waveform Window.

Equivalent to Preview Edit in the Playlist Window.

Equivalent to hitting the SPEAKER icon in the Edit Fades dialog.

Equivalent to hitting a SPEAKER icon in the Edit Regions dialog.

**Rewind:**
In the Waveform Window, this stops any current playback and scrolls the play cursor backwards through the soundfile.

In the Playlist Window, this stops any current playback and scrolls the current region in the Playlist backwards in time.

**SHIFT-Rewind:**
In the Waveform Window, this stops any current playback and scrolls the window to the start of the soundfile.

In the Playlist Window, this stops any current playback and scrolls the Playlist to the first region in the Playlist.

**Fast Forward:**
In the Waveform Window, this stops any current playback and scrolls the play cursor forwards through the soundfile.

In the Playlist Window, this stops any current playback and scrolls the current region in the Playlist forwards in time.

**SHIFT-Fast Forward:**
In the Waveform Window, this stops any current playback and scrolls the window to the end of the soundfile.
In the Playlist Window, this stops any current playback and scrolls the Playlist to the last region in the Playlist.

**Stop:**

If the transport is currently in Play mode, Sound Designer II will enter Stop mode.

- Equivalent to hitting the Space bar. Works in both Waveform Window and Playlist Window.
- Equivalent to hitting the Speaker icon in the Loop Window.

**Record:**

In the Record Dialog, if On-Line is selected, this puts the transport into Record-Ready mode. If not On-Line, it puts the transport into Record-Play mode and immediately begins recording.

- Equivalent to hitting the Record button.

* On the CS-10 only, button F9 toggles On-line on and off.

**F1 Button:**

In the Waveform Window, if the transport is in Play Mode, the selection start, or insertion point if there is no selection, is placed at the current play position.

In the Waveform Window, if the transport is in Stop Mode, the selection start, or insertion point if there is no selection, is placed at the point scrubbed to last, and the window is then scrolled to that point.

**SHIFT-F1 Button:**

In the Waveform Window, it drops a marker at the current playback position.

Equivalent to hitting the ENTER key.

**F2 Button:**

In the Waveform Window, if the transport is in Play Mode, the selection end is placed at the current play position.

In the Waveform Window, if the transport is in Stop Mode, the selection end is placed at the point last scrubbed to; the window is then scrolled to that point.

**SHIFT-F2 Button:**

In the Waveform Window, it puts the wheel in Scroll Mode.

**F3 Button:**

In the Waveform Window, it will execute the Capture Region menu command if a selection exists in the waveform.
**SHIFT-F3 Button:**
In the Waveform Window, it puts the wheel in Jog Mode.

**F4 Button:**
If in the Waveform Window, switches to the Playlist Window.
If in the Playlist Window, switches to the Record dialog.
If in the Record dialog, switches to the Waveform Window.
If in the Edit Fades dialog, switches to the Playlist Window.
If in the Edit Regions dialog, switches to the Playlist Window.

**SHIFT-F4 Button:**
In the Waveform Window, it puts the wheel in Shuttle Mode.

**On-Line Button:**
The on-line mode is inverted, from ON to OFF, or from OFF to ON.

**Wheel:**
Begins scrubbing in Waveform Window if in **scrub** mode.
Begins jogging in Waveform Window if in **jog** mode.
Scrolls through the soundfile in Waveform Window if in **scroll** mode.
Scrolls through the list of regions if in the Playlist Window.
Key Command Shortcuts in the Soundfile Window

Several keys on the Macintosh keyboard provide shortcuts in the Soundfile Window.

**Define Region Start.** The Down arrow key defines the beginning of a selection during playback.

**Define Region End.** The Up arrow key defines the end of a selection during playback.

**Locate Region Start.** The Left arrow key scrolls the Waveform Display so that the beginning of the selected region, or insertion point is centered on the screen.

**Locate Region End.** The Right arrow key scrolls the Waveform Display so that the end of the selected region, or insertion point is centered on the screen.

**Locate to Numbered Marker.** Pressing numbers on the Macintosh keyboard allows you to quickly locate any numbered markers that you have placed in a soundfile.

**Play/Stop.** The Spacebar starts and stops playback of a soundfile. Playback begins at the cursor’s current location. Clicking the Speaker icon plays the soundfile for as long as the mouse button is depressed. Alternately, holding down the mouse button anywhere in the Overview Display will start playback from that point.

**Rewind To Beginning.** Pressing the Return key stops playback and then moves the screen and the cursor to the beginning of the soundfile.
Recommended Reading

Audio in Media, Stanley R. Alten, Wadsworth Publishing Company, Belmont, California, 1986


The Ultimate Home Studio, Michael Goldberg, Digidesign, Menlo Park, California, 1991

Random Access Audio, David Miles Huber, Digidesign, Menlo Park, California, 1989

Mix Magazine, 6400 Hollis St. #12, Emeryville, CA 94608

Electronic Musician Magazine, 6400 Hollis St. #12, Emeryville, CA 94608

Keyboard Magazine, 20085 Stevens Creek, Cupertino, California, 95014
Index
Index

Symbols

.diff 86
.WAV 175
32-bit Addressing 5

A

Add New Channel 166
aliases 24, 54
Allow Edit Undo 160
Audio
  as waveforms 54-56
Audio Regions
  creating 54-56
Audiomedia 171
Authorize 7
AUTO arrows 125
Auto-name Playlists
  setting in Preferences 175
Auto-name regions
  setting in Preferences 175

B

backup disk 10
bandwidth (graphic EQ) 102
  Changing 102
Bars and Beats
  in Scale Marks command 170
Base note 30
black burst 133, 135
Breakpoint 74
Butt splice 65
Bypass 96

C

Capture
  in Set Current Time 176
Capture Region 164
Capturing SMPTE 143
Change Gain 84, 159
channel selection menu 124
Clear 80
clicks 121
clip indicators 51
clipping 85
Close 33, 154
Colors 177
Compare Files 86, 159
Compressed 28
Compressor/Limiter 103
contiguous 50
contiguous recording 183
Continue button 124
Continuous SMPTE Sync 134, 171
Copy 81, 157
crossfade
  butt splice 65
  button 122
curves 123
duration 67
equal power 66
fast-in, slow-out 66
in Playlists 65
Length 124
linear 65
setting 67
slow-in, fast-out 66
Crossfade Loop dialog 123
Crossfade Looping 123
crystal oscillators 132
Cut 80, 157

D

Data Indicator Boxes 41
DATa™ 192
Deauthorize 8
Decimal Sample Number
   in Scale Marks command 170
Defining Regions 197
Delete Playlist... 163
Delete...
   files 155
Deleting Loops 125
Destructive editing 20
Difference 86
DINR 185
Direct from disk 36, 170, 171
directory
   hard disk 184
Disk Buffer 50, 52
Display Scale arrows 38, 122
Dither
   overview of...186
dotted lines (Scrub cursor) 41
drag-drop 57
DSP 172
   about 88
destructive 95
non-destructive 95
tuning off 96
Dynamics 162, 172
   about 103
common functions
   attack 105
detection 104

input 104
output 105
ratio 105
release 105
threshold 105
using 104

E

Edit Regions... 164
Editing
   non-destructive 20
   edits
      previewing 164
EQ 103, 172
Equal Power crossfade 123
Eraser 74
Expander 104

F

fade
   regions within soundfiles 82
Fade In 158, 172
Fade Out 172
Faders 96
   fine-adjust w/Option key 96
   adjusting in DSP windows 96
Fades 165
   creating envelopes 74
   in Playlists 74
   removing envelope points 74
Fast Forward 53
Feet and Frames
   in Scale Marks command 170
FFT Analysis
   about 110
   generating 113
   invoking 168
   setup 110
amplitude
bands
direction
frequency range
time interval
type
File Type
Find Marker
Find Peak
Format
SMPT
Format 1/Format 2
Formatting a Drive
Forward Loops
Forward/Backward loops
fragmentation
Frame Rates
choosing
problems with
Frame-locked regions
frequency (EQ)
Changing
Frequency Analysis
Frequency Plot...

G
Gain
fine tuning
Gain Change
Get Info...
Graphic EQ
gray levels

H
Hard Disk maintenance
Formatting
Initializing
Optimizing
Hard Drive maintenance software
Hardware Setup...
Hex Sample Number
  in Scale Marks command
high-pass filtering
  in Parametric EQ
High-shelf filtering
  in Parametric EQ
Horizontal Scales
  setting in Preferences
house sync
Hr:Min:Sec:Msec
  in Scale Marks command
Hypercard
I
ID
Information button
Initializing a Drive
input level
  setting
Invert

K
Key Commands

L
levels
  optimizing on playback
Linear crossfade
Locate
  numbered marker
  region end
  region start
Locating Regions
Longitudinal Time Code
Loop
  sustain

Index
Loop End Marker  40, 120
Loop playback  36
loop selection menu  124
Loop Start Marker  40, 120
Loop Tools  38
Loop Window  121, 166
Loops  117
  and RAM  120
  creating  120
  deleting  125
  fine tuning  121
low-pass filtering
  in Parametric EQ  98
low-shelf filtering
  in Parametric EQ  97
LTC  129, 130, 136, 143

M
Mac-to-Sampler button  35, 118
maintenance of hard disks  183
Markers  38, 166
  deleting  39
  Find  125
  locating text or loop  166
Loop End  40
Loop Start  40
Numbered  39
Text  39
memory
  increasing  174
  required for crossfades  67
Merge  92, 161
MIDI Interface  168
MIDI Manager  169
  and SMPTE  149
Mix  89
Mixing soundfiles  89, 161
Monitor  51

N
New Playlist...  163
New...  48
No Backup  154
Noise Gate  104
Nondestructive editing  20
Normalize  83, 159, 172
Numbered Marker  39
  placing during playback  62

O
OMS  168, 169
On Line  52, 142, 173
One Shot  73
Open Current OMS Studio Setup  168
Open Playlist...  163
Open...  23, 154
optical drives  50, 174
Optimizing Your Drive  184
oscillators, crystal  132
overlap transition  66
Overview Display  33, 52

P
Page Setup...  155
Parametric EQ  161
  about  97
  adjusting  98
  saving settings  99
Paste  80, 81, 157
peak/notch filtering
  in Parametric EQ  97
Pencil  37
Percent Full Scale
  in Scale Marks command  169
Pitch Shift  108, 162, 172
Pitch Shift with Time Correction  108
Play  24, 53
playback  34, 36, 197
   for any point  53
   from beginning  53
   from current position  53
   from window position  53
Playlist  19, 41, 47
   accessing  41
   creating  63, 163
   deleting entries  70
   editing  70
   fading  165
   opening  163
   playing  64
   previewing transitions  69
   renaming  71, 163
   saving as soundfiles  30, 164
Plug-Ins  185
pops  121
post-crossfade  67
post-roll  72
Pre-Allocate  50
Pre-allocate HD buffers  36, 171, 175
pre-crossfade  66
Pre-roll  72
Preferences  174
Preview Edit  69, 164
Preview edit post-roll
   setting in Preferences  175
Preview edit pre-roll
   setting in Preferences  175
Pro Tools  171
Process  95

Q
quartz crystal oscillators  132
Quit  156

R
RAM  68, 120
RAM Buffer  174
Random access  19
range
   selecting  37
Record  52
reformatting a drive  185
Region
   defined  19
regions
   adjusting end points  73
   adjusting volumes  68
   capturing  164
   copying  71
   creating  54–56
   duplicating within soundfiles  80
   editing  164
   editing from Playlist  71
   editing from playlist  70
   moving within soundfiles  80
   removing from soundfile  80
   renaming  164
   reversing  82
   selecting  59
      with arrow keys  60
      with markers  62
      with Scrubber  61
   silencing  82
   trimming excess data  81
   un-timelocking  164
Register  10
registration card  iv
Rename Playlist...  163
Rename Region...  164
Replace  81, 158
ResEdit  30
Resolving SMPTE devices  133
Resource 28, 29
Format 30
ID 30
saving as 29
Resources
opening 25, 154
Return To Zero 52
Reverse 82, 158
Revert to Saved 27, 155
Rewind 53, 197

S
Sample Rate 50
verifying 94
sample rate conversion 93, 161, 172
Sample Rates folder 10
SampleCell 35, 117
Samples
sending to SampleCell 118
Save 28, 154
Save a Copy... 154, 172
Scale Marks... 35, 42, 169
scroll arrows 125
Scrubber 38, 41, 172
SD II Sample Rates 10
Select All 160
Select Volume 26
Selector 37
Sending Samples to SampleCell II 118
Session 8 171
Set Colors 177
Set Current Time 139, 176
Set Interval 176
Setup menu 12
Show Clipboard 160
Silence 82, 158
Smoothing 80, 160
SMPTE
frame rates 138
in Scale Marks command 170
striping 132
troubleshooting 148
SMPTE devices
resolving 133
SMPTE formats 130
choosing 138
"problem" rates 149
SMPTE generators 133
SMPTE Offset 141–147
SMPTE Resync 134
SMPTE Slave Driver 134, 136
SMPTE Start Time 164
setting 164
SMPTE Trigger 134, 134–137
snd 21
Software for hard drives 185
software update policy iv
Sound Accelerator 171
Sound Manager 13, 172
in Sound Playback parameters 171
Sound Playback... 12, 53, 170
Soundfile Window 32
Soundfiles
sending to SampleCell 118
Speaker button 36, 122, 197
splice point 122
SR Convert 94
Stack Windows 167
Starting 7
Stop 52, 53
Striping SMPTE 132
Studio 3 134
Support iv
sustain loop 118
Synchronization 129

T
Tape Deck 40, 47
accessing  40, 49
technical support  iv
Temp File Location  25
Text Marker  39
Tile Windows  167
Time Code  129
Time Code Machine  134
Time Comp/Expand  106, 162
Time Compression and Expansion  106
tuning reference  109
Time Correction
  option in Pitch Shift  162
time line  52
Time locked regions  146
Time Scale
  Time Code  139
Timecode  176
Title Bar  33
Trash Can  42, 125
Trigger  134
Trigger on Nudge  73
Trim  82, 158
Troubleshooting SMPTE  148–150
tuning reference  109
Tuning up hard disks  183

U
Un-Timelock Regions  164
Undo  27, 157
updates  iv
Use Backup Files  25, 33, 155, 173
Use for playback  95, 96

V
Vertical Interval Time Code  129
Vertical Scales
  setting in Preferences  175
Video Slave Driver  135

View Indicator  34
VITC  129, 130, 143

W
WAV  21, 175
Waveform Display  34
Waveforms
  understanding  54–56
  windows
    displaying and arranging  167
  word clock signal  135

Z
Zero Amplitude Indication  87
Zoomer  36